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LEARNING IN THIS CHAPTER 
Networking and its advantages 

Networking components 

• Types of networks 

• Networking architecture 

NETWORKING CONCEPTS 

r Network topologies 

Accessing a file from a shared drive 

r Network security 

In our daily life, we come across different types of networks. Let us understand this concept by some examples: 

Network of roads, railway lines, canals, etc. 

Communication network of telephone system, which enables us to talk to anyone, anywhere, anytime 

Network of Banks/ATMs (Automated Teller Machines) 

Radio/Television network broadcast programs live across the globe 

Video conferencing allows discussions between people at distant/far off places 

Network of malls, schools, hospitals, etc., all overthe country 

Example 

Internet is an outcome of cyber networking. Imagine life without networking ... no phone, no television, no internet, 

etc. Computer networks have extended the power of a computer beyond the expanse of a room. 

NETWORKING 

A computer network can be defined as a group of computers and other peripheral devices that are linked together 

for the purpose of sharing data and hardware resources. For example, if one of the computers in a network has a 

printer attached to it, then all the computers in that network can access the printer and use it to print the documents 

as shown in Figure 1.1, where Computer A and Bin a network can give the print command to the printer attached 

with Computer C. 

 

Computer A 

 

Figure 1.1:  A Computer Network 

The computers in a network can communicate with each other as well as work independently. Each computer in a 

network is called a Node. The computers in a network can be linked through cables, telephone lines, radio waves, or 

infrared light beams. 
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Know the Fact 

Bluetooth is a wireless 

technology used to 

interconnect mobile 

phones, computers, 

printers using short-range 

wireless connection. For 

more information, visit: 

www.bluetooth.com  

ADVANTAGES OF NETWORKING 

Networking in computers brings efficiency, economy, and effectiveness in an 

organisation. 

EFFICIENT USE OF STORAGE MEDIA 

It is better to store a shareable application data on a network drive than a copy of the 

application on each user's storage device. It is better to have one big hard disk in the 

serverthan to have small hard disks in different computers. 

PRESERVING INFORMATION 

It is difficult to maintain regular backups on a number of stand-alone computers. When 

you keep backups on a central location, you have one place to look for the lost 

information. 

RED1CTION IN HARDWARE COSTS 

In a network, the hardware devices that are not used very often, like modems, printers, 

scanners, CD-writers, etc. can be shared. This reduces the cost of the hardware. 

EFFICIENCY 

In a network, the deletion, modification, or upgradation of the software/data is to be done 

at a single point only. This brings more efficiency and effectiveness into a working system. 

RED10ES REDUNDANCY 

A network reduces the need for hard copies of all documents. By sharing the soft copy of 

a file over the network, the need to share paper copies of reports or any other 

information can be eliminated or greatly reduced. 

QUICKEST DOCUMENT DELIVERY 

Networking provides a facility to instantly deliver soft copies from one computer to the 

other computers throughout the world. 

NTWORKING COMPONENTS 

To establish wired networking in a group of computers, you require some additional 

components that are as follows: 

Let's Know More 

When two users have 

simultaneous conversation 

via the internet, it is called 

Conferencing. When this 

process is supplemented 

by live video, it is called 

Video Conferencing. 

Let's Know More 

Intranet is a term, which 

refers to a computer 

network restricted to an 

organisation. 

Extranet refers to a 

computer network that 

allows controlled access to 

an information source 

available on the internet. 

NETWORK CARD 

A network card is used to physically attach a computer to a 

network, so that it can participate in network communication. 

Ethernet Network Card is the most commonly used network 

card. (Nowadays, most computer motherboards come with an 

inbuilt Network Card.) 

NETWORKING CABLE 

Let's Know More 

Protocols are certain sets 
of rules that determine 

how data should be 

transferred over networks, 

compressed, presented on 

the screen and so on. 

Network Card 

Modern Ethernet networks use twisted pair cable containing eight wires. These wires 
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are arranged in a special order, and an RJ-45 connector (similar in design, but bigger than 

the connector used with the telephone wire) is crimped at both the ends of the cable. 

MODEM 

A modem enables you to connect your computer to the available internet connection over 

the existing telephone lines. It converts the digital signals of a computer into analog 

signals to enable their transmission via phone lines. At the destination, the receiving 

modem further converts the analog signal into digital signals so that the data can be 

understood at the receiving end. It comes as a separate part that can be installed on the 

Peripheral Component Interconnect (PCI) slots found on the mother board. 

HUBS AND SWITCHES 

Networking Cable 

Modem 

Network cards are used to send and receive data being transmitted over the Ethernet 

cables. When a network has more than two computers, you cannot directly connect all the 

computers together. You need an interface through which the computers can be 

connected, and the data can be sent and received. This function is performed by a hub or 

switch. Hubs were the preferred medium in earlier times, but now switches are used 

because of their better eff iciency. Hubs and Switches 

A Hub/Switch performsthefollowingfunctions: 

It acts as a central point of connection for all the computers on a network. Every computer plugs into the 

hub/switch. 

> It helps to arrange the ports in such a way that if a PC transmits data, the data is sent over the other computer 

through its network card. 

Basically, the hub/switch is a box with a set of RJ-45 ports. Each computer on a network is connected to the 

hub/switch via the Ethernet cable. 

To establish Wireless Networking, you require the following components: 

> Wireless Network Cards are used instead of the normal network cards that are used in the wired networks. Most 

laptop computers come with the inbuilt wireless network cards. Radio signals are used for transferring data, 

therefore Ethernet cable is not required. 

>  Access Points or Routers have a wireless antenna, which increases the communication 

range of the radio signals. Access Points can also be used to join a wired network, thus 

making the network a combination of wired as well as wireless networks. 

Routers 

TYPES OF NETWORKS 

Depending on the geographical area covered by a network, there are various types of computer networks, used 

worldwide, which are as follows: 

PERSONAL AREA NETWORK(PAN) 

PAN is a computer network that is mainly created for an individual person. It is used for communication among 

devices, such as laptops, mobile phones, PDA, orsmartphones. 
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igure 1.3: Local Area Network 
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Figure 1.5: Wide Area Network 

Know the Fact 

Wireless Access Point 

(WAP) is a device that 

connects wireless 

communication devices to 

form a wireless network. 

Wireless networking 

allows the networks to be 

deployed without cabling. 

Spaces, such as outdoor 

areas where cables cannot 

be laid; can have wireless 

networks. 

Let's Know More 

Wi-Fi stands for Wireless 

Fidelity. It represents 

Wireless Local Area 

Network. It was developed 

for mobile computer 

devices, like laptops, but is 

now used in PCs, video 

game consoles, 

smartphones, tablets to 

exchange data wirelessly 

over the computer 

networks. This technology. 

enables the radio signals to 

go further (300 feet 

approximately) with a 

faster rate of transmission. 

Personal area networks can either 

be wired or wireless. PAN generally 

covers a range of less than 10 

metres (about 30 feet). You can use 

these networks to transfer files 

ncluding e-mails, calendar 

appointments, digital photos, and 

music. 

Wireless is a means of 

communication that uses 

low powered radio waves 

to transmit data between 

devices. 

Figure 1.2: Personal Area Network 

 

  

Let's Know More 
LOCAL AREA NETWORK (LAN) 

In LAN, two or more computers and peripheral 

devices are connected within a small area, such 

as room, office building, or a campus. In Local 

Area Network, computer terminals are 

physically connected with wires. The data 

transmission speed is fast as compared to 

WAN. Since LAN is operated in a small area, it 

can be controlled and administered by a single 

person oran organisation. 

METROPOLITAN AREA NETWORK (MAN) 

MAN is a larger network than LAN. It is spread across a city. 

Since it covers a city, it is called metropolitan. The most 

common example of MAN is the city cable network or 

branches of a local bank in a city. 

Figure 1.4: Metropolitan 
Area Network 

This kind of network connects two or more 

computers located at distant places. They are 

linked by communication facilities, like 

telecommunication or satellite signals. The 

most common example of WAN type network 

is telecom system. The usage of WAN is limited 

to very large organisations and government 

agencies. The main characteristic of WAN is 

that it requires a public telecommunication 

media to transfer data. The best examples of 

WAN are: 

> Internet and intranet in a large multinational company 

> ATM facility 

) National and multinational bank customer services 
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File Server 

-

iChents Clients 

Resources are controlled 
by the file server in a 
client.server network. 

Point to Point 

Figure 1.8: Point to Point Topology 

E NETWORKING ARCHITECTURE 

Network architecture is an overall design of a computer network that describes how a computer network is 

configured and what strategies are being used in it. Network Architecture are mainly of following two types: 

Network Architecture 

Client-Server Network 

CLIENT-SERVER NETWORK 

It is a network, where several computers called clients or 

workstations are connected to the main computer called the 

server. 

A server is a computer that provides services to clients and 

controls access to hardware, software, and other resources. 

Clients are the computers that request services, like data 

retrieval, storage, etc., from the server. 

Peer-to-Peer Network 

Figure 1.6:  Client-Server Architecture 

PEER-TO-PEER NETWORK 

Peer-to-Peer is a network where a few computers having equal capacity and 

capabilities are connected together to use the resources available on the network. In 

peer-to-peer network, there is no central server, instead each computer can act as a 

serveras well asa client. 
Figure 1.7: Peer-to-Peer Network 

NETWORK TOPOLOGIES 

Network topology refers to the layout in which various components of a network, like nodes, links, peripherals, etc. 

are connected and communicate with each other. Topology can either be physical or logical. Physical topology is the 

physical layout of nodes, workstations, and cables in the network, whereas logical topology is the way how 

information flows between different components. 

Network topologies are categorised into the following basic types: 

POINT-TO-POINT 

Point-to-point topology is the simplest form of network structure in 

which two nodes are directly connected with each other. This type of 

network is more suitable for small areas where computers are in close 

proximity. This technology provides a faster and reliable connection. 

BUS TOPOLOGY 

This topology uses a single communication line or one main cable to which all nodes are directly connected. The main 
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Figure 1.11:  Ring Topology 
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Figure 1.12:  Tree Topology 

cable acts as a backbone for the network. It transmits data only in one 

direction. In this type of structure one of the computers in the network 

acts as the computer server, that provides data to all the clients. This 

topology is used in small networks where cable requirement is relatively 

small. One of the disadvantages of such type of network is that if the main 

cablefails, the entire network becomes unusable. For this reason, this type 

of topology is not used for large networks, such as those covering an 

entire building. 

     

     

Figure 1.9:  Bus Topology 
STAR TOPOLOGY 

In star topology, each device is connected to a central computer using a point-to-

point connection. The central server acts as a Hub. Devices communicate across the 

network by passing data through this hub. Star topology is very popular because 

the startup cost is low. It is easy to add a new device to the network as only one 

cable is required and configuration is simple. Moreover, the network is robust; if any 

one connection in the network fails, the other connections remain intact. But if the 

central hub fails, the entire network goes down. Figure 1.10: Star Topology 

RING TOPOLOGY 

In ring topology, all the nodes in the network are connected in a circular manner. Each 

node connects to exactly two other nodes, forming a single-continuous pathway for 

signa s, when one node sends message to the other node, which is not adjacent to it, 

data ravels through all the intermediate nodes until it reaches its final destination. 

Ring topologies are used in both LAN and WAN setups. The main disadvantage of this 

topology is that if one workstation goes down, the entire network gets affected. Since 

data being transferred over the network has to pass through each workstation, this 

makes it slowerthan startopology. 

TREE TOPOLOGY 

Tree opology is one of the most common network setups that consists of a group of star-figured workstations 

conncted to a linear bus backbone cable. In tree topology, one star network is connected to the other star networks. In a 

tree ntwork, a cable failure in one of the star networks will isolate 

only the workstation that is linked to the central computer of that 

star network, whereas, all the other workstations will continue to 

function normally. If a central computer goes down, the entire ______ 

workstations connected to it will suffer either degraded 

performance or complete failure, but the rest of the network will 

continue to function normally. In case the bus gets damaged, it 

causes disruption in the entire network. In the tree topology, the 

expansion of network is possible and easy hut maintance becomes 

difficult. 
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MESH TOPOLOGY 

In mesh network topology, each node is connected to every other node in the 

network. In this topology, every node not only sends its own signals but also relays 

data from the other nodes. This type of topology can handle a large volume of 

traffic. It is commonly used in wireless networks. In case, if one of the component 

fails, there is always an alternative present so that the data transfer does not get 

affected. Even expansion and modifications can be done in this topology without 

affecting other nodes. The overall cost of this network is extremely high as 

compared to the other network topologies. 

E ACCESSING A FILE FROM A SHARED DRIVE 

Figure 1.13:  Mesh Topology 

To access a file from a shared drive, follow the given steps: - V — - 0 '1 

> Double-click on the Network icon on the Desktop. ,d o±_ [+:X-i 
'-'.4-c-, ,-. 5o'.rn.V,

• '.: 

) The Network window will appear, in which a list of shared 

drives are displayed in the Details pane. 
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> Select the required shared drive to see its contents. J  H'.. 
00 
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• 4—. 0,1. 

> Find the required file in the drive. 
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> If you want to open the file, double-click on it. 
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> To copy the file, right-click on it and select the Copy , PO4—HI 10<41440 
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option from the Shortcut menu. 
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> In the View pane, select This PC icon to view the storage 104— 
f•0 

drives on your computer. 
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0 

Figure 1.14: Finding a File in a Shared Drive 

> Now, click on the drive where you want to 

place the copied file. 

> Right-click anywhere on the Details pane and 

select the Paste option. 

> The file will be copied to the selected drive on 

your computer. 

FIgure 1.15: Pasting a File into the Selected Drive 

NETWORK SECURITY 

Network Security means protecting data and resources from any unauthorised access. It is the most important 

aspect in computer networking. Since many users are accessing the same data, so you must ensure its proper 
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N, LAN, MAN, and WAN are the various types of computer networks. 

twork architecture is an overall design of a computer network that describes how a computer network is 

ifigured and what strategies are being used. 

> Ne twork security means protecting data and resources from any unauthorised access. 

security. Only authorised persons can access or modify data. Consider the following 

points that may happen in any organisation: 

Scme employees may try to change the data concerning their leave records, salaries, 

pdrformance appraisals, etc. 

> Mcidental deletion of important data 

> Former employees or some other people may try to harm the company's data 

People outside the company may try to access confidential data 

There are two general levels of network security. These are: 

Login Security: You are given a unique login name and password. 

Figure 1.16:  Network Security 
Rights Security: Based upon your username, you are given rights, like Read-Only Access 

or Red-Write Access or No Access at all. A combination of rights can also be granted to the same user for different 

sets of data. 

> A computer network can be defined as a group of computers and other peripheral devices that are linked 

tgether for the purpose of sharing data and hardware resources. 

etworking in computers brings efficiency, economy, and effectiveness in an organisation. 

modern enables you to connect your computer to the available internet connection over the existing 

tleph one lines. 

erver is a computer that provides services to clients and controls access to hardware, software, and other 

sources whereas, clients are the computers, which request services, like data retrieval, storage, etc., from 

e server. 

> Network topology refers to the layout in which various components of a network like nodes, links, peripherals, 

etc., are connected and communicate with each other. 
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SECTION - A 

A. Fill in the blanks. 

1. is a computer network created for an individual person. 

2. system allows us to talk to any person in the world at anytime. 

3. A computer network enables two or more computers to share and hardware  

4. In a network, modification or upgradation of the software or data is done at a only. 

5. The computers that communicate with each other are called  

6. A network maintained without using wires is called  

7. and are the different types of networking. 

8. Network refers to the layout in which various components of a network are connected and 

communicate with each other. 

 

LAN Data Resources MAN Wireless networking 

Communication Single point - Nodes Topology PAN 
HINTS  I 

 

B. State True or False. 

1. Nodes and servers have the same function. 

2. Wi-Fi stands for Wireless Fidelity. 

3. Network cards are used to physically attach a computer with a network. 

4. WAN stands for Wide Area Network. 

5. In Client-Server network, there is no central server. 

6. Extranet refers to a computer network restricted to an organisation. 

7. In star topology, all the nodes in the network are connected in a circular manner. 

C. Application-based questions. 

1.	 Mr Hemant has set up his office with 50 computers. He wants to connect computers and peripheral devices 

within his office building with wires. Which type of network should he use? 

2. Which type of network architecture is the most suitable, when a few computers, having similar power and 

capacity are, to be networked together? 
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3. Arpita wants to attach her computer to a network so that it can participate in network communication. Which 

card should he use? 

4. Raman wants to send a few photographs and songs to one of his friends by interconnecting mobile phones, 

using short-range wireless connection. Which technology would be the most suitable for him? 

SECTION  -  B 

A. Multiple-choice questions. 

1. Which is the most commonly used network card? 

a. Wi-Fl b. Bluetooth c. Ethernet Network Card 

2. The  are the certain sets of rules that determine how data should be transferred overthe 

network. 

a. Protocols b. Network cards c. Both a and b 

3. What do you call the computers that are connected to the server? 

a. Nodes b. Laptop c. PC 

4. security means protecting data and resources from any unauthorised access. 

a. Network b. Information c. Resource Sharing 

5. is a device that connects wireless communication devices to form a wireless 

network. 

a.WAN b.Wi-Fi c.WAP 

6. Which network among the following requires a single communication line or one main cable? 

a. Bus Topology b. StarTopology c. Tree Topology 

B. nswerthefotlowing questions. 

1. What is networking? Give some common relevant examples. 

2. Differentiate between LAN and WAN. 



3. What do you understand by the term Network Security? 

4. Explain Client-Sever network in your own words. 

5. What do you understand by the term Network Topologies? 

6. Differentiate between Peer-to Peer network and Client-Servernetwork. 

C. Define the following terms. 

1. WAP 

2. StarTopology  

3. Server 

4. Node 

5. HUB 

Learning Kips uterswilh  

  



LAB SESSION Perfection Through Practice 

ONLINE LINKS 

A. Create an informative presentation using PowerPoint 2016, on the topic: 

Advantages of Networking. 

Apply the formatting and animation effects to make it impressive. 

Try to access a file from a shared drive, and copy it into the selected drive on your computer. 

GROUP DISCUSSION 

Divide the class into fourgroups and discuss the following topics: 

> What is a computer network and why is it useful? Differentiate between the various types of networks. 

> What sort of components are required to build a network? 

> What are hubs, switches, and routers? 

> How is Peer-to-Peer network different from Client—Server network? 

> Differentiate between Star and Tree Topology. 

Using Creativity 

Make an informative presentation on Basic Networking Concepts. Collect information about the 

varkus devices and components that are used for setting up the network, and about the types of 

netorks. 

For Concept Clarity 

Looking For More 

To clarify the basics of networking concepts, visit the following websites: 

> www.slideshare.net/makyongl/basic-concepts-of-computer-networks  

) https://www.lifewire.com/cornputer-network-topology-817884  

Learning 
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LOG ON TO ACCESS 

' Rules for naming a field 

r Data Types, Setting of Data Types 

r Field properties, Primary key 

' Editing tables 

r Sorting, Filtering, Searching of data 

r Closing access, Opening an existing database 

LEARNING IN THIS CHAPTER 

r Concept of Database and DBMS 

r Types and structure of Database 

r Advantages of DBMS 

r Access 2016 and its components 

Creating a Database 

r Views of table, Adding a table 

Information is an important factor to manage our routine activities, and so is its maintenance and management to 

plan well for the future. From a child to an old man, a professional to a homemaker, everyone needs information. 

However, data in its raw and unprocessed form is meaningless, but when such data is converted into information, it 

can be easily interpreted. Hence, it is essential to provide a structure to the available data in a computer system and 

organise it, which can be achieved with the help of a database. 

A database is an organised collection of data. It helps us to enter, manage, access, and analyse a large amount of 

information, quickly and efficiently. 

DATABASEAND DBMS 

Unknowingly, you all use database in our daily life. You maintain your personal address diaries, wherein you 

record addresses and telephone numbers of yourfriends. You maintain the information alphabetically, so that 

whenever any information is needed, you could browse and extract the information quickly. From time to 

time, you keep on adding new addresses, and also update the contact numbers and postal addresses of your 

friends if there is any change. All these operations that you perform, like adding, updating, sorting, editing, 

deleting, etc., are the functions of a database. 

Example Telephone directory, a dictionary, maintaining a list of students and their addresses, keeping their records 

pertaining to academic and co-curricular achievements, list of groceries in a grocery store, catalogue in a 

library, list of customers in a bank, maintaining employees information in offices and organisations, etc., are 

the examples of different types of database. 

It is very difficult to maintain a database manually when there are hundreds and thousands of records, as the 

chances of committing errors increase. A Database Management System (DBMS ) is a computerised record keeping 

system that enables you to create, modify, store, and extract information from a database. It saves time and energy. 

The main function of a DBMS is to provide the users with efficient and reliable methods of data retrieval. Moreover, it 

reduces the chances of errors creeping into the database to a great extent. Therefore, data handling using DBMS 

becomes fast and efficient. 

TYPES OF DATABASE 

There are mainlytwo types of database: 

FLAT FILE DATABASE :  A flat file database refers to the data files that contain records, which have a small, fixed 

number of fields, without any structured relationship. For example, Microsoft Excel. 
Learning 
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Fields 

Maths Hindi 

Table: Students 

Data 

Roll No F_Name 

Give any real life example 

of database, apart from 

the one given in the 

chapter. 

Let's Know More 

Microsoft's SQL Server is 
an example of DBMS that 
serves database requests 

from multiple users. 

Quick Quiz 

What is the difference 

between a file and a 

database? 
p 

RELATIONAL DATABASE :  A relational database stores the data in several tables and 

link those tables together to get a common piece of information. For example, Microsoft 

Access, Microsoft SQL, Oracle. 

ELEMENTS OF DATABASE 

A database contains a specific structure to store data. Let us study some basic 

terminologies used in a database that will help you in getting acquainted with the 

functioning of a DBMS. 

1. TiBLES: Tables are the building blocks of a database. They store the complete 

data in a structured manner, i.e., in the form of rows and columns. Every table has a 

finite number of columns and rows. 

Elements of a Table 

Fields: All the columns in a table are called fields. Afield describes a particular attribute of 

all the records in a table. For example, the field that mentions the Roll No. of the table: 

'Students', will store the roll numbers of all the students. 

Records: The rows in a table are called records. A record contains the values for all the 

fields that belong to a single person or an entity. For example, when you enter data of all 

the fields, such as Roll No, F_Name, and Marks for a given student, it creates a new row in 

a table, which is called a record. 

Data: A set of characters that represents a valid value is known as Data. For example: 3, 

Dipti, 90, 88 and 70 are the data values for the specific fields of the following table: 

'Students'. 

Figure 2.1: Elements of a Table 

2. QUERIES : A database stores a vast amount of data, but queries help us to retrieve 

the filtered data based upon some conditions. Queries are also used to perform 

actions, such as delete, update, etc., on the data, based upon some criteria 

(conditions). 

3. FORMS: Forms are the userfriendly interfaces that facilitate the process of entering 

data in tables and queries. A form has an attractive interface that accepts data from 

the user and forwards it to the corresponding table or query. 

4. REPORTS:  Reports are used to display the selected data in a printable format. They  

Quick Quiz 
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collect the summarised data from one or more tables/queries and organise it in a printable form. 

ADVANTAGES OF DBMS 

Some of the key advantages of DBMS are as follows: 

A DBMS provides the users with efficient and reliable methods of data retrieval. 

It facilitates the reduction of data redundancy (duplication of data) and elimination of multiple copies of the 

same data at different locations. 

It increases the efficiency, speed, and flexibility in searching and accessing information, thus saving time and 

energy. 

DBMS facilitates sharing of data among different users based on their individual needs. 

In a DBMS, the data administration has a complete control over the database. It ensures that data is accessed 

only by the authorised users. 

A DBMS also supports the data integrity as it ensures that the stored data follows the customised standards of an 

organisation. Suppose, the maximum marks of an examination are set to 100, you can have rules to make sure 

that the database accepts the numbers only between the range of 0-100. 

MICROSOFT ACCESS 

Microsoft Access is the most popular and powerful Relational Database Management System 

(RDBMS) that serves as an integral part of the Microsoft Office suite application. It has a graphical 

user interface. It is used to organise and manipulate a large volume of data efficiently. It organises 

data in the form of tables. It provides the facility to create a relationship between these tables by 

using the common fields. A relational database, enables to prevent the duplication of data. 

Another important feature of Access is that you can add, update, delete, and view the data by 

using forms, find and retrieve the data in a desired way by using queries, and print the data in a specific layout by 

using reports. Some other popular RDBMS are Sybase, Oracle, and Structured Query Language (MySQL). 

Let us understand the concept of relationship with the help of an example: 

To maintain the students' database in RDBMS; instead of entering all the records in a single table, you will split 

the fields into two tables having a common column, such as Roll No. 
1 

Example 

1. STUDENTS IN FORMATION TABLE 

The 'Students Information' table consists of information about students as displayed in the below given table. To 

enter the details of students' percentages and grades, you do not have to include all the fields in a separate table, 

which have already been included in the 'Students Information' table. You will take only a common field in the 

second table. By making a link on this common field, you can retrieve the desired set of records from both the 

tables. 
Roll No F_Name Father's_Name Address Tel_No Date_of_Birth 

101 Kabir Mr.R.Nanda 675/4,Pkl 2577899 21-01-1991 

102 Manas Mr.J.R. Nanda 212/2, Pkl 2645624 16-09-1984 

103 Ridhima Mr. D.B. Bhatia C-46/58, Noida 2570066 24-10-1992 



2. MARKS TABLE 

Notice that the values of the Roll No field in the Marks table are the same as 

the values in the Students Information table. You can define a relationship 

btween both the tables using a common field, i.e., Roll No. Thus, by splitting 

irformation in separate tables, RDBMS reduces the duolication of data. 

Roll No Percentage Grade 

101 89% A 

102 59% B 

103 70% B 

OMPONENIS OF MCkUSOFT ACCESS 2O1 

Before learning about the various functions of Microsoft Access, let us get familiar with the various components of 

Microsoft Access window: 

  

Tdle Bar LT&1  me what you want to do Quick Access 
Toolbar 

Tabs 

   

Fre Home 

Databaei 5: Datdbase- C:\UserAUser\Do...  

c", Eyternal Dt Daaba' Tc-c.I - - Ta.e e.i rr' --- - 

Views Clipboard c. 

V 
lew Pate - Filter 

c'Ascendlng Yç- 

.jDescendlng
lJ 

Refresh 
Remove Sort 'Y c oet 

Sort&Fiiter Record: 

He 

All Access Objects @ 
p 

Tables 

b - 

Students info Object Tab 

ROLL NO - FIRST_NAME 

101 Manish Kumar 

102 Prlya Gupta 

103 GauravSingh 

104 Nlshant Bharat 

105 Trisha Singh 

106 Krish Mukrjee 

(ahbñ (Detail) - 1 - 
-) 

Find 

Find 

B Ill 

Text Formatting 

Ribbon 

x 

CL&SS. • FAThER NAME ADDRESS 

10 98 Viay Kumar #445, Chandigarh 

12 90 Lallt Gupta 334. Panchkula 

11 87 Vikram Singh #211, Panchkula 

12 78 Ganesh Bharat R111, Chandigarh 

10 93 Harish Slngh #10, Chandigarti 

10 65 Goyan Mukhrjee #112, Ctlandigarh 

Navigation 
Pane 

Navigation 
Buttons 
sheet Vkw 

Work Area 

eco 4 4 7o17 4 !' NFitter SeMth 

Figure 2.2: Components of Microsoft Access 2016 

TITL  BAR 

It is located at the top of the window and displays the name of the current database. 

QUI K ACCESS TOOLBAR 

This tolbar is present at the top-left corner of the Access window. It contains the most frequently used command 

buttns. By default, it has three buttons, which are Save, Undo, and Redo. 

RIBBON 

It contains various tabs, each with several groups of relevant commands. Some tabs appear when you work with 

certain objects like Forms. Such tabs are called Contextual tabs. 

It is a new feature, which can be used to get quick help on topics that you are looking for or the commands that you 

want to use in your document. 
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1. 

D. 

01 T 8. 

NAVIGATION PANE 

This pane is present on the left side of the Access window. It displays the name of the objects used in the database, 

such as Table, Queries, Forms, Reports, etc. 

NAVIGATION BUTTONS 

As the name suggests, it helps in navigating through the records. The Navigation buttons display the current record 

number in an object. 

OBJ ECT TABS 

The objects that you have opened in a database appear right above the work area in a tabbed form. Clicking on any 

tab displays the contents in the Work area. To close the current tab, click on the cross button on the right end of 

the bar. 

STATUS BAR 

This bar is located at the bottom of the window. On its extreme left, it displays the name of the current view, and on 

its right, it displays four view buttons, which are Datasheet View, and Design View, PivotTable View and PivotChart 

View. 

Access 2013 

In Access 2013, no background colour is given on the top menu as in Access 2016. This colour helps the top menu stand 
out more clearly. 

tCIarity I VU á:  tJJ ror netter oncepi 

A. Assess your knowledge on database with the hints given below: 

DOWN 

1. An organised collection of data.  

2. A computerised record keeping system that provides the users 

with efficient and reliable methods of data retrieval. 

3. R 

4. 

F 

2. 

L 5. D T  6. I 

4. A type of database having fields without any structured 

relationship. 

 

7. 

 

I  ACROSS
E 

3. A database object that displays the selected data in a printable format  

5. A set of characters that represents a valid value  

6. The building block of a database that displays data in the form of rows and columns  

7. A type of database that prevents the duplication of data  

8. A database object that provides user friendly interface to facilitate the data entry process  
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Quick Quiz 

What are the different 

database objects in 

Microsoft Access? 

The overall design 

structure of the database 

is called the Database 

Schema, which describes 

the records and 

relationship among them. 

Let's Know More 

C,... 

Ac'—, 

3— 

the displayed list. Here we have selected the Updated: 

D.O...-(AU,.o\ F.. 

New 

$..thfo. - 

-- D_ I. - I3 

Figure 2.3  Selecting Updated: Students Template 
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Let's Discuss 

Advantages of  RDBMS1 

Consider the given table and answer the questions. 

Teacher_Id Na me Salary Dept 

1 Komal 15000 Physics 

2 Priya 17000 Physics 

3 Sa njay 18000 History 

4 Vi kra m 14000 Biology 

5 Vineet 18000 Maths 

6 Monika 16000 Commerce 

What isthetotal numberof records in thetable? 

How many number of fields are there in the table? 

Name the teachers who work in the same department. 

How many teachers are earning more than 1 5000? 

What is the Id of the teacher who works in the Maths department? 

In Mi 

or cr 

app" 

and 

Open Access 2016. 

You will find some listed templates on the right side of the window. 

Slect the template from 

S udents template. 

Y u can get more 

t mplates by clicking on 

a y category from the 

Suggested searches or 

use the search bar to look 

for the Online templates. 

The Updated : Students 

task pane appears on the 

screen. 

H> 

'I,  

> 

> 

> 

REATING A DATABASE 

rosoft Access there are two ways to create a database, either by using a template 

ating a blank database. An Access template helps in creating a complete database 

ation that is ready to use. It contains four main objects like Tables, Queries, Forms, 

ports, etc. that you need to perform a specific task. 

CREATING A DATABASE USING TEMPLATES 

One df the easiest way to create a table is to use a template. Follow the given steps to 

creata database usingthe template: 



;; M...F.- — 
1.... .— — 

Student List 

 

!J 

  

t,.d.m :—  dd 7 

USiJt,,,O 

   

taIc SUML..X 

          

[Search icr online templates p 

Suggested sechev Oatabese Budnem Logs lndust. Lltts Pemonal 

Inventopim 

        

        

        

        

        

       

Custam*thiçp 

 

Figure 2.5:  Selecting Blank Database Option 
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) Specify the file name in the File 

Name text box. You can either use 
T. 9 

the default location that Access '-i- '' 
-  -  
MA - displays below the File Name box or 

click on the folder icon to select . 

another location. 

> Click on the Create button. Access 

creates the database and displays Figure 2.4:  Displaying Table in Form View 

the table in the Form View. It 

contains the fields which are relevant to the Students database. 

> Click on the Layout View button on the right side of the Status bar. A new contextual tab - Form Layout Tools will 

appear on the Title bar. 

> Select the Add Existing Fields button in the Tools group under the Design tab. The Field List task pane appears 

on the right side. 

) Select the fields from the list that you want to include in the Student List database. 

) Drag the selected field to the table and drop it where you want to position it, when the insertion point appears. 

Access suggests a file name in the File Name box, and also allows you to change it as per your requirement. 

CREATING A BLANK DATABASE 

You can also create a database from scratch. Follow the given steps to create a blank database: 

) Click on the Blank database option. 

) The Blank database window opens up that prompts you to specify the file name in the File Name text box. By 

default, a system generated database 

name appears in the File Name text box in infos 

the format [Database <n>] where n is a 
° 

number that changes sequentially as the New 
databases are created. 

> If required, you can change the default 

location by clicking on the folder icon 

placed next to the File Name text box. 

> Click on the Create button. A new database 

will be created along with an empty table 

named Tablel displayed on the Title bar. 

> The fields tab is selected by default. A new 

tab, i.e., Table Tools will be now visible on 

the Title bar. 
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Datasbeet VZew 

Home 

Design View 

Figure 2.7:  Views of 
a Table 

When you open a new or existing database in MS Access 2016, the objects in your 

database - tables, forms, queries, reports etc., appear in the Navigation Pane. To view 

the objects, click on the drop-down arrow of AllAccess Objects in the Navigation Pane. 

1 VIEWS OFA TABLE 

You can work on a table in two views: Design view and Datasheet view. 

DESIGN VIEW 

In Design View of the table, you can enter the field names, their data types and 

description. The Design View is divided into two parts: 

FeId rid Pane 

In this pane, you can define the field names, their data types, and description. 

Field Properties Pane 

This section is used to set properties for the fields defined in the table. 

Let's Know More 

The standard file name 

extension for database in 

Microsoft Office Access 

2016 is the same as it is 

for MS Access 2013 and 

that is .accdb 

Quick Quiz 

To save the database, 

press Ctrl+S key 

combination or choose the 

Save option from 

the File tab. 

a 

DATASH EET VIEW 

Dataheet View is used to enter 

data n a table. This view displays 

the tbIe as a grid. The fields are 

displyed as columns and the 

records are displayed as rows. The 

fields names are listed as the 

column header. When you double 

click on the table name in the 

Navigation Pane, it opens the 

table in the Datasheet View. 
D,t.411. 04. S*.& Ii. 0*all* 00*41001 

SWITCHING BETWEEN VIEWS Figure 2.6: Displaying Table in Design View 

Microsoft Access allows you to switch from one view to another 

by following either of the two options: 

Click on the View button present in the Views group either 

on the Home tab or Fields tab in the Views group and select the 

desired view. Or 

Click on the Design View or Datasheet View buttons at the 

right cornerof the Status bar. 

ADDING A TABLE 

Quick View 

To quit Microsoft Access, 

press Alt~F4 key 

combination, 

LeVs Know More 

The Datasheet View 

allows you to enter data in 

a table. It looks like an 

Excel spreadsheet. 

Regardless of how you have created your database, you can add new tables to an existing 

database in various ways. These are: 

dingtables in the Design view 
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Computers with  KPS 

>A 



r.hflt 

r..#. 0...h 

c_D_ - — 
P.- t U D*SP.o. D.pa 

tu.,... F.. J..npm4t....5 '.St... 

%PCVFTP.P 
C1. s•tt..t 
HOP4. VOITUI 
Taj_Pn 

Sflc. ;S.P4 

Op..rp, -. 

j . raP. 
is- 

se_Os. F 

P_a F. 
* a. 
TFPMIP 54PeS 

F...r.... Ft. t,,w.. PS.... fl..I.a Ti   

Figure 2.9:  Adding Fields in Design View 

App&ation Tab'e Table SbarePomt Query Querj Form Form Blank Report Report Blank 
Pads • Design UsEs • Wizard Design Design Form Design Report 

Templates Tables Querico Formt Resorts Ma 

infokips pkl ? 
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Fri 14orne Create External Data Database Tools 

Table Tool, 

FIgure 2.10: Adding Table In Datasheet View 
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Student_dat Tablel°'\ 

 

   

ID Fieldi 

1 Priya 

(New) 

5tudent_data'[ Tablet 

ID . Fled1 . Fletd2 - Freld3 - Click to Add - 

1 Tr, 9779451704 

3 Kabir Panchkula 97794517O 

Figure 2.11: Adding Fields in Datasheet View 

Addingtables in the Datasheet view 

>. AddingtablesusingtheTableTemplates 

ADDING TABLE IN DESIGN VIEW 
Student database: Database C:\Uoees\User\0ocurnents\Studerst  data... 

fIe Home Create External Data Database Tools 0  lell eec sihat you w 

Click on the Table Design button on the Create tab in the 

Tables group. A table will be created and opened in the Application Table Table SharePoint Query Query Form Form Blank Repo: 

Design View. 
Paits 

Templates - 

Design Lists 

Tables 

Wizard Design 

Queries 

Design Form 

Forms 

Adding Fields in Design View Figure 2.8: Adding Table in Design View 

> Foreach field in the table, type a name in the Field Name column 

and then press the Tab key to move to the Data Type column. By 

default, the Short Text data type appears in this column. 

In the Description column you can type a description for each 

field, which is optional. The description text is displayed on the 

Status bar when the cursor points to that field in the Datasheet 

view. 

- After defining all fields, save the table by clicking on the Save 

option in the File tab. Or 

Select the Save  [j  present on the Quick Access Toolbar. 

> Now to add data in the table, switch to the Datasheet view. 

ADDINGTABLE IN DATASHEET VIEW 

When you create a blank database, Access creates a table automatically. You can either customise this table or 

create another table by using the Create tab. To create a table in the Datasheet view, click on the Create tab and 

selectthe Table button in the Tables group. A new blanktable will be created and opened in the Datasheet View. 

Adding Fields in Datasheet View 

> Access automatically creates the first 

field called ID. The Data type of this 

field is Autonumber, which means 

Access will automatically generate a 

sequential number in this field for each 

new record. 

You can add a new cell to the table by entering data in the 

Click to Add column. Access will automatically assign a data 

type based on the data you enter. 

Let us enterthe first record: 

Click on the empty field below the Click to Add header. Enter 

the name of the student, e.g. Priya and then press either the 

Tab or the Enter Key. You will notice that Access has assigned 

value ito the ID field and named the second column as Fieldi. 



Now, the Click to Add label shifts to the third column. Observe that the icon in the row selector changes to a 

pencil, which indicates that the record has been changed but not saved. The asterisk (*) sign moves to the next 

row. Observe that two tabs Fields and Table appear on the ribbon underthe Table Tools contextual tab. 

) Enterthe required data. Press the Tab key after each entry. 

> Save the table by selecting the Save icon  [1  present on the Quick Access Toolbar. 

RULES FOR NAMING A FIELD 

As you already know that a table has multiple fields and each field is unique to a table. Each field has its own name 

and data type. Following are some rulesfornaming a field: 

>- Afieldnamecanrangefrom 1 to 64 characters. 

) A field name can include letters, numbers, and some special characters. Generally, the underscore (_) sign is 

used. 

> Afield name cannot start with a blank space. 

) Afield name can be in the upper, lower, or mixed case. 

Afield name cannot have a period (.), exclamation (!), brackets ([]), or the grave account. 

You can change the properties of a field name, i.e., storage size, format, and validation rule by specifying 

certain characteristics in the Field Properties pane. 

IATA TYPES 

Every table consists of fields and every field has its own set of properties, which describe the characteristics and 

behaviour of data added to that field. The most important property for a field is its data type. A field's data type 

determines what type of data you can enter into a field. For example, a field whose data type is 'Number' can only 

store numeric data and does not allow you to entertext data into it. 

The following table depicts the available data types in Access 2016. 

D taTypes 

S ort Text 
It is used to store text or a combination of text and numbers that does not require calculations, such as 

addresses and phone numbers. The fields with this data type can have a maximum of 255 characters. 

Functions 

Lbng Text 

 

It stores text and numbers up to 65,536 characters. It is used for descriptive fields. 

   

Number 

  

 

It stores numeric information that you can use for calculations. A number data type can store integer 

values as well as decimal values.The maximum size of a numberfield can be 16 bytes. 

It stores date and time values. You can display dates and times in various formats. The maximum size 

used by this data type is 8 bytes. Calculations related to date/time can be done in this field type. 

This data type Is used to store monetary data upto 8 bytes. 

It generates a sequential number whenever a new record is added to a table. The value in the 

AutoNumberfield cannot be changed. It stores data as 4-byte values typically used to create an identify 
column, which uniquely identifies each record in a table. 

Date/Time 

Currency 

AutoNumber 
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If you don't find the desired data type in the Data Type 

gallery, then click on the More Fields button present in 

the Add & Delete group. 
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Yes/No 
It is used at places where the field can have only one possible value. It can either be True/False, Yes/No, 

or On/Off. For example, a student can either be a male or a female. 

OLE Object 
This is used to embed an object created in another application, such as Microsoft Word document, 

Excel spreadsheet, or PowerPoint presentation into the Access table. It stores up to 2GB of data. 

Hyperlink 
The Hyperlink data type can store links to web pages, websites, files on an Intranet or LAN on your 

computer. It stores upto 1 GB of data. 

Attachment 

This data type allows you to attach images, spreadsheet files, documents, charts, and other types 

of supported files to the records in your database, much similar to the manner you attach files to 

the e-mails. 

Calculated 

This data type is used when a user creates table fields that calculate values. The calculations can 

include values from fields in the same table as well as built-in Access functions. This data type is 

used mostly in case of queries, forms, and tables. 

Lookup Wizard 
A Lookup wizard helps you to create a field whose values are chosen from the values in another table, 

query or list of values. By  default, Access sets Lookup fields to the Number data type. 

2 SETTING DATA TYPE FOR A FIELD 

You can set the data types for the table fields by working in either Datasheet View or Design View. 

SETTING DATATYPE IN DATASHEET VIEW 

When you create a field by entering data in Datasheet View, Access 2016 automatically assigns a data type to the 

field based on the data you have entered in the table. To define a specific data type for a field: 

> Click on the drop-down arrow of the Click to Add header and choose the required data type from the displayed 

list. Or 

Click on the required data type that you want to assign to the 

field from the Data type gallery present in the Add & Delete 

group on the Fields tab. 

) You can reset or change the data type of a field as and when 

required by clicking on its header and selecting the required 

data type from the Data Type drop down list in the 

Formatting group. 
Figure 2.12: Resetting Data Type in Datasheet View 

SETTING DATATYPE IN DESIGN VIEW 

When you add fields to a table in the Design View, by default 

each field is assigned a Short Text Data type. To change or define 

a specific data type for a field: 
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Figure 2.13:  Setting Data Type in Design View 
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Let Us Recall 

What is a Relational 

Database? 

C aption 

Def wit Value 

Click on the drop-down arrow in the Data Type column of the field and select the desired 

data type from the displayed list. 

)  PIELD PPflPF PTIFC 

A field property applies to a particular field in a table and defines the characteristics of 

that field. Each field in a table has its own set of properties that further defines the field 

and how it is used in the database. You can set the properties of a field in the Design View 

as well as in the Datasheet View. 

TO SET FIELD PROPERTIES IN DESIGN VIEW 

> Click on the field name forwhich you want to set the field properties. 

>  Yqu will observe that the General tab is selected by default in the 'Field Properties' 

pne. 

) Sétthepropertiesofallthefieldsasrequired. 

> Afterfinishing the task, you must save the table by clicking on the Save button on the 

Quick Access Toolbar. Or 

Click on the File tab and select the Save option. 

Description 

This property is used to specify the maximum size for the data stored. It is 

available for Short Text, Number, and Autonumber datatype. 

This property specifies the display layout of the field. it has different 

options for Number, Date and Time, and Logical data. You can select a 

predefined format or enter a custom format. 

It specifies the pattern for the data to be entered in the field. For example, 

you can choose the input maskfora password field as . 

The Caption property specifies a label for a field to be displayed as the 

column heading whenever the table is displayed in Datasheet View. It can 

contain up to 2,046 characters. 

You can use the Default Value Property to specify a value that is 

automatically entered in a field when a new record is created. The user can 

either accept this value or enter a new value. 

With the help of this property you can limit the values that can be entered in 

the field. For example, if a field's validation rule is >o, then a negative value 

cannot be entered into that field. 

This property lets you customise the error message that appears when you 

entera value that violates the validation rule. 

You can use this property to specify if a value is required in a field. it accepts 

two values—Yes (to ensure that the field is not left blank during data entry), 

No (field can be left blank). 
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Let's Discuss 

Short Text Data Type 

Long Text Data Type 

Field Property 

Field SIe 

Format 

Input Mask 

Validation Text 

Required 

ation Rule Valid 

Quick Quiz 

Press CTRL + W to save the 

changes and close the 

Table. 

Let's Know More 

You can also create table 

by selecting the Table 

Design option in the 

Tables group under the 

Create tab. A new table 

opens in the Design View. 
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Figure 214: Setting a Primary Key 

Do you want to save changes to the design of table Tablea? 

Yes No Cancel 

Figure 2.15: MS Access Confirming to Save Table 

- Stud.nt Tab'e 

ROLL_NO FIRST_NAME - 

101 Mansh Kumar 

102 Priya Gupta 

103 Gaurav Singti 

1ONhacIt 

105 Trisha Sr.gt1 

106 Kristi Mukrjee 

CLASS • MARKS FAThER_NAME - 

10 98 Vijay Kumar 

12 90 LalitGupta 

12 87 Vikram Smgh 

32 78 Ganesls 8harat 

93 Hans Sx 

10 65 Go'-an Mukhr1ee 

C 

I 
Figure 2.16: EditIng Records in a Table 

PRIMARY KEY 

Primary key is a standard feature of every database management 

system. A Primary key is a sort of a check on the table that every 

record in the table is unique. The field that is designated as the 

Primary key of a table neither can have duplicate data nor it can be left 

blank while entering the data. 

Suppose, you have a Student table that contains records regarding 

students of a class. The students' Roll no. field can be set as a Primary 

key, since all the roll numbers are unique for each student. You 

cannot consider the students Name field for Primary key as there is 

always a possibility that more than one student in a class might have 

the same name. 

-- - 

If more than one field is combined to form a primary key, then it is called a Composite key. 

Setting a Primary Key 

To setthe Primary keyfollowthe steps given below: 

In Design View, click on the field that you want to set as the Primary key. The selected field will be highlighted. 

Click on the Primary Key button ,present in the Tools group on the Design tab. Or 

Right-click on the field and select the Primary Key option from the Context menu. 

> The field will be set as the Primary key indicated bya small key in the field selector column. 

Microsoft Access x 
> Click on the Close button on the Table window. 

> Access prompts a message window reminding us to save 

the changes. 

> Click on the Yes button to save the changes. 

The Primary key is a toggle key. To remove the Primary key check from a field, select that field and click on the 

Primary Key button. 

FEITING TABLES IN ACCESS 2O1. 

After entering data in a table, sometimes it is required to 

make changes in the database. This can be done in the 

following ways: 

To edit a record directly, scroll through the records or use 

the Record Navigation buttons to find the record to be 

edited. 
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NAME CI.ASS 

4 sort Smallest to L3rgest 

J, Sit Largest to Smallest 

Ltl ppy 

E&d Width 

Hide fields 

nhid Fields 

Freee Fields 

Unfreeze All Fields 

Find.. 

Insert FIeld 

Modify Lookups 

Modify sreston 

Rename Field 

OedeFleM 

> Double-click on the cell where you want to make changes. 

) Tjpe the information into the field. A pencil icon 1  appears in the extreme right in the record selector column to 

in icate the Edit mode. 

) CI ck outside the record to apply the change. 

INSE TING/DELETING FIELD IN DATASHEET VIEW 

> Open a table in Datasheet View. 

Right-click on the field on the left of 

which you want to insert a new field. 

The Context menu appears. 

Select the Insert Field option. * 

StudestTable. 

Fleldi 

    

ROLL NO • FIRST NAME 

101 Manlsh Kumar 

102 Pnya Gupta 

103 GauravSingh 

104 Nishant 

105 Tntha Sngh 

105 KriSh Mukrjee 

CLASS • MARKS FAThER_NAME. 

10 98 ViJay Kumar 

12 90 Lalit Gupta 

12 87 Vikram Singh 

12 78 Garresh Bharat 

10 93 HarsshSingh 

10 65 Goyan Mukhrjee 

ADDRESS 

#445, Chandlgam 

$134. Panthkula 

$21, Panchkula 

$11, Chandigarh 

$10, Chandigarh 

#11. Panchkula 

  

      

Figure 2.17:  Inserting a Field in Datasheet View 

The new field named as Fieldi will be inserted on the left of the selected field. 

Or 

Select the field on the right of which you want to insert the new field. 

>' On the Fields tab in the Add & Delete group, choose the data type for the field. 

> The new field named as Field 1 will be inserted on the right of the selected field. 

NOTE 

Likewise you can delete a field in two ways: 

> Right-click on the field to be deleted and select Delete Field option from the 

context menu. Or 

Select the field to be deleted and then click on the Delete option in the Records 

group on the Home tab. 
Figur 2.18: Selecting Field Option 

MOViNG A FIELD 

> CIck on the field header and Drag and drop 

thbfield to the desired location. 

While dragging you will a find a thick dark line 

the position where the field will be placed. 

As you release the mouse button, the 

selected field will be placed at the new 

location. 

Ste.rt Table 

ROLL_NO . FIRST NAME 

102 Prsya Gupta 

103 GauravSingh 

104 Nushant 

• CLASS 

12 

12 

—a 

MARE .ER_NAME - AODRESS 

Lalit Gupta $334, Panchkula 

87 Vikram Singh 21, Pand'rkula 

73 C'anesh Sharat 511. Chandgarh 

_)sandigarh 
MARKS ADDRESS anchkula 

102 Priya Gupta LaIR Gupta 12 90 5334, andtkuIa 

103 Gaurav Singh Vlkram Slngh 12 S7 *2L Panchkula 

104 Nishart Gjneth Sharat 32 78 $11, Chandgarh 

105 Trisha StrIgh Hansh Szngh 10 93 510. Chandigarh 

106 Knsh Mukr1ee Goyan Mukhr;ee 10 65 1L 5anthkula 

* 

FIgure 2.19: Moving a Field 

appearing between the fields. This indicates I 
ROI.LNO FIRST NAME - FAThER_N CLASS - 

HIDE/UNHIDE FIELDS 

) Right-click on the column header that you want to hide and select Hide Fields option from the context menu. 

> To unhide the fields, right-click on any column heading and select the Unhide Fields option from the context 
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menu to open the Unhide Columns J  StudentTabt'\______________ 

dialog box. Select and clear the check L 
boxes to control which fields should be 

visible. 

x 

tRKS ADDRESS 

90 #334, Panchkula 

87 #21, Panchkula 

78 #11, Chandigarh 

93 #10, Chandlgarh 

65 #11, Panchkula 

ROLL NO FIRST_NAME
j SrtZtoA 

LalltGu 
Vikram :i7 copy 

Ganesh Palte 

Hansh
ed W;dth 

Goyan 

101 Priya Gupta 

102 GauravSingh 

103 Nishant 

104 Trlsha Singh 

105 Krish Mukrjee 

Student TabIe\ 

ROLL_NO - FIRST_NAME CLA 

101 Pnya Gupta 

102 GauravSingh 

103 Nishant 

104 Tnsha Singh 

105 Krlsh Mukrjee 

* 

MARKS ADDRESS 

90 #334, Panchkula 

87 #21, Panchkula 

12 78 #11, Chandigarh 

10 93 #10, Chandigarh 

10 65 #11, Panchkula 
H 

Likewise, you can Freeze or 

Unfreeze the columns. 

House . Class . TultlOfl_Ft -- 

SoelicA 

35, 

T4 Et"s 

lOoted AI 

iy 

Minis 
vtay 

OK Csncdj 

C 
.2 

Slndnnt Info 

Roll_No 

1KabIr 

2 AJay 
S Vljay 
4 Bhanu 
t. ManM 

Figure 2.22: FilterIng In a Datasheet 

Figure 2.20: Hiding the Field 

SORTING DATA WITHIN A TABLE 

You can sort data within a table with respect to a 

particular field either in an ascending or a descending 

order. To Sort the data, follow the steps given below: 

> Selectthefieldthatyouwishtosort. 

> Click on the drop-down arrow next to the right of 

the field or right-click on the field. 

> Select either the Sort Smallest to Largest or Sort 

Largest to Smallest option (if the field is numeric) or 

Select the Sort A to Z or Sort Z to A option (if the 

field is alphanumeric). 

> Observe the change in the database. 

Student 

ROUI0 • FIRST NAME . FATHER_NAME . MARKS . ADDRESS 

101 Priya Gupta Lailt Gupta sot Smtest to Largest 
102 GauravSlngh Vlkram Slngh J,. Sort Lugtt t Sns,Uest 
103 Nlshant Ganesh Bharat 

104 Trisha Singh Harish Stngh 

103 Krsh Mukr1ee Goyan Mukhrlee N,mbe, F,fte,s 

IStle(tAøt 
tatantul 
10 
12 

OK Cancel 

Figure 2.21: SortIng Data in a Table 

' > The Sort buttons-Ascending and Descending on the Home tab in the Sort & Filter group is another way to 

sortthe data. 

) To clear your sort, clickonthe Remove Sort command on the Home tab in the Sort& Filter group. 

FILTERING IN A DATASHEET 

You can display specific records of a table in datasheet with help of Filter 

option . The steps to filter data in a datasheet are as follows: 

> Click on the drop-down arrow present at the right of the column 

header whose data you want to filter. 

> By default, Access selects all the check boxes under the Text Filters 

option. Click on the Select All check box. All the selected check boxes 

will be deselected as shown in the Figure 2.23. 

> Now, select the items that you want to display in your datasheet. 

You can select as many items as you want. Here, you are selecting 
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Computers with  IPS 



Stadost Info 

Roll No Student Name . House • Class 
1 Kablr crtAioZ 

24j3y
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3 Vijay 
4 Shanu 
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Menus 

0 vay 

Tuition_Fee 

OK Concri 

  

Date s.tS Dat.sbuse 

FIn Hon.n £etesne Data Dabesel*.*. Tube cc 

T Assendaug Y Stcun Nun ToOts 

j Desconding  "j  M-.snsnd - Sans 59550,9 
-, Rthasl, 

' Fo,ns,t Pants, Rsseo.ss os-S Ie9gleFdtes M - Deicte Mn,e 

Vbe.s Clpboaad Sen 

Roll No Student Natne.3 House • Class . Tultionee- 
ikablr Green 
2A;ay Blue 
S MaCas s- Yello 

Reoo,d 4 1 of 'I I 1'  fdlat,d Sea,d, 

DatashestVsew Nuottods Afts,ed 

Vie. 

CIA 

Jj Copy 

10 500 

10 500 

10 500 

Class Tuition_Fee 

10 500 

10 500 

10 500 

Custom Rite, ? )< 

Class s eQual to 

loel Cancel 

Student_into 

Roll No Student_Name House C)aJ Tusttors_a'e 

1 Kabir Green 10 500 
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Flgu 2.23:  Deselected 
check boxes 

the names of onlythree students. 

Click OK. The filter icon will appear at the right 

of the column header. It Indicates that the 

column is filtered. If you point at the Filter icon, 

Access shows the filter criteria. 

> You can remove the filter, by clicking on the 

toggle Filter button in the Sort & Filter 

group on the Home tab. 

- 

Figure 2.24: Selecting the Filter Criteria 

5ucjnfo Filter icon 

RaUNo Student_N.Y House 

Green 

2 Ajay Blue 

5 Manas Yello 

Figure 2.25: Filtered Data 

>  You will observe that the datasheet is back to its 

orginal form. 

Figure 2.26: Displaying Data after Removing the Filter 

AkVANCED FILTERING IN A DATASHEET 

An Advanced Filter is quite similar to a multilevel sort in Microsoft Excel. An Advanced Filter can really help you to 
narror down your records. This is like running a miniature query only on one table. 

ToaplyanAdvanced Filter 
I eaSe Gn*' 5.sSeaI.asn L.es 

Selectthe Class column header. Clickon the drop-down 
4gbasna 

artowpresentattherightofit. noon L.. _________ 

* jsaau,nsc DnostisIIs-. 

Select the Number Filters option. A cascading menu 

appears displaying the options as shown in -S.  

Figure 2.27. 

Figure 2.28: Specifying the CrIteria 

This displays all the records of class 12 students. 

Figure 2.27: Number Filters Cascading Menu 

> Select any of the options from the list. Here, you are 

selectingthe Equals option. 

> The Custom Filter dialog box appears. Type 12 in the 'Class 

is equal to' text box and click OK. 

Student nto 

Roll_No Student_Name House • Class -'1 Tuton Fee 

3 Vljay Green 

4 Shartu Red 12 

1000 

FIgure 2.29: Output of Advanced Filtering 
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Figure 2.30: Searching In a Database 
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Studeifl database 

' Database5 
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- Database2l 

>  Select the Open option from the File 

tab. 

)  Select the database from the Recent 

list (if present) or click on the 

Browse folder and select the 

desired darabase from the Open dialog 

box. click on the Open button. The 

selected database will be opened. 
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Figure 2.31: Opening an Existing Database 

SEARCHING IN A DATABASE 
There are times when you require a particular data in your datasheet. It becomes very difficult when you are not sure 

about its exact location. The Search box located at the bottom of the Access window makes it easy to search. 

> Enter a part or whole word, phrase, date, 

or number in the Search box and press 

Enter. 

>  Access highlights the corresponding 

characters that matches your search as 

shown in Figure 2.30. 

>  To find the next matching record, press 

the Enter key again. Access finds all 

records that match that your search 

criteria anywhere in your datasheet. 

CLOSING ACCESS APPLICATION 

> Afterfinishing the work in Access, click on the Close option in the File tab to close the current database. 

>  To close Microsoft Access application, click on the Close button present at the extreme right of the Access 

window. 

I

It is advisable to mention a short filename that relates to the information that you store in your database. 

OPENING AN EXISTING DATABASE 



Datasheet 

AutoNumber 

Long Text 

J  Forms 
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RECAP 
A database is a collection of information stored in an organised way. 

Database is categorised as: Flatfile database and Relational database. 

DBMS stands for Database Management System. It is an application software, which is used to create, modify, 

and extract data from a database. It manages and organises the records in the form of tables. 

> Microsoft Access is the most popularand powerful RDBMS used to organise and manipulate data. 

> Templates are pre-built database that focus on a specific task. They can be used instantly and also be 

downloaded. 

) You can work on a table in two views: Design view and Datasheet view. 

) Afield's data type determines what type of data you can enter into a field. 

> Afield property applies to a particularfield in a table and defines the characteristics ofthatfield. 

> A Primary key is a sort of a check on the table that every record in the table is unique. 

> You can sort data within a table with respect to a particularfield, either in an ascendingora descendingorder. 

BRAIN  
[OPER 

SECTION - A 

A. III in the blanks. 

1. is a collection of information stored in an organised way. 

2. A computerised record keeping system that enables you to store, modify, and extract information from a 

databaseisknownas  

3. MicrosoftAccessisa database. 

4. refers to the arrangement of data in an ascending or descending order. 

5. A key is a sort of check on the table that uniquely identifies each record in a table. 

6. data type is used fordescriptive fields. 

7. The generates a sequential number, whenever a new record is added to a table. 

8. viewdisplaysthetableasagrid. 

9. are the user friendly interfaces that facilitate the process of entering data in tables. 

10.  collects the summarised data from one or more tables/queries and organise it in a 

printable form. 

HINTS 
Sorting 

Primary 

Database Relational 

DBMS Report 



B. State True or False. 

1. The rows in a table are called records. 

2. Currency data type is used to store monetary data. 

3. An Access template helps in creating a complete database application, which is ready to use. 

4. DBMS standsfor Data Binding Management Software. 

5. Atable can have only one primary key. 

6. It is not essential to specify data type fora field name. 

7. OLE data type stores a link to a web page. 

8. Toggle Filter button is located in the Sort and Filter group. 

C. Application-based questions. 

  

  

  

  

  

  

  

  

  

  

  

  

  

1. Supriya is given an assignment to add a new table in the existing database. Which option should she use to 

complete the task? 

2. Rohan wants to write the description for the fields of the table, which he is about to create. In which view he 

should work? 

3. Upasna is creating a table to store Students' details. Which property should she use for the fields to ensure that 

they are not left blank during data entry? 

4. Shivali has to answer some questions based on the following table structure. Help her in answering 

them: 

Emp name Date_ofjoining Project_name Emp_id Salary Designation 

Rajesh 18/11/2015 Payrol I_system AOO1 20000 Project 
associate 

Mansi 10/06/2012 MIS A002 45000 Project lead 

Shruti 30/07/2014 Employee_management A003 
Project 

35000 manager 

(i)  Identify the data type for the following fields: 

Emp_id Date_ofjoining  Salary  

(ii)  List the employees as per their salaries, displaying the highest paid person at the top and the lowest paid person 

atthe bottom.  

(iii)  Set the maximum number of characters to be entered in the field Project_name.  

(iv)  Which field can become the Primary key?  

Learning 
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SECTION  -  B 

A. Multiple-choice questions. 

1. The standard file name extension for database in Access 2016 is  

a. .accdb b. .abbcd c. .addbc 

2. There are mainly types of database. 

a. Four b.Two c.Three 

3.  is an application software that is used to create, modify, and extract data from a 

database. 

a. DBMS b.DBBS c.DDMS 

4. Which data type has the largest storage capacity? 

a. ShortText b.LongText c.Text 

5. What is the maximum number of characters that can be used to define a field name? 

a.62 b.64 c.46 

6. Which icon indicates the edit mode in Access? 

a. Clip b. Pen c. Pencil 

7. The area that displays the list of new or existing database ob jects like Tables, Forms is called  

a. Work area b. Navigation Pane c. Ribbon 

B. Answer the following questions. 

1. What is a Database? Give examples. 

2. Differentiate between Flat File Database and Relational Database. 

3. Define Tables. List the different elements of a Table. 

4. What are Data Types? List the various data types available in Access 2016. 



Create a table having the following fields using Blank database and name it as Bank Account. 

Field Name 

Customer_ID 

Account_N umber 

Account_Type 

Date_Opened 

Balance 

Description 

The unique identifierfora customer 

The unique identifierfor a customer 

The type of account (Current, Savings, etc.) 

The date on which the account was opened 

The current balance (money) of the account 

The table structure is given below: 

IolyKy 1 
- 

Popty Indes Cede Dat. Rcnn.e/ Ro4nhp Objt 
Te,t VJdt,on ot MEW 

Vw Toof Showt,1,d ftd. RQ,d & Tob vflt I.ton$hp 

Ffe!d Name DalaType Descrpon (Optional) 

! Customer_Id Number The unique dentifier for a customer 
Account Number Number The unique Identifier for a bank account 

Account_Type Short Test The type of account(Current. Savingsetc.) 
Oute_Opened DatefTirne The dale on which account was opened 

Balance Number The current balance (moo of the account. 

4) . t)itab.nc?O  -  D.,:ab.s O'U,rWeDa_ 

What do you understand by Sorting? How can you sort data in Access? 

6. What is the utility of Filter in a Datasheet? 

7. Write short notes on the following: 

a) Validation Text 

b) Caption Property  

LAB SESSION Perfection Through Practice 
4 . . 

;
; 

  

   



PROJECT WORK Using Creativity 

Create a database of your Teachers by defining the fields: ID, First Name, Last Name, Date of Birth, 

Department, Email, Address, City and ZIP/Postal Code. Enter 1 5 records in it. 

ONLINE LINKS Looking For More 

To know more about Microsoft Access 2016, visit the site: 

> http:J/www.gcfIearntree.orgaccess201  ö 
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) Define a Primary keyforthe Accounts table. 

> Set the Default value 1000forthefie1d Balance. 

) Set the Field Size to 15 forthe Account Type Field. 

) Enter10recordsineachfield. 

> nsert 1 more field Customer_Name after Customer_ID and enter data in it. 

> ortthetableintheascendingorderofCustomer_Name. 

> Filterthe records and display only those where Balance> 15000. 

) Search for the record of a particular Customer_ID. 

)' Deletethelasttworecordsfromthetable. 

> Save the table and close MS Access application. 

GROUP DISCUSSION For Concept Clarity 

   

   

Conduct a group discussion on the topic: 

Flat File Database  vs Relational Database 

) Data Types 



WORKING WITH QUERIES, 
FORMS, AND REPORTS 

LEARNING IN THIS CHAPTER 

e Query 
r Setting a relationship between tables 
r Creating a query  

r  Specifying simple and multiple criteria 
r  Creating a query in Query Wizard 
r  Forms  

Formatting a form 

* Reports 
* Exporting a report 

The database of any organisation may contain a huge amount of data. Moreover, it may consist of multiple tables. 

When the number of records in a table increases, it becomes an uphill task for any user to extract specific records 

from that table. Microsoft Access provides us a solution for this problem through queries. A Query is a database 

object that allows you to to retrieve information from one or more database tables that meet a specific condition or 

criteria specified by you. The information retrieved on the basis of a specified criteria in the query is stored in a 

separate table, called the Query table. 

QUERY 

A query is a simple question that you ask to find a specific information from the database. Similarly in Access, when 

you build a query, you are defining specific search conditions. You can use queries to view, change, summarise, and 

analyse the specific data in different ways. 

In our daily life, you make several types of queries to get specific information. For example, which students are 

scoring above 85% marks? Which students live in Sector - 4, Chandigarh? And so on... You can make quick decisions 

depending on that criteria. Let us understand the concept of queries with the help of the given example. 

In the Students table, you have records of Class VIII as well as Class IX students. Suppose, you want to 

extract the records of student(s) of Class VIII and Class IX who reside in Panchkula and Chandigarh, you 

—' can find this with the help of Queries. 
Example 

Queries are made on tables and the results are displayed in 

the form of a table, i.e., in a group of rows and columns with 

Students 

Roll_No 

C 101 

x 

F_Name 

Nisha 

class 
8 

Address - 
#81, Sector 3 

city 
Panchkula 

the set of records that match the given condition. C 
102 Vivek 8 #89. Sector 2 Panthkula 

0 103 Narnan 8 #67, Sector 21 Panthkula 

Microsoft Access provides various types of queries: Select, 27 Gitika 9 #9. Sector 23 chandigarh 

Parameter, Crosstab, Action, and Structured Query 
2 208 Preet 9 #89. Sector 21 Chandigarh 

Language (SQL) query. 
J Record 

Dtshet View 

NoIer Seacch 

loCk 

4 

> SEllING A RELATIONSHIP BETWEEN TABLES 
Relationships are links that associate a field in one table with the same field in another table. In Access, you can store 

data in multiple tables. To bring that information together, you need to define relationships between the tables. 

Once you have defined the relationship between the tables, data from both the tables can be used by Query, Form, 

or Report. 

A relationship works by matching a field with the same name in both the tables. In most cases, these matching fields 

are a Primary key from one table that uniquely identifies each record in a table, and a Foreign key in the other table. 
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Figure 3.1:  Students Table 
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Figure 3.4:  Show Table Dialog Box 
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Figure 3,5: Edit Relationships 

Window 

Let's Know More 

A Select query retrieves 

data from one or more 

tables and displays the 

record set in a datasheet. 

You can also use a Select 

query to group the data, 

and calculate the sum, 

count the average, and 

other types of total. 

Let's Know More 

A Parameter query is a 

type of Select query that 

prompts you for input 

before it runs. The query 

then uses your input as 

criteria that controls the 

results. For example, you 

can design it to prompt for 

two dates. Access will then 

retrieve all data with 

values between the two 

specified dates. 

(A foreign key is a value in one table that must match with the Primary key of another 

table.) 

To create a relationship, make two tables one with the name Students that holds 

information about students, such as their Roll No, F_Name, Class, Address, and City. And 

the other with the name Marks that holds the information about the students' Roll_No, 

Percntage and Grade. Open one of them in the Datasheet View. 

x Marks 

RolçNo . F_Name . Class Address CItY Roll_No Percentage Grade 
101 Nisha S e81, Sector 3 Panchkula Observe there is 101 89 A 

Vvek 

Naman 

Gitka 

8 

S 

9 

e89,5ec5or2 

e57,Sector2l 

F9,secto,-23 

Panthkula 

Panchkuia 

Chandgarh 

one common field, 
i.e., Roll_No in both 

the tables. 
—J 

102 

103 

207 

90 

95 

87 

4+ 

A 
Preet 9 89, Sector 21 Chandigazt, 208 60 B 

Figure 3.2: Students Table Figure 3.3: Marks Table 

> Click on the Database Tools tab. Select the Relationships button from the 

Rlationships group. 

I TIe Show Table dialog box appears, select the required table and click on the Add 

button. The selected table will appear in the object Relationships window. Likewise, 

add anothertable to the Relationships window. 

Y?u can activate the 'Queries' tab if your 

relationships are based on queries, or activate 

'Bpth' tab if relationships are based on both-

Tbles and Queries. 

Click on the Close button to close the Show Table 

dialog box. 

Drag the Primary key of the parent table (e.g., Students 

Table) and drop it over the same field in the child table 

(e.g., Marks Table). In our example, Roll_No is the 

primary key. 

> The Edit Relationships dialog box appears. 

> Click on the Create button. Access creates the 

relationship between the tables. 

A me linking the two tables will appear 

indicating that both have been linked on 

the basis of the linked field. 

Click on the Save button on the Quick 

Access Toolbar to save the relationship 

and then close the Relationships window 

by clicking on the Close button on the 

Relationships group. 

X Ci
i Tb

9 / Dt P.. ..*wps 
R,4.bend.p P..po.t çM R..Rwrd.p 
"S

'.5 

Relationships 

a 
F.".-. 
cress 
£431,S 

Figure 3,6: Tables Added to the 

Relationships Window 

Let's Know  More 

An Action query creates a 

new table or alters your 

data or database by 

adding, deleting, updating, 

and appending data to it. 

5'. Window 
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After the relationship has been created between two tables, you must delete the relationship before you make 

modifications to the fields on which relationship is based. To delete a relationship, click on the line that connects 

the tables and press the Delete key. 

CREATING A QUERY 
Access provides two ways to create a Query: 

Query Wizard .. Query Design 

CREATING A QUERY IN DESIGN VIEW 

The Design View gives you more control over a query. It allows you to create a 

query from the scratch. 

Open the database and click on the Create tab on the Ribbon. Now, click on 

the Query Design button in the Queries group. 

> The Show Table dialog box is displayed from which you can select the 

record source for your query that can be one or more Tables or Queries or a 

combination of the two. Figure 3.7:  Selecting a Table 

> Select the table from the Show Table dialog box on which you would like to run a query. Click on the Add button 

and then click on the Close button. 

> The selected table appears as a small window displaying a list of fields in the upper section of the Query window, 

i.e., the Object Relationship Pane. 

> Double-click on the field names you want to add in the query. They will be added to the Design Grid (the bottom 

section of the Query window). You can also add fields to the query by dragging them from the field list to the 

Design Grid. The Design grid is similarto a spreadsheet, 

with columns representing each field in the query. 

Let us understand the Design Grid. 

Field : The first row of the Design Grid displays the selected 

field names from the table. 

Table: Beneath each field name is the name of the existing 

table. 

Show : The Show row displays a check mark. The fields 

with check marks display the information when the query 

is run. To hide the field during run time, deselect the check 

mark by clicking on it. 

Sort : This property is used to filter the data either in an 

ascending or descending order. It is optional. 

Criteria: It contains the condition on the basis of which the 

records will be filtered in the Query output. 

Or: This property is used to set multiple criteria in a query. 

Learning 
Computers with  IPS 

Figure 3.8: Adding Table in Query Window 
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Let's Know More 

A cross-tab query uses 

row headings and column 

headings so that you can 

see your data in terms of 

two categories at once. 

Let's Know More 

To reopen the 'Show Table' 

dialog box, while creating 

relationship, click on the 

Show Table button [ij  on 

the Design tab in the 

Relationships group. 

Know the Fact 

All the tables you select to 

include in your query will 

appear as small windows 

in the Object Relationship 

pane. Each window 

contains a list of the 

available fields within 

those tables. 

Know the Fact 

To add all the fields 

present in a field list to the 

design grid, double-click 

on the top bar of the 

table's field list and drag it 

to the design grid. 

Quick Quiz 

To Zoom-in the current 

field in the Datasheet 

View, press Shift+F2, 

r  

SPECIFYING SIMPLE CRITERIA 

You specify criteria in the Criteria row of the design grid. Specify the criteria value in the 

Criteria row and the data will be filtered accordingly in the query output. 

Let us understand it with the help of the given example: 

> To view the roll numbers and names of students of class VIII, double-click on the 

required fields in the table. 

Figure 3.9:  Specifying Simple Criteria 

The query name will appear in the Navigation Pane (Make sure you have selected the 

All Access Objects option from the drop-down menu in the Navigation Pane). 

Double-click on the query name to 

view the query output. Microsoft Access x 

> The query result will be displayed in Do you want to save changes to the design of query Queryl? 

the Datasheet View, which looks
Yes No Cancel 

like a table. 

4  To view the query output without saving, click on the Run button in the Results 

group on the Design tab. 

SPECIFYING MULTIPLE CRITERIA 

To see information when either two or more alternate criteria are satisfied, you can make 

use of or criteria row in the design grid of the query. 

Suppose from a wide range of record you want to see the records of Class 8 and Class 

9 only. 

Move the cursor to the Criteria row 

and type the criteria =8 in the Class 

field column. 

- Click on the Sort property in the 

F Name column and set it in the 

Ascending order. 

> Click on the Close button of the 

query window to save the query. A 

dialog box will appear asking you to 

save changes to the design of 

Queryl. Click on the Yes button to 

save the changes. The Save As 

dialog box will appear. Specify the 

Query name and click OK. 
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FIgure 3.10: Specifying Multiple Criteria 

in the Datasheet View. 

If you want to save your query, 

click on the Save command in the 

Quick Access toolbar. When 

prompted to name it, type the 

desired name, and then click OK. 

Students Queey 

Roll_No F Name • Class 

101 Nisha 8 

102 Vivek 8 

103 Naman 8 

207 Gitika 9 

208 Preet 9 

Move the cursor to the Criteria row and type the condition =8 in 

Class field. Type the 

second condition =9 

in the or row of the 

same column. 

Now, run the query 

by clicking on the Run button on the Design tab. 

The query result will be displayed 

Figure 3.11: Query Output 

CREATING A QUERY IN QUERY WIZARD 

To create a query in Query Wizard: 

> ClickontheCreatetab. 

> Select the query Wizard button in the Queries group. 

The New Query dialog box appears. The Simple Query Wizard 

option is selected by default. Click OK. 

Figure 3.13: New Query Dialog Box 

> The Simple Query Wizard screen appears as shown in 

Figure 314. Select the table that contains the data in the 

Tables/Queries list box. 

) Now, add the fieldsthat you wantto have in the query result. 

Simple Quesy 55(izard 

'esNds fields do you newstC yi 

You ces choose frizss sse than one table er query. 

L 
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Figure 3.14: Simple Query Wizard Dialog box 
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Figure 3.12: Selecting Query Wizard 
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Figure 3.16: Displaying Different Options for Creating a Form 
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TOADDA FIELD 

> Select the required field(s) in the Available Fields box. 

> Click on the single forward arrow buttonL or just double-click on the field. 

) You will notice that the selected field is shifted to the Selected Fields box. 

> lncase you want to add all the fields, then click on the double forward arrow button >> . It will shift all the fields 

at once. 

> You can remove the selected fields from the Selected fields box. To remove them one by one, click on the single 

backward arrow button "orto remove all at once, click on the double backward arrow button 

> Once you have selected the required fields, then click 

on the Next button. 

> The Simple Query Wizard screen 2 of 3 appears, 

prmpting you to either select the Details or 

Simple Query Wizard 

Wtaat btte do y, want for yo quecy? — 

> 

Summary Query. Simply, click on the Next button. 

In the next step, Simple Query Wizard screen 3 of 3 
That's al the fornabon the w,zard needs to eate ys 

appears. Enter a newlitle foryour query. 
Do y want to opt, the quay or mocify the .,ery's deg 

> OLserve that the Open the query to view information 

racliio button is selected by default. 

® ç,en the y to ew flfâcmabcn. 

> Now,clickontheFinishbutton. 

Th query result will appear in the Datasheet View. 

You will observe that the query name is visible in the 
Cane <adc 

Na'igation pane. Figure 3.15: Adding Title for Query 

In general, a form is a piece of paper, on which a user fills the required information in the specific fields. Likewise, in 

Microsoft Access 2016, Forms work quite similar to it. Forms allow you to add and update data in one record at a time in 

a table. Although Access provides a Datasheet View, which is a convenient way of entering data, but it is not an 

appropriate tool for every data entry situation. Sometimes, when you work with different users and do not want to 

expose to the inner working of Access database, you may choose to use Access forms to create a better userfriendly 

interface. 

Any form you create from a table will let you view the 

data that is already in that table and you can also add 

new data. A form can have a different name from a 

table, yet it manipulates the same information and data 

to the corresponding table. If you change a record in a 

form, it will be reflected in a table also. Data can be 

inserted, updated, and deleted from a table by using a 

Form object. 

You can work on a form in the followingthree views: 

Form View is used to enter, edit and view data. 



. ,_ •— 
,._. _,. '-. - . . c_. 

Students Query 

ou p 

0 

Design View is used to adjust the design of your form. It gives you a more detailed view of the structure of a form, 

such as Header, Detail, and Footer sections. 

): Layout View is used to change the appearance and size of various controls of a form. 

CREATING A FORM 

To create a form, select a table or query in the Navigation Pane that you wantto use as the data source forthe form. 

) Click on the Create tab on the Ribbon. Select the Form option in the Forms group. 

> A new form is created and opens in the Layout view, in which you can 

change the appearance of a form. You will notice that three new tabs: 

Design, Arrange and Format appear on the Ribbon. 

> If you want to edit or enter data in the form, click on the Home tab > View J1 

button>FormView. I 

> Use the Record Navigation barto move through the records in the form. 

> After finishing the data entry, save your work by clicking on the Save option 

in Quick Access Toolbar or the Save option in the File tab. You will observe 

that the Form object gets added in the Navigation Pane. 

FORMATFING A FORM 

You can change the appearance of the form by using various options available on the Design and the Format tab. 

USING DESIGN TAB 

l' J 

Figure 3.17: Formatting a Form 
Using Design Tab 

> Click on Logo in the Header/Footer group. The Insert-Picture dialog box 

appears. Select any picture and click OK. 

> Click on Title in the Header/Footer group. Type 'Students Query' as the 

title for the form. 

> Click on Date and time in the Header/Footer group. The Date and Time 

dialog box will appear. Choose the desired format of the Date and Time 

and click OK. You will find Date and Time placeholders in the Header 

section of the form. You can move these placeholders to the Footer 

section also if you want to display Date and Time there. 

IL.. 1flhIIiL 

Figure 3.18:  Formatted Form 

> Click on Themes in the Themes group. Click on the desired theme from the drop-down menu. 

USING FORMAT TAB 

> Click on the Background Image in the Background group. The Browse button appears. Click on it. Locate and 

choose the picture in the Insert Picture dialog box and then click on the Open button. 

> Select the field to which you want to apply conditional formatting, say 'Class'. Click on the Conditional 

Formatting option in the Control Formatting group. Click on New Rule in the Conditional Formatting Rules 

Manager dialog box. Under Select a rule type, select Check values in the current record or use an expression. 

Under Edit the rule description, select the rule, apply desired formatting, and click OK. 
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) If needed, modify the page size, margin width, and page 

orientation using the related commands on the Ribbon. 
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A report is an effective way to organise and summarise 

datafor viewing or printing. A report can be created 

exactly in the same way as you have created a form. The 

only change is that after selecting the Create tab, click on 

Report in the Reports group. Access creates a report and 

places all fields of the selected table in the report. 

Four new tabs appear on the Ribbon as soon as Report is 

created: 

Desin, Arrange, Format, and Page Setup. 

Cick on the Save option on the Quick AccessToolbarto save the report. 

The Report object gets added in the Navigation Pane. 

Following are the four different types of views in which a report can be displayed: 

Report View: You can viev data of the report in this view but cannot make any modification in the design. 

Print Preview: This view allows you to see how the report will look like when printed. 

Layout View: It provides a view that closely resembles what 

the report will actually look like to the user. In this view, you 

can also edit the design of the report to some extent such as 

change the size of various controls. 

Design View : This view displays only the structure of the 

report that can be modified and customised as per the 

requirement. This view does not display the underlying data, 

but displays the expressions that are used to generate the 

content. For example, you may find Date Qfunction on the 

Header section of the report but not the actual date. 

FORMATTING A REPORT 

Like Forms, you can format a report using different options 

prese1ton the Design and Format tabs. 

Students 

S 089, Sector 2 :Panchkula 

S 1467. Sector 21 jPanchkula 

9 09, Sector 23 hanadi 

9 1189, Sector 21 Chanart, 

Roll No F,,,Name 

01: Nisha 

'RE 

02 \frvek 

07 Gitika 

Wednesday, December 07, 2016 

4'3247 PM 

Class Address City 

8 1481, Sector 3 Panchkula 

Figure 3.20: Formatted Report 

PRINTING A REPORT 

To print a report, select the File tab and then click either on 

the Print option or select the Print Preview View option. 

This view displays how the report will appear on a page. It 

also allows you to choose the Page orientation, Page setup, 

etc. 

F(gure 3.21:  Print Preview of a Report 



Excel Text PDF 
File orXPS 

Data 

Email More close Print 
Preview 

Word 
Export the selected object to Rich 
Text 

Figure 3.22:  Selecting Word Application 
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) Click on the Print option. The Print dialog box will appear. Set the desired print option and then click OK. 

E EXPORTING A REPORi 

Click on the drop-down arrow of the View button on the 

Home tab and select Print Preview from the drop-down 

list of options. 

The report will be opened in the Print Preview layout and 

the ribbon will display the commands related to the Print 

Preview layout. 

    

On the Data group, click on the drop-down arrow of the More 

button and select Word. 
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) The Export-RTF File dialog box will appear on the screen. Select 

the location where you want to save the report and give a valid 

name to the report. You will also find some export options. select 

the options as per your requirement. 

> Click OK. 

>  A final screen will appear on the screen notifying you about the 

successful completion of the exporting process. 
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Figure 3.23:  Export-RTF File Dialog Box Click on the Close button. 

Locate the word file where the report has been exported and open it. 

RECAP 
> A Query is a database object that helps you to retrieve and view information from one or more database tables 

that meet a specific condition or criteria that is specified by you. 

)' Microsoft Access provides various types of queries: Select, Parameter, Crosstab, Action, and SQL query. 

> Relationships are links that associate a field in one table with the same field in anothertable. 

) Access provides two ways to create a query -through the Query Wizard and Query Design. 

> The Criteria property contains the condition on the basis of which the records will befiltered in the Query output. 

> A Form is a piece of paperon which a userfills the required information in the specific fields. 

> Report is an effective wayto organise and summarise the data forviewing or printing. 
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BRAIN 

  

  

  

  

SECTION  - A 

  

A. Fill in the blanks. 

1. A  is a database object that helps you to retrieve and view information from one or 

more database tables. 

2. In a query, the property is used to set the condition on the basis of which the records are 

filtered. 

3. You can set multiple criteria in a query using property. 

4. property is used to filter the data either in an ascending or descending order. 

5. allows you to add and update data in a table, one record at a time. 

6. A is an effective way to organise and summarise data in a printed form. 

HINTS Or Criteria Sort Form Query Report 

B. State True or False. 

1. ueries help us to retrieve information from one or more tables that meet a specific condition. 

2. Areport is created exactly in the same way as Forms are created. 

3. To specify the multiple criteria, the Or property is used. 

4. You cannot run a query without saving it. 

5. The Sort property is used to filter the data either in an ascending or descending order. 

6. A relationship works by matching a field with the same name in two tables. 

7. Oncearelationshipisset,itcannotbedeleted. 

8. The Form View is used to change the structure of yourform. 

C. Application-based questions. 

1. Swati created a database of her classmates and entered 30 records in it. Her teacher asked her to show the data 

of those students who have scored less than 50% marks. Suggest how she can apply this criteria. 

2. Johnson & Johnson company has a huge database of employees. The company wants to maintain the privacy 

of each employee and has given the instructions to computer operators to update each record, one at a time. 

Which database object should it use to perform this task? 



Learning 
Computers with  KIPS 

SECTION - B 

A. Multiple-choice questions. 

1 Which query allows addition, deletion, updation, and appending operations on data? 

a. Select query b. Action query c. Cross query 

2. Which query prompts you for input before it runs? 

a. Cross tab query b. Parameterquery c. Select query 

3. Which option is used to change the appearance and size of various controls of a form? 

a. Design View b. Form View 

4. How many views does Access provide to display a form? 

a.Two b.Three 

5. Which key defines a relationship between two tables? 

a. Primary key b. Candidate key 

B. Answerthefollowingquestions. 

1. What is a query? Name the parts of a query window. 

c. Layout View 

c. Four 

c. Secondary key 

2. What do you understand by Criteria? 

3. Differentiate between a Form and Report. 

4. What is a Form? How is it useful? 

5. How can you export a Report to a Word file? 



> Create a database on the Information System using the 

Design View. 1 RecID AutoNumber N/A 

) Use the fields, as given in the screenshot, in your 2 Name Short Text 50 

database. 3 Address Short Text 100 

1 4 City Short Text 50 
> Save the table with name InfoSys. 

5 State Short Text 50 

> The InfoSys table icon will appear in the Database 6 PIN Number Long Integer 

window. 7 Mobile Number Long Integer 

) Double-click on it to open and enter data of your relatives, 8 Date_of_Birth DatelTime N/A 

9 Anniversary Date/Time N/A 
friends, teachers, and the principal. 

10 Email_ID Short Text 50 
) Enter minimum 20 records in the table and save it. 

) urther add 10 more records into the table using Form. 

) tfiake a query to display the records where 'Date of Birth' falls in the month of November. 

> imilarIy, make a query to display the records with 'Anniversary' date falling in the month of December. 

)' Create a query to display the records in the descending order according to 'Date_of_Birth'. 

) Make a query to retrieve the records having'City' as Panchkula. 

) Runthequeriesandsavethem. 

> Generate a report forthe above data and export it to the Word file. 

GROUP DISCUSSION For Concept Clarity 

Conduct a group discussion on thefollowing topics: 

Creating Query Using Query Wizard vs Creating Query Using Query Design 

Looking For More 

To know more about Forms and Reports, visit the following websites: 

> https//www.quackt.com/microsoftaccess/rnicrosortaccess_2O16/tutoriaI/create_a_query  

micro soft_access. cfm 

)' https//www.lynda.com/Access-tutorials/Access-201  6-Forms-Reports-Depth/455727-2.html 
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' 
Perfection Through Practice 

  

LAB SESSION 

  



icons, and draggable shadows. 

Learning 
Computers with  KIPS 

ADOBE PHOTOSHOP CC 

LEARNING IN THIS CHAPTER 

r Introduction and features of Adobe Photoshop CC 

r Starting Adobe Photoshop CC 

r Components of Photoshop CC 

. Creating a new file 

r Inserting images 

Saving and closing a file 

Opening a file 

• Selection tools 

• Cropping tool 

• Common painting tools 

Students! You might have noticed that photographs in marriage albums, magazines, or catalogues 

of any cosmetic company are much different from the common pictures you click daily. A normal 

looking person looks ravishing, dull skin turns bright, wrinkles disappear from the face of old 

people, and eventually a person looks better in the pictures than they look in the real life. 

Can you imagine how it all happens? Well, this alteration is made possible with the Photoshop 

software. Adobe Photoshop, popularly known as Photoshop, is a graphics editing program 

developed by Adobe Systems. Photoshop is widely-used by millions of graphic artists, web 

developers, photographers, as well as people who use it as a hobby. Most of the posters, 

magazine covers, book covers, brochures, etc., are created or edited with Photoshop. Due to the 

popularity of this software, it has been accepted as an industry standard for graphics 

professionals. 

FEATURES OF PHOTOSHOP CC 
) It has a revised user-friendly interface. 

) Photo editing can be done more efficiently with very little efforts. 

> It has redesigned powerful tools to: 

> enhance or change the colour of an image by adjusting the brightness and contrast, colour balance, hue and 

saturation levels, curves, etc. 

> crop or resize pictures without losing the quality of an image. Photoshop CC provides various options along 

with the Crop tool to make it work even better. 

> remove the unwanted object from the picture using the Vanishing Point Tool. 

) click and drag across an image to make fast selections with the new Quick Selection Tool. 

) You can create graphics for web applications with reduced file size, thereby, helping in faster loading of the 

website. Files can be compressed by 10 to 50% of its original size. You can also make animated graphics, which is 

also known as Graphics Interchange Format (C IF). 

)	 Layer Effects preserve the original state of an image while manipulating another version of it through another 

layer. You can add as many layers as you need. 

> 3D effects incorporate completely new and improved extents to an object by introducing new 3D reflections, 



The credit for the 
invention of Adobe 

Photoshop goes to 
Thomas Knoll, who 
invented the first 

version of Photoshop in 
1987, which was known 

as Display Program. 

)  Pn improved Print Window simplifies printing options and eliminates the need for 

separate Print and Print with Preview commands. 

) The new Auto Align and Blend features helps save time. 

The Tool Recording using Actions in Photoshop CC enables us to add brush strokes 

and different helpful tools. 

) The new addition of the Video Timeline Panel enables you to add effects to the video 

clips in Photoshop. 

The Blur Gallery allows you to apply and combine three different kinds of blur and 

create effects. 

Content Aware Patch allows you to heal undesirable portions of an image. 

Content Aware Move enables you to select pixels and drag it to some other part of 

an image without using layers or masks. The magical part is that it fills the hole with 

matching elements from the existing background and shifts the pixels to a new 

location. 

A new Adaptive Wide Angle Filter enables you to straighten the curves and lines in 

photographs and quickly achieve effects on the images where there is a less space. 

With the new Powerful Vector Tools, designers can now design and shape graphic 

elements more quickly and easily. 

TARTING ADOBE PHOTOSHOP CC 
To start Photoshop, follow the sequence of steps given below: 

'.4 Li  Adobe Photoshop CC 
Start 

Figure 4.1:  Starting Adobe Photoshop CC 

COMPONENTS OF PHOTOSHOP CC 

Figure 4.2: Components of Photoshop CC 

Know the Fact 

Adobe Photoshop (1.0) 
was launched in 1990. 
Different versions of 

Photoshop have evolved 
till now from Photoshop 

(2.0) to Adobe Photoshop 
(19.1.16). The latest 
version, Photoshop 

(18.0.1) is popularly known 
as Adobe Photoshop cc. it 

was released in August, 
2018. 

Know the Fact 

The default extension of 
Adobe Photoshop file is 

.psd. 
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MENU BAR 

It is the top-most horizontal bar in Photoshop window that contains all the main menus of Photoshop, such as File, 

Edit, Image, Layer, Type, Select, Filter, 3D View, Window, and Help. 

OPTIONS BAR CONTROL PANEL 

The Options Bar Control Panel lies below the Menu bar. It displays the options related to the currently selected tool 

in the Tools panel. 

DOCUMENT WINDOW 

It is the area that displays the image file that you want to edit. The name of the image file appears as a tab at the top 

of the Document window. 

PANELS 

On the right side of the Photoshop window, there is a separate area for panels. Photoshop offers various panels that 

can either be grouped, stacked, or docked. By using various options from these panels, you can monitor and modify 

the properties of an image. Panels can be placed anywhere on the screen. To float them: 

> clickonthetopofthepanel. 

> drag the panel while keeping the left mouse button pressed. 

The most commonly used panels are as follows: 

Color panel 

The Color panel displays the colour values for the current foreground and background colours. You can use the 

sliders in the Color panel to change the foreground and background colours using different color modes. You can 

also select a foreground or background colourfrom the spectrum of colours, displayed at the bottom of the panel. It 

has Swatches tab to the right of it. 

Swatches panel 

The Swatches panel stores the most frequently used colours. You can easily add or delete customised colours from 

the Swatches panel. 

Adjustments panel 

The Adjustments panel helps you to apply an effect to a group of layers in a much easier way. Later on, you can edit 

that effect while preserving the original layers. The Adjustments panel has a Styles tab to its right. 

Styles panel 

The Styles panel allows you to view, select, and apply preset layer styles. By default, a preset style replaces the 

current layer style. You can also add your own style using the Create New Style icon. 

History panel 

You can access your document's history in the History panel and undo the changes easily. 

Layers panel 

The Layers panel in Photoshop displays all the layers in an image. It also shows the various effects applied to the 

,

layers. 
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Let's Know More 

In Photoshop CC, you can 

customise your Tools Panel 
as per your need by using 

the Edit Toolbar tool in the 

Tools Panel. 

• Rictangulue Marquee Ted P4 

Elpbcal Marquee Ted P4 

• QuKk Solecb, Tool W 

Wand Ted W 

9 Eyedropper TOol 

• I Eyedropper Ted 

Color Sanplar Tool 
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Elrpbcal Marquee Ted P4 

single Row Marquee Tool 
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C., Zoom Tool Z 

Set BacSyroed Color 

If the Tools panel is not 
visible on the screen, 

choose Window from the 
Menu bar and select the 

Tools option. 

Figure 4.4:  New Document Dialog Box 

Tools panel 

The Tools panel is to the left side of the Photoshop window. It works like an artist's paint box and holds a variety of 

tools that help us to draw, paint, and manipulate the images. 

Figure 4.3:  Tools Panel 

EATING A NEW FILE 

Open Photoshop and create a new image file by selecting the File> 

New option. 

This will open the New Document dialog box. This dialog box allows 

you to: 

> create documents using the selected templates from Adobe 

Stock across several categories that include Photo, Print, Art & 

Illustration, Web, Mobile, Film & Video within the dialog box. 

> find more templates by using the Search for more templates on Adobe Stock search box. 

> quickly access files, templates, and items that you have recently accessed from the Recent tab. 
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Figure 4.5: Background Layer 

Ctri.N 

Open.. Ctrl.O 

n Bndge... Alt. Ctd.O 

Open As... Alt.Slsltt.Ctrl.O 

Open as Smart 0bjct. 

Open Recent 

Close Ctrl.W 

Close All Att-Ct,l.W 

Close and Go to Bridge... Shift.Ctrt.W 

Sac Ctd-S 

Save As... Sinft.Ct,1*S 

Revert P12 

M0-ãa. S.d,dMaat. 

Shore on Behonce... 

Figure 4.7: Place Dialog Box 4 T i 

> save your own custom presetsfor reuse in the Saved tab. 

Create a blank document usingthe Blank Document Presets. 

Click on the Photo category and select any preset. Change its settings as per your need in the Preset Details pane 

on the right. 

Specify the details like Name of the image file in the Name text box, set up the size (Width & Height) of an image 

file in different units of measurements, such as Pixels, Inches, Centimetres, or Points, Specify the value for 

resolution to determine the sharpness and clarity of an image in the 

Resolution text box. Mention the colour mode such as RGB, CMYK, 

or Grayscale in the Color Mode text box and provide the background 

colour of an image by defining either of the three options: White, 

Black or Background Color in the Background Contents section. 

Click on the Create button. 

A new blank Photoshop canvas will be created with a locked 

Background layer in the Layers panel. 

SFRT!NV!M 

To insert any image, follow the given steps: 

Open a new file in Photoshop CC. 

Click on the File menu and choose either the Place Embedded or 

Place Linked option. Here, you have selected Place Embedded 

option. 

In the opened Place Embedded window, browse and select the 

image file that you want to insert. Click on the Place button. 

The image will appear ma grid. 
Seach A&be &cS 

Click on the image and 

drag it to the point where 

you want to place it Figure 4.6: Selecting Place Embedded Option 

within the canvas. 

it to rotate the image in clockwise or anti-clockwise direction. 

When you are satisfied with the placement, size 

and rotation of the image, double-click on the 

image. 

You will find that a new layer appears in the Layers 

panel where the image is placed. If the Layers / 

panel is not visible, then select Window> Layers.  Figure 4.8: Selected Image 

Learning 
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You can resize the image by dragging one of its corner nodes. To rotate 

the image, hover near the 

corner node till the rotate 

cursor appears and then drag 

Figure 4.9: Displaying a New Layer 



OPENINGAFftE 

> Click on the File menu and select the Open 

option. The Open dialog box appears. Now, 

browse and select the desired file and click on 

the Open button. 

> The selected file will be opened. 

SAVING A FILE 

> To Save the document, use the File> Save option. 

>. TheSaveAsdialogboxappears. 

> Choose the location and specify a name in the File name text box. Click on the Save 

option. 

LOSINGA FILE 

> Click on the File menu and select the Close option. The file will be closed. 

Let's Know More 

Reveal The 

Hidden Tools 

Some of the tools have a 

small white triangleat 

the bottom right corner 

indicating that more 

tools of the same kind 

are available in a pop-up 

menu. click on it to view 

these hidden tools. 

- ..-.,.._..., p 
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Know the Fact 

A selected area is indicated 
on the screen by a blinking 

selection border, called 
Marquee. 

SELECTION TOOLS
Figure 4.10: Open Dialog Box 

Selection tools are used to select an image or a part of it to perform cut, copy, edit, or 

retouching operations. Following are the various selection tools in Photoshop: 

RECTANGULAR MARQUEE TOOL 

It is used to select an image or a part of it in a rectangular, square, elliptical shape, or as a 

row/column that is one pixel wide. 

> Click on the Rectangular Marquee Tool in the Tools panel. The cursor appears as 

a crosshairsign®. 

> Place the cursor on the image. Click and 

hold the left mouse button and then 

drag out a marquee to select the 

required part of the picture. 

Figure 4.12: Selecting the Object 

Know the Fact 

A dock is a collection of 
panels displayed together, 

generally in a vertical 
orientation. You can dock 

or undock panels by 
moving them into or out of 

a dock. 

Know the Fact 

To collapse or expand all 
panel icons in a column, 

click on the double arrow 
at the top of the dock. 

Let's Know More 

To collapse an expanded 
panel back to its icon, click 
on its tab, its icon, or the 

double arrow in the 
panel's title bar. 

• [I] Recbnguar Marquee Tool P'l 

) EthpbcI Marquee Tool M 

Single Row Marquee Tool 

Single Column Marquee Tool 

Figure 4.11: Rectangular Marquee Tool 

> You will notice that a dashed border 

has covered the selected object, as 

shown in Figure4.12. 

> Now, right click on the image layer 

and select the rasterize layer. 

> Press the Delete key. Notice that 

the selected part of the image is 

deleted. 
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Figure 4.14: Using the Lasso Tool 

Selection with 
Polygonal Lasso Tool 

Figure 4.16: Using the Magnetic Lasso Tool 

Do not save the edited image as it will spoil the original one. 

LASSO TOOL 

The Lasso Tool is a bunch of three very useful tools used for freehand 

selections: (1) Lasso Tool (2) Polygonal Lasso Tool (3) Magnetic Lasso Tool. 

Follow these steps to select a part of the image using the Lasso Tools: 

. p LassoTool I 

- 
Polygonal Lasso ol I 

Magneth Lasso Tc1 L 

 

Figure 4.13:  Lasso Tool 

> Open any image. Click on the tiny black triangle on the Lasso Tool icon or right-click on the icon. The three 

types of the Lasso Tool will appear. 

Using Lasso Tool: 

> SelecttheLassoTool 

> Choose one of the Selection options from the Options bar. 

> Click and drag the mouse around the part of the image to be selected 

and markthe selection. 

> Release the mouse at the end point. You will notice the selection as 

shown in Figure 4.14. 

Using Polygonal Lasso Tool: 

It helps to make freehand selections, but its contour is made up of straight segments. 

> Select the Polygonal Lasso Tool. 

> Specify the options using the Options bar. 

> Click on the image at any point near the object to be outlined. 

> Click at the position where you want the first straight segment to 

end. 

> Keep clicking to set the next end points of the subsequent segments 

until the whole object is outlined. Close the contour by clicking at the 

starting point. 
Figure 4.15:  Using the Polygonal Lasso Tool 

Using Magnetic Lasso Tool: 

When you use this tool, the border snaps to the edges of the defined areas in the image. The Magnetic Lasso Tool is 

especially useful for quickly selecting objects with complex edges set 

against high-contrast backgrounds. 

)' Select the Magnetic Lasso Tool . Click on any part of the image to 

be selected and drag the mouse pointer around the object to select 

it. You will find this tool dropping the 'Fastening Points' along the 

edges. 

> Continue this process till you reach the starting point or double-click 

at the ending point. Observe the selection as shown in 

Figure 4.16. 



Figure 4.17: Quick Selection Tool 

Figure 4.19:  Using the Magic Wand Tool 

If the Quick Selection Tool does not appear in the Tools panel, right-click on the 

Magic WandTool andselecttheQuickSelectionTooI. 

Figure 4.18:  Using the Quick 
Selection Tool 

In Photoshop cc, you 
cannot undo more than 
one action using Undo 
command in the Edit 
menu. To do so, press 

ctrl+Alt+z key 
combination. 1 

QUICK SELECTION TOOL 

This tool is used for quick selection. As you drag the 

moue, the selection expands outwards. It finds and 

follws the defined edges in the image 

autonatically. 

The Quick Selection Tool is useful for selecting the 

parts of an image, which requires great precision to 

reach. 

>- ClickontheQuickSelectionTool •. 

> Dragthemousetomakethedesiredselection. 

Magic Wand Tool 

ltisusedtoselecttheadjacentareasof the same 

colour in an image. 

> Click on the Magic Wand Tool or press W. 

The pointer changes into ? symbol. 

)' Click on any part of the image. All the adjacent 

areas of pixels having the same colour will 

be selected, as shown in Figure 4.19. On selecting 

the Magic Wand Tool, the Options bar displays 

the following options: 

Let's Know More 

To add a floating panel 
or panel group to an icon 
dock, drag it in by its tab 
or title bar. (Panels are 
automatically collapsed 
to icons when added to 

an icon dock) 

Quick View 

When using either Lasso  or 
Polygonal Lasso tools, you 
can toggle between the 

two by pressing the Alt key. 

Let's Know More 

The Magic Wand Tool 
can make and merge 
selections if you press 

the Shift key. 
• % r s. S- sn4 .5 f c,,o,,, SM.ct S.ab$rt 5.4(1 

Figure 4.20:  Magic Wand Options Bar 

Tolerance (0-255) determines the colour range of the selected pixels. The higher 

the tolerance, widerwill be the range of the selected pixels. 

> Anti-alias produces a smooth edge by partiallyfillingthe edged pixels. 

>  Contiguous limits the selection to adjacent pixels only. While unchecking this 

option, all the pixels in the image within the same tolerance range will be 

selected. 

9OETOOL 

This tol is used to drag a selected part of an image to a new location in the image. 

> Oen any image and select the partto be moved (using Marquee/Lasso Tool). 
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Figure 4.24:  Crop Tool 

Figure 4.25: Cropping Area 

> Select the Move Tool A from the Tools panel or press V. The pointer changes to sign t1.. 
> While holding the left mouse button, drag the selected image to the point where you want to place it and 

release the mouse button. 

> Notice the change, as shown in figures given below. 

> To copy a selected part of an image within the same image, press Alt key while draggingthe selection. 

> To copy a selected part of an image to another image, use the Edit> Copy and Edit> Paste options. 

Figure 4.21: Selecting an Image 

CROPPING TOOL 

Figure 4.22: Moving the Image Figure 4.23: Copying the Image 

 

It is used to select a specified area that you want to focus on and removes the 

unwanted parts or everything outside the selected area of a picture. 

> Open an image. Select the Crop Tooj from the Tools panel or press C. 

The pointer changes to the cropping symbol While holding the left mouse 

button, drag it across the picture to make a rectangular selection. 

Release the mouse button when the selection is complete. 

The selected part of an image within your selection is known as cropping 

area. 

> The area outside the cropped area 

appears dark. This is called shield. 

> To finish the cropping process, 

double-click inside the selection or 

press the Enter key. 

> You will find that the selected image is cropped. 

Photoshop CC provides a variety of Crop options in the Options bar. 

These are Perspective Crop Tool, Slice Tool, and Slice SelectTool. 

Figure 4.26: Cropped Image 
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Let's Know More 

The Slice Tool is 

used to divide an image 

into multiple rectangular 

sections called Slices. 

These Slices can be 

easily moved, resized, 

aligned and optimized 

individually as separate 

files. After you create a 

Slice, you can select it by 

using the Slice Select 

Tool. 

Figure 4.28: Selecting the Image 
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Figure 4.30:  Gradient Editor Dialog Box 

) Now, select the Linear Gradient 

from the Options bar. 

> Click and drag the mouse pointer in 

the selected area. Notice that the 

selected gradient gets applied on 

the selected area. 

) Press Ctrl+D to deselect the selection. 

COMMON PAINTING TOOLS IN PHOTOSHOP 
Adobe Photoshop is basically an image editing and 

retouching software, but you can also create artworks 

by using different Painting Tools, like Gradient, Paint 

Bucket, 3D Material Drop tools, etc. Figure 4.27:  Painting Tools 

Let's Know More 

cropping is the process 
of removing portions of 
a photo to create focus 

or strengthen the 
composition. 

GRADIENT TOOL 

The Gradient Tool allows you to fill an area with a 

range of colours in a specified pattern, It creates a 

blend of two or more colours. The gradients of 

colour can be filled with linear, radial, angle, 

reflected and diamond gradient. 

> Open an image. With the help of the Magic 

Wand Tool , select the area with Tolerance 

setting of 90. 

Figure 4.29:  Options bar 

> Select the Gradient Tool from the Tools 

panel. 

> Click on the drop-down arrow of the 

Gradient picker and select the desired 

gradient from the displayed options. You 

can also edit the gradient. To do so, click on 

the Gradient picker from the Options bar. 

The Gradient Editor dialog box will appear. 

> Select the Chrome gradient option and 

click on the OK button. 

Figure 4.31:  Gradient Applied on the Image 

Quick View 

You can press the Esc key 
or click the Cancel 

button in the Options 
bar to cancel the 

cropping of an image. 

Let's Know More 

You can easily change 
the brush tip size of the 
Quick Selection Tool by 

clicking on the Brush 
Picker drop-down menu 
in the Options bar, and 
type in a pixel size or 

drag the slider. You can 
also press the right 

bracket (]) to increase 
and press the left 

bracket ([) to decrease 
the brush tip size. 
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Paint Bucket Tool 

It is used to fill an image or a part of it with different colours based on the tolerance 

ora range of colours. 

Open an image. With the help of the Magic Wand Tool, select the image area 

with Tolerance setting of 90. 

Select the Paint Bucket Tool from the Tools panel and set the Tolerance to 100 

to paint the whole selection. 

Click on the Set foreground color option. The Color Picker (Foreground Color) 

dialog box will appear. Select any colour of your choice, for example, pink and 

click OK. 
Figure 4.32:  Selecting the Image 

> Now, click on the selected area of the image. The colour of the selected area will change to pink. 

Figure 4.33: Selecting the Foreground Color 
Applying Paint 

Bucket Color 

RECAI 

   

   

   

> Adobe Photoshop, popularly known as Photoshop, is a graphics editing program developed by Adobe Systems. 

) Layer effects preserve the original state of an image while manipulating another version of it through another 

layer. 

) Photoshop offers various panels that can be either grouped, stacked, or docked. These include Colors panel, 

Swatches panel, Styles panel, Tools panel, Layers panel, Adjustment panel, and History panel. 

The Selection tools are used to select an image or a part of it to perform cut, copy, edit, or retouching operations. 

The Magnetic Lasso Tool is especially useful for quickly selecting objects with complex edges set against high-

contrast backgrounds. 

) The Crop Tool is used to select a specified area that you want to focus and remove the unwanted parts outside the 

selected area of a picture. 

> The Move Tool is used to drag a selected part of an image to a new location in the image. 

> The GradientTooI is used to fill an area with a range of colours in a specified pattern. 

64 
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SECTION -A 

A. i11 in the blanks. 

1. rhe panel stores the most frequently used colours. 

2. allows you to heal undesirable portions ofan image. 

3. The works like an artist's paint box, which holds all the drawing tools used to draw, 

paint, and manipulate the images. 

4. The tool is used to select a specified area that you want to focus on and removes 

the unwanted parts. 

5. Some of the tools have a small at the bottom right corner. 

6. rhe tool creates a blend of two or more colours. 

I!1T1  Tools panel White triangle Content aware patch Swatches Gradient Crop 

B. State True or False. 

1. Lasso Tool is a bunch of three very usefultools that are used forfreehand selections. 

2. The Menu bar is present on the bottom of the Photoshop window. 

3. Marquee is a blinking selection border. 

4. There are three types of Selection tools in Photoshop. 

5. The move tool is use to dragthe selected part of an image to a new location in the image. 

C. Application-based questions. 

1. Poonam is a wildlife photographer. In one of her photographs, she wants to focus only on one lion in the 

pride and remove the rest. Which tool can she use? 

2. idhya has inserted an image of penguins in her file. She wants to select an irregular area of the image. Suggest 

the tool that will serve her purpose. 
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SECTION- B 

A. Multiple-choice questions. 

1. Which is the latest version of Adobe Photoshop? 

a.CS5 b.CS6 c.CC 

2. Who invented Photoshop? 

a. Thomas Knoll b. Thomas Edison c. Thomas Cook 

3. Which bar shows different options of the currently selected tool? 

a.Toolbar b.Optionsbar c.Menubar 

4. WhatisthedefaultextensionofanAdobe Photoshopfile? 

a. .psd b. .phd c. .psh 

5. Which tool is used to select the adjacent areas of the same colour in an image? 

a.Magicwand b.Lasso c.Crop 

6. Which key combination is used to deselect the selected area? 

a. Ctrl+Q b.Ctrl+D c.Ctrl+Z 

B. Answerthefollowingquestions. 

1. What is Adobe Photoshop? Describe anytwo features of Adobe Photoshop. 

2. Name the three options used with the Magic Wand Tool. 

3. What do you understand by Cropping? 

4. Differentiate between the Rectangular Marquee and Lasso Tool. 



GROUP DISCUSSION For Concept Clarity 

Discuss the various types of Selection Tools. 

ONLINE LINK 

To know more about Photoshop, visit the website: 

http://www.photoshop.com/tutorials  
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Looking For More 

Perfection Through Practice 

Create an image depicting the view of a forest in Photoshop CC. 

> pen Adobe Photoshop CC and create a new file by selecting the 

File> New option. 

> elect the Gradient Tool from the Tools panel. Select the 

Foreground to Background gradient from the Gradient picker 

i theOptionsbar. 

ow, click on the selected Gradient. The Gradient Editor dialog 

ox will appear. Click on the Color Stop slider. The Color option 

ill be enabled. 

> ow, click on the Color box next to the Color option. The Color Picker(Stop Color) dialog box will appear. 

> lect the sky blue color and click on OK. Click on the Linear Gradient option Em the Options bar. 

> slick and dragthe mouse pointer in the vertical direction to create the sky background for your image. 

S-arch the Forest and Animal clipart images on the web and store them on your computer. 

pen the Forest clipart image in your file by clicking on the File > Open option. Select the Forest image and 

oose Edit> Copy. Now Paste it on the sky background image by selecting the Edit> Paste option. 

> spen the Animal clipart image by selecting the File> Open option. Now use the Magnetic Lasso Tool to extract 

the image of the animal only. 

> Press Ctrl+Enter to fix the selection nodes on the animal. Now copy and paste it on the sky background image. 

> Use the Move Tool to place the animals at the desired position. Likewise repeat the steps 12 to 14 to paste 

other animals. 

) The image depicting the Forest View is ready. Now save it by using the File> Save option. 

C 
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LL::  Selecting the Grass Area in the Image 

MORE ON PHOTOSHOP CC 

LEARNING IN THIS CHAPTER j  

. Painting tools Drawing and Type tools 

• Retouching tools Navigation tools 

• Using Image menu • Layers 

Adobe Photoshop is basically used for retouching and editing the photographs to make them look attractive 

and appealing. Adobe Photoshop provides various Painting tools to retouch and edit an image, which are as 

follows: 

PAINTING TOOLS 
1 Brush Tool 

4 History Brush Tool 

4 Gradient Tool 

Figure 5.1: Painting Tools 

BRUSH TOOL 

The Brush Tool is a basic tool that is used to create smooth strokes of the foreground 

colour in an image. You can set various options in the Options bar, which include: 

Brush Preset picker: This option provides you with a large number of predesigned Figure 5.2: Brush Tool 

brush presets that you can use. You can also change the diameter of the brush by moving the size slider. 

Mode: It allows you to select and set the painting mode from the drop-down list. 

Opacity: This option allows you to set the level of transparency of the brush strokes. 

Flow:Theflowoption determines how quicklythe Brush tool applies the paint. 

Followthese steps to use the Brush Tool: 

Open an image. Right click on the Quick 

Selection Tool and choose the 

Magic Wand Tool with tolerance 

settings of 32 and select the area 

where you want to apply the Brush 

Tool (as the grass area is selected in 

Figure 5.3). 

Select the Brush Tool from the 

Tools panel or press B on the keyboard. 

Select the desired brush style from the 

Brush Preset picker, say, Grass in the 

Lagacy Brushes option. 

Learning 
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Figure 5.' Brush Preset 
Picker 

Know the Fact 

A brush can be upto 5000 

pixels wide. 

Quick View 

Press the Caps Lock key 

if you want to see the 

brush size. 

Li' I.'w rn.. 7$ Øy...y...t.. 

Figure 5.5: Brush Strokes made with Green Color 

Foreground Colour is used to 

paint, fill, and also used for stroke 

selections. Background Colour is 

used to make Gradient fills and fill 

colour in the erased areas of the 

image. By default, the 

foreground colour is black and 

the background colour is white. 

Pencil Tool 
jst - L rp M.' LO .' 
f 4 - (Vs.. Ia-. - 
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Click on the Set foreground color box in the Tools panel. 

The Color Picker (Foreground Color) dialog box will 

appear. Select the desired colour. Here, dark green colour 

has been chosen. 

Similarly, select light green background co!ourfrom the Set 

bckground color box. Click OK. 

Drag the pointer on the image while holding down the left 

mouse button so as to apply brush strokes. 

Notice the grass strokes being made on the selected 

portion of the image. 

Press Ctrl+D to deselect the selection. 
Let's Know More 

Adobe Photoshop is 

available in 29 languages. 

Know the Fact 

Selections can be saved for 

future use. To save the 

selections, click on the 

Select menu > Save 

Selections. In 'Save 

Selections' dialog box, 

specify any name to your 

selection. 

Quick View 

To increase and decrease 

the brush size, press] and 

keys respectively from the 

keyboard. -. 

Let's Know More 

The History Brush Tool 

paints a copy of the 

state or snapshot 

selected in the History 

panel into the current 

image window, whereas 

the Art History Brush 
Tool paints with 

styled strokes using the 

selected state or 

snapshot. 

The Prnci!  Tool is used to draw freehand 

drawiigs with hard edges. 

Right-click on the Brush Tool and 

choose the Pencil Tool from the 

TobIs panel. 

Seect the required options for the tool 

fr4m the Options bar. 

Clik on the Set foreground color box in 

thTools panel. 

Th Color Picker (Foreground Color) Figure 5.6:  Using the Pencil Tool 

dilog box will appear. Select the desired colour. Click OK. 

> Drg the pointer to draw a desired shape as shown in Figure 5.6. 

Color Replacement Tool 

This tol replaces the existing colour of an image with the foreground colour. 

Right-click on the Brush Tool and select the Color Replacement Tool from the 

flyout menu that appears. 
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NOTE 

Tolerance  determines how closely the colours should be matched for sampling. The default value is 30%. Specifying a 

higher value selects the wide range of colours, whereas specifying a lower value selects the colours that are closer to 

the pixel. 
Limits allow you to specify whether only the colour of the adjacent pixels containing the sample colour should be 

replaced or the colour of the non-adjacent areas should be replaced as well. 

Figure 5.8: Use of Mixer Brush Tool 

) The pointer shape changes to the target symbol . Choose an appropriate colour, say blue, from the 

Set foreground color box in the Tools panel. 

) Now, drag the mouse pointer over the area of the image whose colour is to be replaced, such as the 

big red mushroom in Figure 5.7. As you dragthe cursor, Photoshop continuously samples the colourthat is under 

the cross hair in the centre of the mouse pointer and this colour will be replaced with the current foreground 

colour. 

You can also select the replacement colour from the image itself. To do so: 

> hold down the Alt key and the left mouse button to select any appropriate colourfrom the image. You will notice 

that the colour changes in the Foreground color box in the Tools panel. 

> you can also specify various settings to control the behaviour of the Color Replacement Tool in the Options bar. 

Set the appropriate values forTolerance and Limits in the Options bar. 

Figure 5.7: Use of Color Replacement Tool with Blue Foreground Color Selected 

Mixer Brush Tool 

This tool allows you to paint in a more realistic way by mixing colours on the 

canvas, combining colours on a brush and varying paint wetness accross a 

stroke. 

) Right-click on the Brush Tool and select the Mixer Brush Tool from the 

Tools panel. 

> Press the Alt key from the keyboard and click on a point in the image from 

where you want to load the paint for the brush. Here, you have loaded the 

brush with the blue colour of the background. Alternatively, you can select a 

foreground colourfrom the Set Foreground color box in the Tools panel. 
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Healing Brush Tool also works in a similar manner. The only difference 

between 'Spot Healing Brush Tool' and 'Healing Brush Tool' is that in the 

latter you have to define a source point and then paint over an imperfection. 

Press Alt key and click on the image to define a source point. 

You will observe that the Current brush load Swatch in the Options bar reflects the colour orthe pattern that you 

have chosen from the canvas. 

Drag the mouse pointer on the image to paint with a mixture of Current brush load and the existing colour of the 

image as shown in Figure 5.8. 

The outcome of the Mixer Brush Tool depends on the values of Wet, Load, Mix, and Flow options in the Options bar. 

RETOUCHING TOOLS 

Spot Healing Brush Tool 

Clone Stamp Tool 

4 Eraser Tool 
e 4 BlurTool 

4 Dodge Tool 

 

       

Retouching Tools 

These tools help usto change the appearance of the selected areas of the image. 

SPOT HEALING BRUSH TOOL 

This tool helps us to repair imperfections like blemishes, dark spots, scratches, or 

other unwanted elements from an image. 

Open an image. Select the Spot Healing Brush Tool. 

Choose the brush size from the Options bar. 

Figure 5.10: Spot Healing 
Brush Tool 

> Click and drag overthe spots to get it repaired. 

Patch Tool 

'I 

After 

 

Before 

 

   

Figure 5.11: Effect of Spot Healing 
Brush Tool 

Usin Patch Tool, you can select the unwanted elements from an image and 

replace them with the matching content from the surroundings. This tool is quite 

similar to the Healing Brush tool except that with the Patch tool, you can define 

that sIection where you want to apply the effects. To use this tool: 

> Riht-click on the Spot Healing Brush Tool and select the Patch Tool from 

tte Tools panel. 

In the Options bar, click on the drop-down list adjacent to the Patch option 

and choose the Content-Aware patch mode from the displayed list. Figure 5.12: Use of Patch Tool 
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Figure 5.14:  Clone Stamp Tool 

Figure 5.15: Use of Clone Stamp Tool 

> Drag a line with the Patch Tool around the part of the image to be replaced. 

> Now, drag the selection over the area from which you want to generate the fill. 

Content Aware Move Tool 

This tool is used to select and move or extend any part of an image to another area within the same image without 

the use of layers and masks. As you move, the area left behind is filled using matching elements from the existing 

background. 

Right-click on the Spot Healing Brush Tool and select the Content-Aware Move Tool from the Tools panel. 

> Drag the mouse pointer to 

select the area that is to be 

moved. 

Now, click and drag the 

selected area to a different 

location. Here, you have 

selected the cub. 

> You will observe that the hole 

that is left behind gets filled 

with the matching elements 

from the surroundings. 

CLONE STAMP TOOL
Figure 5.13:  Use of Content Aware Move Tool 

This tool allows you to duplicate the part(s) of an image by taking the sample 

pixels from an image and cloning them onto another area. Cloning works better 

than copying as it retains soft edges on details and gives more realistic 

duplicate image. 

- Open an image and select the Clone Stamp Tool 

Set the brush type, change its size or hardness, select the blend mode of your choice, set the opacity for stroke, 

and other options for the tool in the Options bar. 

To define a sampling source, hold down the Alt key. The cursor shape changes to the target symbol®. Click on 

the area of the flower image to be cloned. 

Click and drag along the area where the 

cloned image is to be placed. 

; While you drag, a plus sign + appears on the 

original flower image while a 

corresponding circle appears on the 

cloned image. 

Save the image and close it. 
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Smud'eT' 

 

Figure 5.16:  Blur Tool 

Figure 5.17:  Use of Blur Tool 

A 
The Sharpen Tool and Smudge Tool are used in the same manner as the Blur tool. 

DAWING AND TYPE TOOLS 

Pen Tool aT. 4 Type Tool 

Path Selection Tool .4 Shape/Line Tools 

Let's Know More 

The Path Selection Tools 

are used to make shape or 

segment selections 

showing anchor points, 

direction lines, and 

direction points. 

The Pattern Stamp Tool allows youtofill an area with a selected pattern. It works 

quite similar to the Clone Stamp Tool U but the only difference is that after defining 

rhe appropriate options in the Options bar and selecting the pattern from the Pattern 

icker, you do not have to select the source point in the image. Place the pointer inside 

he area to be painted with a pattern and drag the mouse. 

Let's Know More 

Path and Shape tools are 

also termed as Drawing 

tools because they help in 

making complex shapes 

and drawings. 

BLUR TOOL 

The Blur Tool is a great way to change the focus of the 

selected portion of the image. This tool softens the selected 

area of an image by giving it a blurred effect. 

1>  Open any image in Photoshop. 

Click on the Blur Tool and select the desired Brush 

size and style from the Brush Preset picker. Specify 

the Effect Mode and set the strength for stroke from 

the Options bar. 

- Drag the mouse pointer over the area that you want 

to blur. 

Sharpen Tool 

The Sharpen tool is the contrast of the Blur tool. This 

tool lets you improve the clarity of your image by 

sharpening the outlines of an image more prominently. 

Let's Know More 

The Eraser Tool is 

used to erase pixels and 

changes them to either 

the background colour 

or transparent. 

73 
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The Smudge tool as the name implies, allows you to smudge the image around as if 

you have dragged your finger through the wet paint. This tool picks up the colour from 

where the stroke begins and spreads it in the direction you drag your mouse. 

Figure 5.18: Use of Smudge Tool 

Let's Know More 

The Dodge tool is 

used to lighten the areas 

of an image, whereas the 

Burn tool is used to 

darken the area of an 

image. 

Figure 5.19:  Drawing and Type Tools 
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Figure 5.20: Type Tool 

F:aure 521 Creating Warping Text 

El Rectangle Tool U 

Rounded Rectengle Tool U 

EllipseTool U 

) PolygonTool Li 

/ Lint Tool U 

• Custom ape Tool U 

Figure 5.22 Using 
the Custom Shape Tool 

TYPE TOOL 

The Type Tool is used to add text in an image. This tool provides plenty of settings to 

control the text properties. 

> ClickontheTypeTool 

) Select the option like Font, Size, Color, Bold, Underline, or Italics from the Options bar. 

> Click on the image where you want to add text. 

) Type the desired text. 

) Click the checkmark button on the Options barto end text editing. 

Warping Text 

Warping is used to position the letters or text in different shapes. To use the Warp option, follow these steps: 

> Select the Type Toolfrom the Tools panel and enterthe text. 

> Select the text and click on the Create warped text option 

from the Options bar. 

> The Warp Text dialog box will appear as shown in Figure 5.21. 

> Click on the drop-down arrow of the Style option and select 

the Fish style. 

> Select the orientation of warp style—Horizontal or Vertical. If 

needed, specify values for additional options as given in the 

Warp Text dialog box. 

>. ClickontheOKbuttontoapplytheWarpstyle. 

> With the help of the Move Tool, place the text where you 

want to position it. Save your file for future use. 

SHAPE/LINE TOOLS 

Adobe Photoshop provides various types of Shape tools for drawing both filled as 

well as unfilled shapes, including rectangles, ellipses, polygons, and custom shapes. 

> Openanewfile. 

> Right-click on the Rectangle Tool and select the Custom Shape Tool•. 

) Click on the drop-down arrow of the Shape menu in the Options bar. 

> Select the required shape. For example, Flower 5. 

> To access more shapes, you can click on the Gear icon on the right side of the Shape panel. 

U. . 0 Mçn Edg.t 

Figure 5.23: Options Bar 

0. 



I The procedure for making different shapes is the 
same as making the Custom shape. 

. M,9 Eàg.s 

0- 

./0G• 

 

Select the desired colour from the Fill option in 

the Options bar tof ill colour in the shapes. 

Drag the mouse to draw the selected shape and 

after adjusting the size release the mouse button. 4 .4 .4   
-' Figure 5.25:  Different Flower 

Prints in Different Colours 

NAVIGATION TOOLS 

Figiire 5.24: Shape Dialog Box 

' HandTool H 

Rthte V Toz R 

Figure 5.27:  Hand Tool 
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Know the Fact 

Adobe Photoshop 

provides a spelling 

checker facility. Go to Edit 

> Check Spelling to check 

the spelling mistakes. 

Besides Photoshop, 

Adobe company has also 

developed and published 

Abobe Photoshop 

Elements, Adobe 

Premiere Elements, and 

Photoshop Lightroom. 

collectively these are 

branded as "The Adobe 

Photoshop Family". 
Hand Tool 4 Zoom Tool 

Let's Know More 

Figure 5.26:  NavIgation Tools 

There are two types of Navigation tools: Zoom Tool and Hand Tool. The Zoom tool is 

shaped like an old-fashioned magnifying glass and the Hand tool is shaped like a hand. 

ZOOM TOOL:	 This tool lets you zoom in by clicking the Zoom tool on the image to 

view its magnified size or zoom out by pressing the Alt key on a keyboard 

while clicking the image. Observe the symbol within the magnifying 

glass, the cursor will change from a plus sign to minus sign. 

HAND TOOL:	 When you zoom in, the image is usually 

too large to see it all at once. Hold down the 

left mouse button and move the Hand tool 

to move the image within the window. 

            

            

            

4: > Use Ctrl +,to Zoom In and Ctrl-, to Zoom Out. 

While an image is zoomed in, you can move the image by dragging the mouse 

while holding down the Spacebar key. The current icon will change to Hand Tool 

till the Spacebar key remains pressed. 

   

            

   

ING IMAGE MENU 

      

            

IMAG ADJUSTMENT OPTIONS 

Image Adjustment options are just like setting the colour settings of your television. 

Photoshop allows you to set the colour levels, contrast, brightness, and many more 

Let's Know More I 
The Red Eye Tool 

removes the red 

reflection caused by a 

flash while clicking a 

photograph. 

Let's Know More 

The Rotate View Tool is 

used to rotate the 

canvas, non-destructively. 

Know the Fact 

The Sponge ToolDis 
used to desaturate or 

saturate a part of an 

image. To desaturate 

means to reduce the 

intensity or richness of a 

colour, whereas saturate 

means to add more 

vibrant colours or 

brighten a picture. 



lm.rj.• Layer rype Seted Filter 3D View Window Help 

Mode 

Brightness/Contrast... 

Levels... 

Curves... 

Exposure... 

 

Auto Tone Shift.Ctrl.L 

Auto Contrast Alt.Shift.Ctrt-L 

Auto Color Shift.Ctrl-B 

Ctrt.L 

Ctrt'..M 

  

Vibrance... 

  

Image Size... 

Canvas Size,,. 

Image Rotation 

C rep 

Trim... 

Alt. Ctrl'.l 

Alt.Ctrl.0
Color Balance.,. 

Black & White,.. 

Photo Filter... 

Channel Mixer... 

Color Lookup... 

  

  

Ctrl+B 

Alt. Shift. Ctrl. B 

Duphcate... 

Apply Image... 

Calculations... 

:arable-. 
Apply Data Set... 

Invert 

Posterize... 

Threshold... 

Gradient Map... 

Selecti'.'e Color... 

Ctrl.'l 

Shadows/Highlights... 

1-IOR Toning... 
Analysis 

Desatu rate 

Match Color.., 

Replace Color.,. 

Equslize... 

Shift.Ctrl. 1) 

Figure 5.2: Different Setting Options 

Figure 5.30: Hue/Saturation 
Dialog Box 

Figure 5.31:  Image after Changing 
the Hue/Saturation 

Figure 5.32:  Creating and 
Deleting a Layer 

settings of the image. Figure 5.28 shows the different settings 

options. 

ADJUSTING HUE/SATURATION 

This powerful tool is used to adjust the hue (colours in the 

image) and the saturation (the intensity of the colours), and 

also gives you control over the lightness. Follow the given 

steps to apply this tool on an image: 

Open an image in Photoshop CC. 

Select the image or a part of it by using the Rectangular 

Marquee Tool. Click on the Image > Adjustments> Hue / 

Saturation or press Ctrl+U. 

The Hue/Saturation dialog box will appear. Adjust the Hue 

settings to -28, Saturation to +55 and Lightness to +16. 

You will notice the change in the colour of the selected 

image. 

P LAYERS 

Layers are the transparent sheets that can hold objects and are stacked on top of each other. When you have a 

number of objects, it is always better to distribute the objects in different layers as it makes the work process much 

easier. You can draw and edit objects on one layer without affecting the objects 

on another layer. You can add a number of layers, hide and lock layers, change 

the position of layers, delete layers, and even customise the layers as well. 

The Layers panel displays a small thumbnail view of all the layers in an image. 

ADDING A NEW LAYER 

A new layer is created when you paste an object in your image. 

To add a new layer, follow the given steps: 

Select the Layer> New> Layer option. 

The New Layer dialog box appears. 

Define name in the Name text box, and click OK. 
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BlendEQ Options... 

Bevel & Emboss... 
Stroke... 
Inner Shadow... 

Sath... 
Color Overlay... 
Gradient Overlay.. 
Pattern Overlay... 
Outer Glow... 
Drop Shadow... 

Figure 5.33: Selecting 
Layer Style Option 

Know the Fact 

The Ruler Toot 
is used to measure the 

distances and angles in 

an image. 

Quick View 

You can create a new layer 

by using the Shift+Ctrl+N 

key combination. 

p Let's Know More 

Photoshop provides 

multiple Pen Tools that 

let you draw smooth- 

edged paths. The 

standard Pen Tool 

draws with great 

precision whereas the 

Freeform Pen Tool 

helps you make free hand 

drawings. 

Fqre 5.34:  Layer Style Dialog Box 
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Know the Fact 

 

You can also add a new layer by clicking on the Create a new layer button at the 

- bottom of the Layers panel. 

  

I 

  

The Note ToolOis  used 

to make notes that can 

be attached to an image. 

               

               

REN MINGALAYER 

To rename a layer, double-click on the layer name in the Layers panel and type a new 

name. 

DELETING A LAYER 

> Selectthelayerthatyouwanttodelete. 

> Right-click on it and select the Delete Layer option from the Shortcut menu. 

LAYER EFFECT AND STYLES 

Photoshop provides a variety of effects, such as shadows, glow, bevel, emboss, and 

overlay. These effects change the appearance of the layer' contents. Layer effects are 

linked to the layer contents. When you move or edit the contents of the layer, the same 

effects are applied to the modified contents. For example, if you apply a drop shadow to 

a text layer and then add text, the shadow is added automatically to the new text. To 

apply the layer effects, follow the given steps: 

Select a layer in the Layers panel. 

) Click on the Add a layer style button at the bottom 

of the Layers panel. 

Choose an effect from the displayed list. 

> The Layer Style dialog box appears. Select the desired 

effect by clicking the corresponding check boxes on the 

left side of the dialog box. 

Likewise, select the appropriate options for the selected 

effect on the right side of the dialog box. 

) Click on OK to apply the effect. 

Observe that the applied effects 

will be reflecting below the layer 

name in the Layers panel. 

277) 
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) The Brush tool is a basic tool used to create smooth strokes of the foreground colour in an image. 

> Pencil tool is used to drawfreehand drawings with hard edges. 

) Mixer Brush tool allows you to paint in a more realistic way by mixing colours on the canvas, combining colours on 

a brush, and varying paint wetness across a stroke. 

) Spot Healing Brush Tool is used to repair imperfections like blemishes, dark spots, scratches, or other unwanted 

elements from an image. 

> Patch Tool is used to select the unwanted elements from an image and replace them with the matching content 

from the surroundings. 

> Content-Aware Move Tool is used to select and move, or extend any part of an image to another part of the 

same image and fill the area left behind using matching elements from the existing background. 

) Clone Stamp Tool allows the user to duplicate the part(s) of an image by taking the sample pixels from an image 

and cloningthem onto another area. 

) The BlurTool is a great wayto change the focus of the selected portion of the image by giving it a blurred effect. 

) Warping is used to position the letters or text in different shapes. 

> Layers are the transparent sheets that can hold objects and are stacked on top of each other. 

SECTION - A 

A. Fill in the blanks. 

1. Adobe Photoshop is basically used for  and  photographs to 

make them look attractive. 

2. Tool allows you to paint in a more realistic way by mixing colours on the canvas, 

combining colours on a brush, and varying paint wetness across a stroke. 

3. Press key if you want to see the brush size. 

4. By defaultforeground colour is and background colour is  

5. tool replaces the existing colour in an image with the foreground colour. 

6. The tool is used to select the unwanted elements from an image and replace them 

with the matching content from the surroundings. 

7. There are two types of Navigation tools: and tool. 
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c. Adjustments 
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Hand Editing Zoom Caps Lock Black 

ø Color Replacement Patch Mixer Brush Retouching 

- White HINTS 

  

B. State True or False. 

1 Warping text is used to position the letters ortext in different shapes. 

2. Text Tool is used to add text to the image. 

3. A brush can be upto 2500 pixels wide. 

4. The Content-Aware Move Tool moves any part of a picture to another area by shifting it to another layer. 

5. Zoom Tool lets you see a magnified view of a picture. 

6. ath Tool helps in making complex shapes and drawings. 

7. Spot Healing Brush Tool is used to repair imperfections. 

C. Application-based questions. 

1. Ali has designed a greeting card in Photoshop CC. He wants to change the colour of flowers from red to pink. 

uggest him the suitable tool to do so. 

2. Vikram has inserted an image in a new file. He wants to duplicate the part of an image on the same layer. 

Suggest him the right tool to do so. 

SECTION -B 

D. Multiple-choice questions. 

1. Which key is pressed on the keyboard to define the source point while using the Healing Brush Tool? 

a.Shift b.Alt c.Ctrl 

2. Which key helps us to move the image while the image is zoomed in? 

a. Ctrl Key b. Spacebar Key c. Shift Key 

3. Which tool is used to create smooth strokes of the foreground colour? 

a. Color Replacement b. Path Type c. Brush 

4. Which option is used to position the letters or text to different shapes? 

alColor Replacement b. Brush c. Create Warped Text 

5. Which tool is used to move the zoomed picture within the window? 

aHand tool b. Zoom tool c. Both 

6. Diring Image Adjustments, which option is used to change the intensity of the colours of an image? 

a. Colour Setting b. Color Replacement 
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E. Answer the following questions. 

1. What is the use of PaintingTools? Name any five Painting Tools. 

2. Differentiate between the Spot Healing Brush Tool and Healing Brush Tool. 

3. What is the use of the Hue/Saturation dialog box? 

4. What is the use of the Mixer Brush Tool? How can you apply itto an image? 

5. What do you understand bythe Warping of text? 

6. Explain the utility of the Content-Aware Move Tool. 

7. What do you understand by layers? 



LAB SESSION Perfection Through Practice 

) Click on the Type Tool and type the text 'No Water No Life' ata suitable place on the image. 

> Apply the Drop shadow effect to the text by clicking on the Add a layer style button at the bottom of the 

Layers panel. 

> Savethe file by giving it a suitable name. 

A reate a Poster on 'Water Conservation' by using various tools in Photoshop CC. 

) pen Adobe Photoshop CC and create a new file by selecting the File> New option. 

) earch the 'Sky' image on the Internet and store it in your computer. 

> Open the sky background image by selecting the File> Open option. 

Likewise, open a 'Drought scene' image. Select the required part of it by using the Marquee Tool. Copy the 

selected part and paste it on the sky background image. 

> If required, press Ctrl+T or select the Edit > Free 

Transform option to apply transformation on the 

selected area of the image. Drag the corner handle 

to reduce its size and place it at the desired 

position. 

Likewise, insert the images of the 'Earth' and a 

'Tap' as shown in the screenshot. 

> Right-click on the Rectangle Tool and select the 

Custom Shape Tool from the drop-down list. 

> Click on the drop-down arrow of the Shape option 

on the Options bar and select the Raindrop shape. 

Drag the pointer to draw the Droplet of water 

under the Tap. 

) Right-click on the Droplet layer and select the 

Rasterize Layer option from the drop-down list. 

)' FillitusingtheGradientTool. 

No Waler 
No Life 



B. Open and Edit an image depicting the Fun Time Scene in Photoshop CC. 

> Search a relevant image by typing 

'Playing kidst in the search box and 

open it in Photoshop. 

Using Polygonal Lasso Tool, select 

the boy holding the kite in the 

image. 

Choose Select > Inverse or Press 

Ctrl+Shift+lto invert the selection. 

) Select the Blur Tool from the Tools 

panel and drag the mouse pointer 

to apply the blurred effect to the 

selection. Press Ctrl + D to deselect 

the image of the boy. 

Select the Color Replacement Tool 

from the Tools panel. Choose blue 

as the foreground colour and drag 

the mouse pointer to replace the 

colour of the boy's trouser. 

> Use the Clone Stamp Tool to 

duplicate the clouds in the image. 

Clone these clouds to fill the empty 

area in the sky. 

Using Polygonal Lasso Tool, select the kite in the image. 

Now select the Image > Adjustments> Hue/Saturation option and adjust the Hue value to +14, Saturation 

to +17 and Lightness to -16 in the Hue/Saturation dialog box. Click on OK. Press Ctrl+D to deselect the 

selection. 

Right-click on the Spot Healing Brush Tool and select the Content-Aware Move Tool from the Tools panel. 

Drag the mouse pointer to select the girl on the extreme right of the image. Click and drag to place her on 

the left. 

> Now select the Smudge Tool from the Tools panel and drag the mouse pointer over the boundary line of the 

kite to give it a smudging effect. 

> Save the file by giving it a suitable name. 
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'A 
ONLINE LINK Looking For More 

Move Tool Lasso Tool Paint Bucket Tool Magnetic Lasso Tool 

Conduct a group discussion on the given topics: 

>  Spot Healing Brush Tool vs  Healing Brush Tool 

) Clone Stamp Tool vs Pattern Stamp Tool 

For Concept Clarity GROUP DISCUSSION 

C. Create a poster on 'Good Habits' in Photoshop CC. Apply the suitable effects that you have learnt in 

the  cha per. 

Onflne Link for More on Photoshop: 

http://www.guru99.com/photoshop-tutorials.html  
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WORKSHEET 

I r,I 

Ctrl + Alt + Z 

Alt + F4 

L 

To select the Move Tool 

Learninq c Computers with 

Chapters 1-5 

A. Fill in the blanks. 

1. When two users have simultaneous conversation via internet, it is called  

2. MicrosoftAccessisa database. 

3. is the process of removing portions of a photo to create focus or strengthen the composition. 

4. A  key is a sort of check, which uniquely identifies each record in a table. 

5. are used to display the selected data in a printable form. 

6. The tool is used to draw free hand drawings. 

HINTS Primary Cropping Relational Pencil Reports Conferencing 

B. State True or False. 

1. PAN is a kind of network that connects two or more computers located at far away places. 

2. The Dodge tool is used to lighten the areas of an image. 

3. Lasso tool is used selecting objects with complex edges. 

4. If more than one field is combined to form a primary key, then it is called a Composite key. 

5. The rows in a table are called Fields. 

6. A Query is a database object that allows you to to retrieve information from one or more database tables. 

C. Identify these tools and write their names in the given space. 

I1 

D. Match the following shortcut keys. 

To undo more than one action at a time 

To save the Database 

To select the Lasso Tool 

To quit Microsoft Access a 

V 

Ctri+S 
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Chapters 1-5 

A Choose the best answer. 

1. The are the certain sets of rules followed for data transferred over the network. 

2 Protocols b. Topologies c. None of these 

2. What do you call the selected area, indicated on the screen with blinking selection border? 

2 Clipboard b. Marquee c. Cropping 

3. A - is a type of query that prompts you for input before it runs. 

2 Action Query b. Parameter Query c. Crosstab Query 

4. A set of characters that represents a valid value is known as  

2 Records b. Fields c  Data 

5. Which among the following tool is used to lighten the areas of an image? 

2 Bum Tool b. Dodge Tool c. Blur Tool 

B Answer in one word. 

1. Name the topology in which each device is connected to a central computer. 

2. What do you call the computers that are connected to the server? 

3. What is the default extension of Adobe Photoshop file? 

4. Into how many types is a database is categorised? 

5. Write the full form of RDBMS. 

C. Answer the following questions. 

1. c tate the difference between Star topology and Tree topology. 

E xplain the importance of the Patch tool. 

3. How is a Query useful? 

4. What is a Database? Give examples. 

5. What do you understand by Layers? 
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LEARNING IN THIS CHAPTER  

a Features of Python 

• Installing Python on your computer 

• Working modes of Python 

• Variables  

r  Data types in Python 
r  type() Function 

r  input() Function 

' Operators in Python 

• Precedence of Operators 

• Comments in Python 

• Types of control structures 

' Conditional Statements 

Any task that you perform in your daily life consists of three steps-Input, Processing, and Output. Have you ever 

tried to make a clay toy? Let us see the process of creating a toy by following the given steps: 

Take raw clay. 

Mould the clay in to the desired shape. 

Finally, colour the toy and leave it to dry for some time. 

So, you see that the formation of a toy is divided into three major steps. Raw clay is the Input. Moulding, colouring, 

and drying is the Processing; and the clay toy is the Output. 

INPUT PROCESS OUTPUT 

Clay Moulding the clay Toys made with clay 

Figure 6.1:  Formation of a Toy 

A computer also works in the same manner. First, a computer accepts the data input by the user; then it processes 

the data, and finally, it gives you the output. A computer performs all these operations with the help of programs. A 

program is a step-by-step sequence of instructions that help the computer to perform the given tasks. 

There are many programming languages that you can use to write the programs. For example, Python, C, C++, Java, 

etc. In your previous class, you have already studied Python language. This chapter will help you in recapitulating the 

previously learned concepts of Python. 

S> FEATURES OF PYTHON LANGUAGE 

Python is a general-purpose, high-level programming language, which uses variables without declaration. It is: 

Simple and interactive 

Platform independent 
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U Dropbox 

Dropbox Instagram 

r Python 3.7.4 Sh& 0 

IIe tht 9s Qug Qp6ons Widow kfdp 

Python 3.7.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 19:29:22) (MSC v.1916 
32 bit (Intel)) on win32 
Type "help", "copyright", "credits" or "licenseO" for more information. 
>>> I 

U3 Co&4 

Case sensitive 

Object-oriented 

Interpreted language 

All these features make Python a popular language. It was created by Guido Van Rossum at Centrum Wiskunde & 

Informatica (CWI). It can be used for designing Console apps (where text-based application is involved like in C and 

C++ language), Desktop applications, Web applications, Mobile applications, Machine learning, Robotics, and 

performing scientific computing. 

Some popular applications that are designed using Python are: 

You Tube 

Go gle 

Google 

Quora 
Quora 

Yu 
Bittorrent 

INSTALLING PYTHON ON YOUR COMPUTER 

After installing Python, you will get the following screen: 

You can download various Python distributes 

from www.python.org/download  

Figure 6.2: Python Shell 

WORKING MODES OF PYTHON 

Python works in two different modes: 

> Interactive Mode 

> Script Mode 

INTERACTIVE MODE 

In the interactive mode of Python, the interpreter executes the statements, one by one. After the first statement is 

executed successfully, it moves to the next statement. It means that in the Interactive mode, the statements are 

executed, line byline, giving the output instantaneously. 

Learning 
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Lil' £ Sw Qug Wndow H.p 

Python 3.7.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 19:29:22) (MSC v.1916 
32 bit (Intel)) on win32 
Type "help", "copyright", "credits" or licenseO" for more infonation. 
>>> •Python i a High Level 1rograrn:uing Language' 
Python is a High Level Programning Language 
>> 10 
10 
>>> 16.8 
16.89 
>>> 19<78 
True 
>>> 100+200 
300 

L'4) C, 

To work in the Interactive mode, follow the process given below: 

- Click on the Start button> scroll down to Python 3.7> IDLE(Python 3.7). 

> It will open the Python Shell Window where you will see the Python prompt(>>>) 

Type the following commands in the interactive mode and see the output: 

Figure 6.3: Interactive Mode 

print() function 

The print() function can be used in the Interactive mode as well as in the Script mode. It is used to display 

user-defined messages on the screen. Using the print function, you can also show the result of an expression, once it 

is processed. 

There are many parameters or arguments that can be passed in the print() function. For example: 

fi. £d Sl.)I Qibug Qpioii ndow i1p  

Python 3.7.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 19:29:22) (MSC v.1916 
32 bit (Intel)3 on win32 
Type "help", "copyright", "credits" or "licenseU" for more information. 
>>> print('This is an example of print function') 
This is an example of print function 
>>> print('The sum of 10 and 20 is', 10+20) 
The sum of 10 and 20 is 30 
>>> I 

 

Li.7 Cc  

Figure 6.4: Using Print Function 

You can use many separators with print() function to format the displayed result. These include: 

> ','(comma): To print the next value after a space 

- '\n'(newline):  To print the new value in the next line 

> '\t' (tab): To print the next value aftera tab space(1 tab=5 spaces) 

For example: 
Python 3.7.4 (tag/v3.7.4:e09359ll2e, Jul $ 2019, 19:29:22) (MSC v 
32 bit (Intel)) on win32 
Type "help", "copyright", "credits" or "licenseU" for more informat 
>>> print(10,20) 
10 20 
>>> print(10,'\t',20) 
10 20 
>>> print (10, '\n',20) 
10 
20 

>>>I  -- 
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IDLE: IDLE is an integrated development environment for editing and running Python commands. If you type an 

arithmetic expression at the Python prompt and press the Enter key, the interpreter automatically evaluates it and 

displays the result. In this case, the interpreter acts as a simple calculator. It executes instructions one line at a time. 

In this mode, if you are evaluating an expression, it is not necessaj-y to use the print() function. For example: 

F 0 X 

51e Ld.t Sb1I Qtog Qpoions ndow eIp 

Python 3.7.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 19:29:22) [MSC v.1916 
32 bit (Intel)) on win32 
Type "help", "copyright", "credits" or "licenseQ" for more information. 
>>> 11+22 
33 
>>> 22-11 
11 
>>> 22/10 
2.2 
>>> 22*2 
44 
>>> 222 
484 
>>> 10+3-2 
11 
>>> I 

I.n•15 Cot4 

Figure 6.6: Using IDLE 

SCRI FIT MODE 

In th Interactive mode, Python displays the results of expressions. In the Script mode, however, Python does not 

automatically display results. You use an interactive mode when you write small programs because the output in the 

Interactive mode is compressed between the statements and is not suitable for writing lengthy programs. So, to 

write lengthy programs, you use the Script mode in which you can create and edit programs. The files created in the 

Script mode can be saved for later use. 

Writing a Program in Script Mode 

To write a program in Script Mode, follow the given steps: 

> Click on the File> New File option. 

> A new file opens. Write the program and save yourfile by selecting the File> Save option. 

) The files in Python are saved with the extension .py. 

> Once your file is saved, you can open the same file by selecting the File> Open option and execute the file using 

F5 key or click on Run > Run Module option. 

File Edit Shell Debug Option! 

New Fice Ctr(.-N 

Open... ctd+o 
Open Module... Alt+M 

Recent Files 

Module Browser Alt+C 

Path Browser 

Save ctri+s 
Save As... ctrl+shift+S 

Save Copy As... Atta-Shift+S 

Pnnt Window ctii+P 

close Alt+F4 

Exit 

Figure 6.7: Opening a New File 

O4 10.n Pt.o W..o. 0,+ 

print('python is a High 1.ev01 I.anguage') 
print (10) 
print (10+200) 
print(89<56) t 0 

10.no4q.,a 

  

  

   

Ott, 1f3VZQ1929$. 

?ijlwllpt, u., 
.0u.. 7flnOtO-4* 

O,o,. • ?J1'1.0I0. 

''51*~C' .1a 

j  k,*7 lo.. 7fl'Sttiflfll ala 

I ,0.o - 
0 - I 

   

s"- 

   

      

             

             

             

             

             

             

Figure 6.8: Saving a File 
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Let's Know More 

In Python programs, tab 
indentation is used in 
place of curly braces 

(used in other 
programming languages 

like C, C++, and Java), 
which brings clarity while 

reading codes. 

Know the Fact 

The complete script is 

written in an editor, such 

(as Notepad in Windows. 

thg do ñ'..dw Hdp  
Python 3.7.4 (tags1v3.7.4:e09359112e, 
:29:22) (MSC v.1916 32 bit (Intel)] on 
Type "help", "copyright", "credits', or 
r more information. 
>>> 
   RESThRT; C:/users/Dinezh/De5k  

thon/B8/. 1 
The .rocjuct of 10 and 20 is 200 
>>> 

Printing the Values 

Let's Know More 

A keyword is a word that 

conveys a special 

meaning to the compiler. I 

r progi .py  -  C:/Users/Dinesh/DesktoplTools  7 PythonJB8/... 

File Edit Fomiat Run Options Window Help Python is a High Level Language 
print('Pyt: Python Shell 1 La: 10 

print (10) Check Module Alt+X 210 

print (10+2 Run Module FS False 

print (89<5.. Run... Customized Shift~F5 >>> 

Figure 6.9: Executing a File Displaying Output 

> VARIABLES 

While creating programs in Python, you may require some storage location to hold the 

values to be used later. Whenever you need these values, you can draw them from the 

storage and use them for processing. These locations that are used to store values in 

memory are known as variables. Avariable can store only one data value at a time. When 

a new value is stored in a variable, its previous value gets overwritten. 

a=1O #the value lOis stored in the variable a. 

b=20 #the value 20 is stored in the variable b. 

c=a*b # the product of a and b, i.e., 10*20=20015  stored in the variable c. 

In the above example, a, b, and care the variables that store the values 10, 20, and 100 

respectively. 

Dirt:h/DektopfTooI1 Python/BS/pyl... - 

e M FQnnit Bun  Qptions ffundow 

a=1O 
b=20 
c=a*b 
print('The product of 10 and 20  is', C) 

Figure 6.10: Using Variables in a Program 

RULESTO WRITETHE VARIABLE NAMES 

When you are specifying any variable name, you need to follow certain rules: 

> A variable name must start with an alphabet (capital or small) oran underscore(_). 

> A variable name can consist of alphabets, digits, and underscore. No other character 

is allowed. 

> A Python keyword cannot be used as a variable name. 

> Space is not allowed in a variable name. 

REMEMBER 

> A variable name can be of any length. 

) Variable names are case-sensitive (e.g., roll num and Roll_num are different variable 

names). 

RESTART: C: /Users/Dinef 

Let's Know More 

Python is an open-source 

software. This means 

that its source code is 

available to the public. 

You can download it, 

change it, use it, and 

distribute it. This 
property of a programing 

language is called 

Free/Libre and open 

ource software (FLOSS). 
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Examples of some valid variable names are: 

staffid, staff address, minvalue, max val, agel 980, a45r 

Following are the examples of some invalid variable names: 

Invalid Variable Name Reason 

Book Name 

90 Price 

Book. Price 

Book@Author 

Space is not allowed. 

Variable name cannot start with a digit. 

Dot is not allowed. 

Special characters are not allowed. 

'mm' is a keyword in Python, so it cannot be used as a variable name. 

  

mm 

 

  

LATA TYPES IN PYTHON 
While riting a Python program, you need to work with different types of data. For example, if you have to enter the 

heighof a person, you will be required to use the decimal value, but if you have to write the name of a person, then 

you need to use a string ora collection of characters. 

The type of data value that can be stored in an identifier, such as a variable, is known as its data type. The data type of 

a valu or a variable is an attribute that tells what kind of data a variable can have. Data types help in classifying 

differnt types of data values used in a program. 

Pythor1 language has standard data types that are used to define operations performed on them and the storage 

method for each of them. The main data types used in Python are as follows: 

S. No. Data Type Explanation 

mt It is used when you have to work with whole numbers (positive or negative). 

These can be: 

Plain integers: Store values of the range from -2147483648 to 2147483647 

Long integers: Support the values that lie beyond the range of plain integers 

Boo!: Represents logical values in the form of True and False. In Boolean, 0 

represents False and 1 represents True. 

2. float Represents floating point values 

3. string Represents a collection of characters enclosed within single or double quotes 

Examples of values and their data types are 

S. No. 

1.  

given below: 

Value Type 

1500-1986 nt 

2.  709,789, 17.234 float 

3.  423.0 mt 

4.  'Python_Language' str 

5.  124<987 bool 
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Figure 6.14:  Using Input() Function to Multiply Integers 
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typeU FUNCTION 
If you want to know what type of data you are working with, use thetypeQfunction. It is used to return the data type 

ofa value. Lookatthe following example: 

Qthog Qptdo.s dow b4 
Python 3.7.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 19:29:22) (MSC v.1916 
32 bit (Intel)] on win32 
Type "help", "copyright", "credits" or "license 0" for more information. 
>>> type(100) 
<class 'int'> 
>>> type(' Python' 
<class 'str'> 
>>> type(10.25) 
<class 'float'>.... 
>>> type(True) [DataType 
<class 'bool'> 
>>> type(False) 
<class 'bool'> 
>>> type(89>10) 
<class 'bool'> 
>>> I 

Figure 6.11: Using Type() Function 

input() FUNCTION 

In the earlier part of this chapter, you have used '= (equal to sign), which is known as an assignment operator in 

Python. This operator is used to store a value in a variable. The value stored in a variable can be changed during the 

program execution. But to make the program user friendly, input() function is used, which allows the user to enter 

the value duringthe execution of the program as required. 

Program 1: 

      

 

pipy C:/UcDesit/Dek:op1h / - 0 X 

 

Type "help", "copyright", "credits" or "lice 
for more information. 
>>> 

RESTART: C:/Users/Dinesh/Desktop/Tof  
ython/38/Ch 7/pl.py  
Enter your name:N4IT SHARMA 
P.NIT SHARMA  

1>>  -- 

 

file fdit rmat Run Qptiono Window jjelp 

  

 

a=input("Enter your name:") 

print (a) 

  

Figure 6.12: Using Input() Function With String Values 

  

Output 

Let us see what happens when you use input() function with integerand float values. 

Program 2:
- 

Value 

P -  (,/Ut,../5,,, ID.l1opRoo / Pythrn/O/.Ch/i 

E8e £60 Ftmat 5n Qptions Window koJp 

awinput("Enter the first number:") 
b=input("Enter the second number:") 
print("The sum of the numbers is:", a~b) 

>>> 
RESTART: c:/Users/Dinesh/Desktop/Tools  7 

Enter the first number:90 
Enter the second nwnber:78 
The sum of the numbers is: 9078 
>>> I 

Figure 6.13: Using lnput() Function to Add Integers Numbers are Concatenated 

In the above program, when you enterintegervalues and tryto add them, the values are not added. Rather, they are 

joined together. Similarly, when you try to multiply these values, you will get an error as shown in the program given 

below. 

Program 3: 

Edo Qpticos  ,dow 

a=input("Enter the first number:") 
b=input ("Enter the second number:") 
rint('Tho product of the numbers is:", a°b) 

p.,. - - - -- -- 
flflAflt C,/Uflfl,DtO..h/t*,ttCt/to'i, ' pyt000l$4/Ol_7Ip3.fl 

0.,.n to. to,,. or*o 
.fl ,h. ,t-,.1 ,..flfl 

t,.c,t.tt Ct ncqot C.). last)) 
Pt). C.flst,.IDtI&fljDe*ttcpflr,iS S  ythavlatcojfl3.py. Ii.. 3. *3 

psLat,' prOduCt St the ,. In'.  •'bI 
typ.C.ror: c.a't slitipty PquCC ty Dos-let *7 tyia 'Its 

Displaying Error 



Operands 

This happens because the data type of a variable is a string by default, and a string can neither be added nor be 

multiplied. So, to convert this string into an integer or a float value, we use the functions intQ and floatO, respectively. 

Program 4: 

 

Ue/Dints -toptToo7 P)th &B8IChj/p Type "help", "copyright", "credits" or "licens. 
>>> 

RESTART: C: /Users/Dinesh/Dezktop/Tools 

     

  

file  £ FQtmat Bun icn indow p  

a=int(input("Enter the first number:")) 
b=int(input("Enter the second number:")) 
print('The product of the numbers is:", a*b) 

 

   

Enter the first number:56 
Enter the second number:43 
The product of the numbers is: 2408 
>>> I 

Output 

  

Figure 6.15: Input Values as Integers 

 

OPERATORS IN PYTHON 

   

Now, he concept of variables and various data types in Python is clear to you. Let us perform some arithmetic and 

logical operations on the variables. 

If a teacher asks you to find the product of two numbers, say, 20 and 30. What will you do? You will multiply these 

numbers, i.e., 20 * 30 and will get the result 600. 

So, if a=20 and b=30, then the product will be calculated asfollows: 

c=a*b=20*30=600 

In the above expression, "b'  is a symbol, which is used to multiply these two 

numbers. Similarly, in place of *', jf you use '+', you will get the sum of these 

numbers, i.e., 20+30 = 50. 

Operators are used to perform different operations (Arithmetic, Relational, and 

Logical) on operands and give a meaningful result. For example, in the above 

expressions, you have used symbols like P+,*P,  and =', which are called 

operators, and variables like a, b, and c, which are called operands. 

Python provides different types of operators to work with. These are listed in the following table: 

Operator Function Example 

Anti imetic These operators are used to perform arithmetic operations on the data. These 

Ope rators can be further classified as: 

Unary Operators: They work on a single operand. Unary + and Unary — a=10, a=-10 

Binary Operators: They work on two operands: 

Addition (+): To find the sum of the data values 30+ 20= 50 

> Subtraction (-): To find the difference of the data values 100-30=70 

> Multiply (*): To find the product of the data values 10*2= 20 

> Division (I): To divide the numbers and give the result in decimal form 10/4= 2.5 

) Integer Division (II): To divide the numbers and give the result in 

integer form 10/14 = 2 

> Modulus (%): To divide the numbers and give the remainder 10%3=1 

Exponential (**): To find the powers of the numbers 3**481 
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Output Figure 6.16:  Using Arithmetic Operators 
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- 
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Python 3.1.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 20:34:20 

(51(064)) on win32 
Type help, "copyright", "credits" or "llcenzeO" for nore 
>5> 
- RESTART: C:iusers/abhay/5ppDatalLocalIPrO'4rass/Pythofl/PYt 
Enter the first string:000d 
Enter the second stringAft.rn000 - 

Two strings joined together: 6000Afternoon 
The replication of the string: Good0oodGOodsood000d000d 
>5> 

Program 5: 

String operators work on the string values. These operators are of two 

types: 

>  Concatenation (~): It is used to join two string values. 

String 

Operators 
>>>'KlPS' + 'Learning 

>>>KlPSLearning 

Replication (*): It is used to repeat a string for a number of times. 

>>>KlPS*4> 

>>>KlPSKlPSKl PSKIPS 

I 

Program 6: 

Figure 6.17:  Using String Operators 

This operator is used to assign a value to a variable. 

Output 

a= 290 

The value 290 is 

assigned to the 

variable a. 

Assignment 

operators () 

Python 3.7.4 (tags/v3.7.4:e09359112ê, Jul 8 20 
4:20) (MSC v.1916 64 bit (Z4Z4D64)j on win32 
Type "help", "copyright", "credits" or "license 
more information. 
>>> 

RESTART: C: /Users/abhay/AppData/Local/Program 
/Python37/Fig7 .18 .py - 
300 

Program 7: 

Figure 6.18: Using Assignment Operators Output 

Relational 

Operators 

These operators are used to show relationship between two operands. They 

compare the values assigned to the operands and give the output in a Boolean 

expression. These are: 

Less than: < 

Greater than:> 

Less than and equal to: <= 

Greater than and equal to: >= 

Not equal to: 

Equal to: = = 

a=100 

b= 30 

a>b True 

a==b False 

FJ, fit Fs,mt Ron Ophens Wosdow Heip 

b2CI 
c=a+b 

e. i . e 
£-int(thput("fnter the first cuber;")) 
bint(input)"fnter the second nuer:")) 
printC"7h sue of the nusbers  is:,&4b) 
pr)nt)The  difference of the nunbero  is".a-b) 
print)"The product of the nIors  i:&b) 
print(he quotient  of the  nuebern in;".z/b) 
pcint("The answer for the integer division ls:".a/Ib 
prfntrme cube of the first noeher  is:".1"3) 

U. U. SOrt bent Oeoe 00.40. 0*  
Python 3.7.4 (tags/v3.7.4:009359112e, Jul 8 2019, 20:34:20) I 
(51(064)1 on win32 
Type "help". "copyright", "credits" or "license))" for mor' 
>5> 
- RESTART: cs/Users/a av/*sopltl/L.ocal/proqrap.3/PVthOfl/°'jtL  - 
Enter the first string:000d 
Enter the second string:AfternoOn 
two strings joined together: 000dAfternoon 
The replication ofthe string: GOOdGOOdGOOdGOO'Od 

d. £d8 hent Re, Optiun W.ndow Help 

a-input(("Enter the first string:")) 
b-input(("Enter the second String:")) 
print("Tn4o strings joined together:",a4-b) 
rint_e replication of the string:",a°6) 



 

>,> 
- RESTART: C: /User5/abhay/kppData/ Local/Pro. 
Python/Python37/Fig_7. 19.py - 

RI I F.  
1-100 
b200 
print (a<b) 
print(a>100) 
print (a<-b) 
print (b>234) 
rint(ab) 

 

 

 

 

True 
Falze 
True 
False 
True 
>>> I 

   

Figure 6.19  Using Relational Operators Output 

These operators are used to combine two or more conditional statements. 

They provide the result in the form of True or False. These are of three types: 

> and: Gives the result 'True' if all the specified conditions are true. 

> or: Gives result True' if any one of the specified conditions is true. 

 

a=28 

b=78 

a<100 and b<a-

True and False - 

False 

a<100 or b<a 

True and False -* 

True 

not a<100 - not 

True -)'False 

) not: It reverses or negates the given condition. If the condition is True, it 

evaluates to False, and vice versa. 

 

Program 8: 

Logical 

Operatoi .5 

RI 1* O *- II 
a-100 
b200 
print(l<b b>a 
print (1>100 :r b>a) 
print (1<-b b>lOO) 
print (b>-234  Cr  b>100) 
print(al.b) 
rint(nt(a>100)) 

Figure 6.20 Using Logical Operators  

>>> 
- RESTART: C: /Uer5/abay/AppData/Local/Proqz 
as/Python/Python37/fig_7 .20.py - 
True 
True 
True 
True 
True 
True 

Output 

Pr1ram 9: 

Let us observe the use of various operators in Python programs: 

PRECEDENCE OF OPERATORS 

The precedence of an operator refers to the order of priority in which the operators are evaluated in an expression. 

In case, two operators with the same precedence are the part of an expression, then associativity is taken into 

consideration. The Associativity of an operator determines the direction of operators from which side (either left to 

right or vice versa)the expression should be resolved. 

Precedence of operators 

Operators Description 

() Parenthesis 

** Exponentiation 

+X, -X +  Unary, -Unary 

   

Multiplication, Division, Floor Division, Modulus 

Binary Addition, Subtraction 

Relational Operators 

+, - 

  

   

C:  >, <= > =1 = =1 = 

 

   

     

   

Boolean/Logical operators 

  

not and or 
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Pytbe 3.7.4 (t.,/vi.1.4:.359II2e. .701 
4 bit (C64)J on win32 
Type h.1p, cepyrit.t, cre4i13 or 11c .0 r 

- P1SrARr: C. /Uo.iabOay/ApOata/Eca1/Pto.raa.3fPyt 
1.py - 
Enter the length of the rect.angle:20 
Enter the health of the rectar.gle.40 
The area of the rertangle i. 8:.) 

Output Figure 6.21 : Program to Calculate Area of Rectangle 
Learning 
Computers with  KIPS 

Remember: Use BODMAS rule to evaluate the operators in an expression. 

(BODMAS: Brackets Off Divide Multiply Addition Subtraction). 

COMMENTS IN PYTHON 

Comments are the statements that are added to a program with the purpose of making the code easier to 

understand. Compilers and interpreters generally ignore comments during the execution of the program. If you add 

comments to your Python program, it will not show the text written in the comments in the output. Although 

comments are optional, they are needed from the users' perspective. 

In Python, there are two types of comments: 

> Single Line Comments: Single line comments are created by beginning a line with the hash (#) character and 

automatically terminated at the end of the line. 

> Multiline comments: Sometimes your program may need to explain things in more details, which may exceed 

one line. Such comments are called multiline comments. You can provide multiline comments in a program by 

adding a delimiter(""")at the beginning and the end of the comment. 

Forexample: 

>>>  # This is a program used to calculate the simple interest. 

>>> "Program to enter the rate of interest, principle and time period. 

Use these variables to calculate the simple interest and 

Print the same. 

Remember: Single line comments appear in red colour and multiline comments appear in green colour. 

TYPES OF CONTROL STRUCTURES 

In a computer program, statements are generally executed in a sequential manner. However, at times, the user may 

need to change this order of execution by repeating or skipping the execution of a few statements, subject to a giver. 

condition. In such a situation, the flow of execution is altered by the use of Control Statements. 

Before proceeding further, you must understand the different types of constructs/statements in programming tha 

govern the flow of the control of a program. 

There are different types of statements that control the flow of a program. These include: 

> Sequential Statements: In Sequential construct, the statements in a program are executed in a sequentia' 

manner, where one statement is followed by the other, with no possibility of branching off to another action. 

For example, to calculate the area of a rectangle, first, enter the length and breadth of the rectangle, ther 

calculate its area and print the result. 

Program 10: 

I c.m I  0pbs  
-jot (input(Enter the length ot the rnctangle:)) 

btnt(input('Enter the breadth of the rectangle)) 
ar-ith 

area of the rectangle i3:,ar) 



Condition Plan of Action 

If correct PIN is entered You can withdraw the money 

If incorrect PIN is entered You cannot withdraw the money 

> Conditional Statements:  In programming languages, conditional statements cause the program control to 

transfer to a specific location depending on the outcome of the conditional expression. Every decision involves a 

choice between the two alternatives 'Yes' and 'No' result. If a conditional statement is true, then one set of 

statements is executed, otherwise, the other set of statements is executed. For example, if a number is 

completely divisible by 2 then it is an even number, otherwise it is an odd number. You will be studying more 

about these statements in the coming section. 

>	 Iterative Statements: These statements repeat a set of statements for a specific number of times as long as the 

given condition is true. When the given condition becomes false, the control comes out of the loop, and the 

repetition stops. For example, the loop will be repeated for ten times till the sum of the 10 natural numbers is 

calculated. You will learn more about these statements in the next chapter. 

CONDITIONAL STATEMENTS 

In a program, the statements are generally executed sequentially. However, at times, the user may need to change 

this order of execution, either by repeating or skipping the execution of a few statements, subject to a given 

condition. In such situations, the task can be performed by the use of Control statements. 

The Conditional statements check the condition and execute the statements accordingly. Let us understand this 

concept with a simple example. Suppose, you want to withdraw some money from the ATM. You will be allowed to 

withdraw the money only if you enter the correct PIN number. Look at the plan of action based on the condition: 

Thus, observe that you can follow one plan of action if the condition is true, otherwise, the other plan of action is 

followed. Letusanalyseitwiththehelpofaflowchart. 

A flowchart is a pictorial representation of the flow of steps or a procedure to solve a problem. 

START 

  

Go to the ATM 
and enter the PIN 

 

Cannot withdraw the 
money 

No 
4  

Is the Yes 
Correct 

PIN entered? 

Withdraw the 
money 

   

STOP 

Figure 6.22: Flowchart Displaying the plan Action Based on a Condition 
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In the conditional statement, the most important element is the condition, based on which the decision is based. 

The execution of the statements depends on the evaluation of this condition. Let us understand the various 

conditional statements given below: 

    

Example Statement 

 

Explanation & Syntax 

 

    

if This statement is used to evaluate only one Program 

condition. It performs a course of action if the a=int(input("Entera number:")) 

condition evaluates to true, otherwise it skips the b=int (input (" Enter another number:")) 

statements. if a ==b: 

Syntax: 
print ("The numbers are equal") 

Output 

if <condition>: Enteranumber 34 

statements set Enter another number: 34 

The numbers are equal 

if...else The if... else control structure is used when either Program 

of the two different actions are to be performed a=int(input("Enterthe first number:")) 

depending the result of the conditional b=int (input("Enterthe second number:")) 

expression. It works with two blocks: if and else. a>b: 

In case the conditional expression evaluates to print(a,"isgreaterthan",b) 

true, the statements in the if block are executed, else: 

and if the result is false, then the statements in print(b,"isgreaterthan",a) 

the else block are executed. Output 
Syntax: 

Enterthe first number: 456 
if <condition>: 

statements set 1 
Enterthe second number: 234 

else: 

statements set 2 

456 is greater than 234 

if...elif...else Sometimes we need to work with multiple Program 

conditions. In this case, only using if-else a=int(input("Enterthefirstnumber:")) 

construct does not serve the purpose. The if-elif- 

else statements provide a compact way to 

b=int (input(" Enter the second number:")) 

perform multiple tests on a condition. 
print (a, "is greaterthan", b) 

elif b>a: 
Syntax: 

if <condition>: 
print(b,"is greaterthan", a) 

else: 
statements set 1 

elif <condition>: 
print(" Both the numbers are equal") 

Output 
statements set 2 

else: 
Enterthefirstnumber' 548 

statements set 3 Enterthe second number 548 

Both the numbers are equal 
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We can also check multiple conditions in the 

following manner: 

if <condition>: 

statements set 1 

elif <condition>: 

statements set 2 

elif <condition>: 

statements set 3 

elif <condition>: 

statements set 4 

else: 

statements set 5 

AECAP 

 

 

> Python is a high-level language that is simple and interactive. 

) It is used to design web applications, mobile applications, desktop applications, robotics, and performing 
scientific computing. 

) Python works in two different modes—Interactive mode and Script mode. 

) In Interactive mode, the statements are executed line by line giving the output instantaneously. 

) Script mode is used to create and edit programs, which are executed as a file and can be saved for later use. 

) The files in Python are saved with the extension .py. 

> The type of data value that can be stored in an identifier, such as a variable, is known as its data type. The data 
type of a value or a variable is an attribute that tells what kind of data it can have. 

) A variable is a storage location that stores the values that can be changed during the program execution. 

> Operators are used to perform different operations (Arithmetic, Relational and Logical) on operands and give 
meaningful result. 

> There are five types of operators used in Python: Assignment, Arithmetic, Relational, Logical, and String 
operators. 

) Comments are the statements that are added to a program with the purpose of making the code easier to 
understand. 

In programming languages, Conditional statements cause the program control to transfer to a specific location 
depending on the outcome of the conditional expression. 

> There are three types of constructs in a program that control the flow of the execution of statements in a 
program. These are: Sequential, Conditional, and Iterative. 

> if,if... else, if... elif... else are the three types of conditional statements. 

Learning
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Program 

a=int (input ("Enterfirst number:")) 

b=int(input("Entersecond number:")) 

c=input("Enter your choice of operator:") 

if c=='+': 

print ("The sum of the numbers is:", a+b) 

elifc=='-' 

print ("The difference of the numbers is:" ,a-b) 
elifc==*: 

print ("The product of the numbers is:" , a*b) 

elif c=='/': 
print ("The quotient of the numbers is:" ,a/b) 

else: 

print ("Wrong operator input") 

Output 

Enter first number: 100 

Enter second number: 50 

Enter your choice of operator * 

The product of the numbers is: 5000 



Two Data Type Control Statement F5 Comments 

b. # 

C. Multiple-choice questions. 

1. Pythoncanworkin differentmodes. 

a.Three b.Four c.Two d.Five 

2. Concatenation is a operator. 

a. String b. Integer c. Float d. Boolean 

c.& 

a. trative b. Conditional 

SECTION - A 

A. Fill in the blanks. 

1. The of a variable is an attribute that tells what kind of data can a variable have. 

2. There are types of string operators. 

3. The statements that govern the flow of a program are called  

4. are the statements that are written while programming but are not executed during the 

program execution. 

5.  is the shortcut key to execute a program. 

6, StteTrueorFalse. 

1. Logical operators are used to assign a value to the variable. 

2. The value ofa variable cannot be changed duringthe program execution. 

3. In Python, 'and' is an example of Logical operators. 

4. Script Mode is used to create files in Python. 

5. Python is a case-sensitive language. 

SECTION  - B 

4. The construct executes the statements in a sequential manner. 

3. A single line comment can be created by using the symbol. 
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5. Thefilesin Pythonaresavedwiththeextension  

a. .pyth b. .py c. .pthy d. .python 

D. Answer the following questions. 

1. Write any two features of Python that make it user friendly. 

2. What is the difference between the Interactive mode and the Script mode of Python? 

3. What is the purpose of adding a comment in the program? What are the two ways used to add the comments? 

4. How is if statement different from if... else statement? 

5. Differentiate between the function of '+' operator when used with integer and string values. 

6. What is the difference between the a=1O and a==1O? 



LAB SESSION Perfection Through Practice 

A. Rewrite the following statements after correcting them:
- 

1. a=100 

b=20 

if(a>b) 

print(a) 

else 

print(b) 

2. x=290 

y=300  

ifx>yandy<100 

print (x+10) 

else if y>x orx<100: 

print(y+10) 

else 

print(x+y) 

3. a=hello' 

pri nt(a*4) 

B. Write the output of the following code segments: 

1. a=10 

b=200 

print(a>100 and b>200) 

2. a=23 

b=25 

print(a== 100 or b<26) 

3. a=10 

if a> 100: 

print("Welcome") 

else: 

print(" KlPS") 
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4. a=1O 

b=100 

print(a/b) 

print(a//b) 

print(a*3) 

print(a**3) 

5. p="lndia" 

print(p+"Delhi") 

print(p*3) 

C. Write the code for the following programs using the Script mode: 

1. Create a program to check if a number is a Buzz number or not. (Buzz number is a number that ends with 

7 or is divisible by 7). 

2. Create a program to calculate and print the area of a rectangle if the user enters 1 and print the area of a 

square if the user enters 2. 

3. Create a program to check whether a number is completely divisible by 10 or not. 

4. Using Python script mode print your school name 5 times. 

5. Create a program to check whether a character entered by the user is an uppercase character or a 

lowercase character. 

6. Create a program to check if a number input by the user is a positive or a negative number. 

7. MayurTransport Company charges for a parcel as perthe following tariff: 

Upto 10 Kg 

For the next 20 kg 

Above 30 Kg 

Rs. 15 Per Kg 

Rs.25 Per Kg 

Rs. 35 Per Kg 

  

Create a program to calculate the charge for a parcel by taking weight of the parcel as input. 

GROUP DISCUSSION For Concept Clarity 

Conduct a group discussion on the topic "Relational operators vs Logical operators" 

and "Conditional statements vs Sequential statements". 

ONLINE LINKS Looking For More 

To know more about programming in Python, visit the following links: 

https://www.tutorialspoint.com/python/python  basic operators.htm 

https://www.programiz.com/python-programming/operators  
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ITERATIVE STATEMENTS IN PYTHON 

LEARNING IN THIS CHAPTER 

' Iterative Statements 

. for Loop 

while Loop 

r Infinite Loop 

r Loop. else 

In the previous lesson, you reviewed the basic concepts of Python, its functions, 

operators, and conditional statements. In this chapter, you will learn about the 

Iterative statements. In a program, there are situations when you have to repeat 

one or more statements many times. This repetition can be carried out using 

loops in programming. 

Let us understand the concept of a ioop with the help of a real-life example. 

Suppose, your instructor instructs you to run and take five rounds of the 

playground to warm up. Before you start running, you fix a starting point. On 

reaching the starting point again, you complete one round. Then, you take the 

second round, and so on. This way you keep track of the number of rounds until 

the process of taking rounds gets completed. 

Now, let us understand the concept of looping with the helps of the above example. 

Let us say that the control variable is C. In this example, you have taken the initial value of C as 0. When you complete 

the first round, the value of C becomes 1, after the second round, its value becomes C = C + 1, i.e., 1 + 1 = 2, and so on. 

This value will get incremented each time the process repeats. After incrementing, the control variable, C will be 

checked against the maximum number of the repetitions, which is Sin this case. 

Let us understand this example with the help of a Flowchart: 

START 

Take starting point as C 

No 

Are the number 
of rounds 

greater than or 
equal to 5 (C>=5)? 

Yes 

c=c+1 
(Take more rounds) 



This process will continue until the value of C becomes 5. It means, the loop will continue 

for five times and then it will terminate. 

The advantage of using the looping technique in programming is that it reduces the 

number of instructions and also the memory space. 

ITERATIVE STATEMENTS 

The statements that keep repeating themselves as long as a given condition is true are 

called Iterative Statements or Repetitive Statements. As soon as the condition becomes 

false, the loop terminates. These are also called Looping statements or simply Loops. 

An Iterative statement is based on three values: 

A start value (initial value), e.g., C=0 

A test condition, e.g., Cz=5 

A step value (increment or decrement), e.g., C=C+1 

Every ioop works with the help of a variable known as the Control variable. The initial 

value is assigned to the Control variable at the beginning of the loop, then the final value 

of the Control variable is specified, and finally, the step value of the Control variable is 

defined, i.e., it is either incremented or decremented by the given value at each step to 

reach the final value. 

In Python, there are two types of Iterative statements: 

for 

while 

Ii> for LUO 

The for loop is used when you are sure about how many times a loop body will be 

executed. It is also known as definite loop. In Python, the working of for loop is based on 

vario soperatorsandfunctions. 

The syntax for using the for loop is: 

for <variable> in <sequence>: 

loop body (statements to be executed) 

or 

Let's Know More 

A Control variable in a 

loop is used to store the 

initial value and gets 

incremented after every 

loop to reach its final 

value. A control variable 

is also known as the 

Counter variable. 

Let's Discuss  - 

conditional Statement 

vs 

Iterative Statements 

for <variable> in range (initial value, final value, step value): 

x= 10 X=20 Default value is 1 
Know the Fact 

Loop control 

loop body (statements to be executed) 

By default, the step 

value in a loop is 

incremented by 1. 
j 

Learning 
Computers with  KIPS  



Fe Ed Format Rwi Options idow Help 

Ja=int(input("Enter a number:")) 
print(a in[1O,20,30,40,501) 

-- --- — --- 1  
C: 

r 3 t.ho/pj2 .py  
Ester a .urer:2C 

>>> 
ZZ.RT: C:/aers/  

r 3 po/py2.py 
Enter a 
Fa3.ae 
>>> 

Output 

Output 

yr7 
yth0n37-32\CT8_Fig8  .3 .py 
10 
20 
30 
40 
>>> I 

File Edit Format Run Options Window Help 

I - (10,20,30,40): 
print (I) 

Before proceeding further, let us first understand the concept of Membership Operators: 

MEMBERSHIP OPERATORS 

Membership operators play an important role in controlling the working of a loop. There are two membership 

operators, in and not in. Out of these, the in operator plays a significant role in the working of loops. Let us 

understand the in membership operator. 

The 'in' Operator 

The in operator is used to check if a given value exists in the sequence or not. It evaluates to true if it finds a value in 

the specified sequence else it returns false. 

Syntax: 

Value in [sequence]. 

For example, if you want to check whether number lOis present in a given sequence of numbers, [1,2,3,10], execute 

the following code: 

Program 1: 

   

1 8 2019. 19:29:22) LMSC v.1911 
(Intel)) on win32 
Type "help", "copyright", crecti 
licen3e() for more information. 
>>> 
3ESTART: C: \Uers\abhayAppIata 
rogram \ Python\Pytflon37-  32 \CT_Fi 

P 
F.i, £ Fc,n,t Rw, Opt.o.n Heap 

print(1O :[i,2,3,iO)) 

   

Figure 7.1:  Using 'in' Membership Operator Output 

In the above example, the program checks whether the number 10 exists in the given list or not. If yes, the in 

operator will return the value true, otherwise, it will return a false value. 

Similarly, if you want to check whether a number entered by the user is present in the given list or not, type the 

followingcode and observe the output: 

Program 2: 

Figure 7.2: UsIng 'in Membership Operator 

Using 'in' membership operator with 'for' loop 

Consider the following example: 

Program 3: 

Figure 7.3: 'in' Membership Operator with 'for' Loop 

mprswIthK(PS   



F. £d h.4 Wow  H*  
Python 3.7.4 (tags/v3.7.4:e09359112e, 
(Inte1)j on win32 
Type he1p" "copyright", "credits" or 
>>> 

RESTART: C \Uzers\abhay\AppData\Local\ 

True 
>>> I 

i=1O 
rint(i in range(100,200)) 

ytnon . r4Tt73749i12e 
(Intel)I on win32 
IType "help", copyright", credits" or 
I>>> 

RESTART: C: \Users\abhay\AppData\Local' 

False 
>>> I 

The following steps are involved in the execution of the for statement: 

Step 1:  The in operator will first check if there is a value in the list. If yes, then in operator will return the 

value true. If the value returned by the in operator is true then the loop control variable iwill be assigned a 

value from the sequence. 

Step 2:  The print statement will print the value assigned to the variable i. 

Every time the in operator returns true, a new value will be assigned to the variable i, and it will be printed. This 

process of printing values will continue until the last value in the sequence is used. The loop will terminate after 

printing the last value. 

The range() Function 

The range() function used with for loop in Python is helpful in generating a sequence of numbers in the form of a list. 

For example, range (10) will generate numbersfrom 0 to 9(10 numbers). 

Syntax: 

range(initial value, final value, step value) 

Here, the initial value is an integer specifying at which position to start, while the final value specifies the end, and 

the step value specifies either increment or decrement at each step to reach the final value. While using the range() 

function, the final value is always 1 less than the last value in the given sequence. The use of the rangeQfunction can 

be understood by thefollowing example: 

Program 4: 
118_Fg8 4 py c \Users\abhay\AppData\Local\Programs\Python 

File Edit Format Run Options Window Help 

Ii=io 
print(i in range(1O,20)) 

Figure 7.4:  range() function Returning True Value Output 

In the above code, the initial value of the variable I is 10 and the final value is 19 (20-1 =19). Each time the loop 

executes, the value of i is incremented by 1. So, the final sequence will be [10,11,12,13,14,15,16,17,18,19J. Now, the 

variable i(which in this case is 10) will be checked within this range. As '10' is present in the given range so the output 

of the program will be true. 

Now try some other range. The output of the program will change accordingly. 

Figure 7.5:  range() function Returning false Value Output 

Learning 
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Step 1:  The initial value of the i variable is assigned 10. 

Step 2:  using the range() function, a sequence is created with all the values between 100 and 199. The in 

operator will check whether the value of the variable i exists in the sequence or not. If the value does not 

exist in the sequence, the in operator will return false. 

Using range() function in for loop: 

You can use the range() function in for loop to iterate through a sequence of numbers. 

Program 6: 

- 
4e Let Siu Dt9 Opt,om Wdo $dp  

File Eirt Format Run Options ,'.indc' He'p Python 3.7.4 (tags/v3.7.4:e09359112e, 

- . , 19:29:22) IMSC v.1916 32 bit (Intel) 
for  1  in (10, 20) : 'rype "help", "copyright", "credit5" or 

print (1)
" for more information. 

Figure 7.6:  Using 'for' Loop with 'in' Operator Output 

Step 1:  The for loop executes. The initial value, 10 is assigned to the variable i. 

Step 2: The value of i, i.e., 10 is printed. 

Step 3: The counter variable is incremented. The next value, which is 20, is assigned to the variable i and the same 

is printed. 

Now, let us see how the range() function works in for loop: 

Program 7: Write a program to print the square of the numbers given in range. 

*a8F1g8.7.py  - hon\ Python37-32\CT8_Fig8 
100 
121 
144 
169 
196 
225 
256 
289 
324 
361 
>>>  I 

 

     

File Edit Format Run Options Window Help 

 

for i in range(iO,20) 
print (j*j) 

 

     

     

Figure 7.7: Using 'for' Loop with range() Function Output 

When you use the range() function, it creates a sequence of all the values between the initial value and the final 

value - 1'. In this case, a sequence of values between 10 and 19(20-1=19)is created, and the squares of all the values 

from 10 to 19 are printed. 

>>> 
RESTART: C: \Users\abhay\AppData\Local' 
ython\Python37-32\CT8Fig8.6. py 
10 
20 
>>> I 



p 
File t Sard Debug Optiona Wordo. -4e4p 

Jul 8 2019, 19:29:22) IMSC v.19 
bit (Intel)) on win32 
Type "help", "copyright", "credi 
r "license C)" for more informati 
>>> 
RESThRT: C: fusers/abhay/AppData 

1/Prograins/Python/Python37- 32/CT 
re8 • 8. 
10 
13 
16 
19 
>> 

The variable is 
incremented by 3 

at each step.) 

Step 1: The for loop executes and the rangeQ function creates a sequence of values between 10 and 19. The 

initial value, i.e., lOis assigned to the variable i. 

Step 2: The square of the value 10, i.e., 10015 printed. 

Step 3: By default, the countervariable is incremented by land its square gets printed. 

Step 4: The step 3 continues till the last value in the sequence, i.e., 19 is assigned to the variable i and its square is 

printed. 

Now, if you change the step value or increment the value in the range() function by 3, see what happens: 

Program 8: 
C:/Users/abhay/AppData/locallProgram... 

I 
File Edit Format Run Options Window Help 

for i in  range(1O,20,3) 

Here, value of I is 
incremented by 3 

everytime. 
I 

Figure 7.8: Changing Step Value in range() function Output 

When you increment the step by 3, you willget the sequence [1013,16,19]. 

Step 1: The for loop executes and the range() function creates a sequence of values between 10 and 19. The 

initialvalue, i.e., lOis assigned to the variable i. 

Step 2: The value lOis printed. 

Step 3: The countervariable is incremented by 3, the next value is assigned to i, i.e., 13 is printed. 

Step 4: The step 3 continues till the last value in the sequence, i.e., 19 is assigned to the variable i and gets printed. 

TIe value of the countervariable can also be decremented ton number of steps. Forexample: 

fori in range (20,10,-3) 

Program  9:Write a program to find the Factorial of a number. 

Factorialof5:5x4x3x2x1= 120. 

File Edit Format Run Optiono Window Hdp 

a=int(input("Enter a number:")) 
f=1 
fr i in range(1,a+l): 

ff*j 

print("The factorial of the number is: ",f) 

Figure 7.9:  Printing Factorial of a Number 

F. hut Shot Ostug 0p1io1 Wodow Naip  

Python 3.7.4 (tags/v3.7.4:e09359112e, .u1 6 2019, 19:29:22) )MSC 
.1916 32 bit (Intel)) on win32 
Type "help", "copyright", credits" or 'license()" for more info 
tion. 
>>> 

P,ESTART: C: \U3.rs\abhay\Appoata\Local\Programs\Python\Pytho37-32 

Enter a number:S 
The factorial of the n,mrber is: 120 
>>> I 

Output 
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Step 1:  The program asks a userto enter a number, let's say, 5. 

Step 2: Assign the value 1 to variable f. 

Step 3: Specify the range in for loop, i.e, 1 toa+1 (where the value entered by the user is stored in variable 'a'.). 

Step 4: Thefactorial will be calculated as f=f*i. 

Step 5:  By default, each timethe loop executes, the value of the variable i is incremented by 1. 

Note: The variable f is assigned a new value each time the statement f*j  is executed. 

Step 6: Steps 4 and 5 are repeated till the last value of the counter variable is encountered. 

Step 7: The final value of the factorial variable, i.e., f is printed. 

Program 10: Write a program to print a Fibonacci Series. 

A Fibonacci series is a series in which each number is the sum of the two preceding numbers, such as 0, 1, 1,2,3,5,8, etc. 

File Edit Fo,Tn.t Run Options Window I4elp 

n=int(input("Enter the level upto which the series needs to be printed:")) 
a=O 
b=1 
print (a) 
print (b) 
for  I in range(l,n+1): 

c=a+b 
print (C) 
a=b 
b=c 

Figure 7.10:  Fibonacci Series 

pythcn/pyl3 .py 
Enter the level upto which the series needs to be printed: 
0 
1 
a. 

2 

3 

5 

a 

13 

21 

34 

>>> 

Output 



Step 1: The useris asked to enter a value forvariable n. 

Step 2: The variable a is initialised toO. 

Step 3: The variable b is initialised to 1. 

Step 4: Initial value of a is printed. 

Step 5:  Initial value of b is printed. 

Step 6:  Now, the for loop executes from 1 up to n+1. 

Step 7:  The next value of the series is generated and printed by adding the previous two terms, i.e., c=a+b. 

Step 8:  The value of b is assigned to a. 

Step 9:  The value of c is assigned to b. Note, the value of a and b is updated every time when the loop is executed. 

Step 1O:The loop will terminate when the last value in the range, i.e., n+1 is encountered. 

E while LOOP 

The while loop is the simplest of all looping structures. In general, this loop can be applied to a program where the 

number of iterations is not known beforehand. The while loop keeps on executing the block of statement as long as 

the specified test condition evaluates to true. 

While loop has four main components: 

INITIALISATION 

It is used to assign an initial value to the loop control variable, e.g., a=1O. 

CONDITION/TEST EXPRESSION 

This statement checks whether the loop body will be further executed or not. The loop keeps executing till the 

condition or the test expression is true. 

LOOP BODY 

It contains the set of statements that are required to iterate or repeat. 

STEP VALUE 

This statement keeps updating the loop control variable so that a final value is achieved and the loop terminates. 

Remember 

You must provide an initial value to the loop variable to execute the loop smoothly. 

Syntax: 

initialization 

while<condition>: 

loop body 

updation 

Let us understand the working of the while loop with the help of the following examples: 

comrsKIPS  



File Edit Format Run Options Window Help 

i=10 
while i<20: 

print (j*j) 
i+=l 

lsquare of a number 
is calculated. 

Program 11: Write a program to print the first 10 natural numbers. 

8..Fig8.11.py-C:\Users\abhay\AppData\1ocal\ProgramAPytbon' 

File Edit Format Run Options Window 

1=0 
while i<=10: 

print (i) 
i=i+i 

RESTART: C: \Userz\abhay\Appi 
rogralns\ Python\ Python37 -32 \CT8J 
V  
0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 

Figure 7.11: Using while Loop to Print First 10 Numbers Output 

Step 1: InitiaIisethevariableito0. 

Step 2: Check the condition whether k=1O. 

Step 3:  lfk=10, print the value of i. 

Step 4: Increment the value of i by 1, i.e., i=i+1. 

StepS: This process will continue till the value of i is less than or equal to 10. The loop will terminate once the 

value of I becomes greater than 10. 

Program 12.  Write a program to printthe square of numbers between 10 and 20. 

'.[g8.12.py  
100 
121 
144 
169 
196 
225 
256 
289 
324 
361 
>>> I 

Figure 7.12:  Square of Numbers Using while Loop Output 

Step 1: The variable i is assigned an initial value, 10. 

Step 2: The condition <20 is checked. 

Step 3:  If the condition evaluates to true then the statement print(i*i)  is executed. 

Step 4: Each time the loop executes, the value of i is incremented by 1. 

StepS:  The control shifts back to the while loop. The while condition is checked again. If the condition is true then 

steps 3 and 4 are repeated, and if the condition is false, the while loop terminates. 

Learning 
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Step 1: The user is asked to entera number of his choice. 

Step 2: The initial value 1 is assigned to the variable i. 

Step 3: The while condition i<=1O will be checked. 

Step 4: If the condition evaluates to true, the statements after the while condition are executed and the product 

of n and i is printed. 

Learning 
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Program 13  : Write a program to print the multiples of 3 and their sum (in the range 10 to 30). 

Type thelp, copyright, cr.dits or 1icenze0 for re infc 
rmation. 

RESTARr: C: /Users/abhay/AppData/Local/Prograaz/Python/ Python37- 
32/CT8_fig8.13.py 
12 
15 

. I 
i-jo 
s-O 
while(i<-30): 

ir  j13-0: 
print(i) 
3+-i 

i+-j 21 
print('The su. of  all the ultipies of 3 in the range 10 to 30  is:,$) 24 

127 
30 
The sum of all the multiples of 3 in the range 10 to 30 is: 147 L.IO CL 

FIgure 7.13: Sum of multiple of 3 using while loop Output 

Step 1: The variable i is assigned an initial value, 10. 

Step 2: The variables is assigned an initial value, 0. It will store the sum of all the multiples of 3. 

Step 3:  The condition k=30 is checked. 

Step 4:  If the condition evaluates to true then the if statement checks whether the variable is a multiple of 3 or 

not. 

Step 5: If the condition is true then the counter variable is printed and is added to the previous value of s. 

Step 6:  Each time the loop executes, the value of i is incremented by 1. 

Step 7: The control shifts back to the while loop. The while condition is checked again. If the condition is true 

then steps 4,5 and 6 are repeated, and if the condition is false then the while loop terminates. 

Step 8: Thefinal value ofsis printed. 

Progrdm 1 4: Write a program to print the table of a number. 

n=int(input("Enter a number:")) 
i=1 
while  i<=1O: 

print(n, '*'  ,j, =1 1 flt1) 

i+=1 

Figure 7.14:  Printing table of 6 using while loop  

r 3 pytho/py1C.py 
Enter a nber:6 
6l-6 
6 2 12 
6 * 3 - 18 
6 - I 24 
6 • 5 - 30 
6 * 6 - 36 
6 • 7 - 42 
6 8 - 48 
6 * 9 - 54 
6 • 10 - 60 
>>> 

Output 



File Edit Format Run Options Window Help 

i= 10 
while i>=1: 

print(i) 
i += 1 

 

Infinite loop 

File Et SMII Debug Options Wledcw H 

To terminate 
an Infinite loop close 
the interactive mode 

window. 

'juz 
1303 
1304 
1305 
1306 
1307 
1308 
1309 
1310 
1311 
1312 
1313 
1314 

StepS: The value of i is incremented by 1. 

Step 6: The control shifts back to the while ioop. The while condition is checked again. If the condition is true 

then steps 4 and 5 are repeated and if the condition is false, the while loop terminates. 

Program  15:Write a program to display no output when the test condition is false. 

r 

File Edit Format Run Options Window Help 

1=10 
while i<=1: 

print(i) 
i=i+1 The condition will 

return false. 

F3e EI Shd Debug  Options Widow I4eip 

Python 3.7.4 (tags/v3.7.4:e0935 
8 2019, 19:29:22) [MSC v.1916 
tel)) on win32 
Type "help", "copyright", "credi 
icenseO" for more information. 
>>> 
RESTART: C: /Users/abhay/AppDat 

ogramslPythonlPython37- 32/CTS_F 
dition.py 
>>> I 

The loop body will 

not execute. 

Figure 7.1 • False Test Condition in while Loop Output 

In the above example, as the initial value of i, lOis greater than 1, the condition will return false, and hence the loop 

body will not be executed even once. Hence, you do not get any output. 

INFINITE LOOP 

An infinite loop (or endless loop) is a sequence of instructions in a computer program, which loops endlessly. It 

happens either due to the loop having no terminating condition or having the condition that can never be met. Let's 

consider the following example: 

Program 16:To create a program displaying endless loop 

Figure 7.16: Infinite Loop Output 

In the given example, as per the condition, the loop will continue until the value of i is greater than or equal to 1. In 

the updation part, you are incrementing the value of i by 1 at every step and hence the loop variable i will always be 

greater than 1. This means that at no time will the loop variable be less than 1 and hence the loop body will execute 

infinitely. 

Learning 
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File Edit Fonnit Run Options Window Heip 

a=int(input("Enter the lower limit:")) 
b=int(input("Enter the upper  limit:")) 
even=O 
odd=0 

i  in  range (a,b~l)-- 
if  i%2==0: The else part will be 

even+=i executed when the loop 
terminates successfully. 

odd+=i 
e I  e: 

print("Loop terminated successfully:") 
print("The  sum of all the even numbers in the given series is:", even) 
print("The  sum of all the odd numbers  in the given series is:", odd) 

Ln 14 CcO 

J 

Ln:10 Col:4 

Output 

Learning 
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To come out of the infinite loop, you have to terminate the interactive mode or program execution by closing the 

interactive mode window. 

1 
 If the control variable does not get updated to a final value, the condition remains true forever, and the loop 

Lcontinues infinitely. 

Lop...eIse 

A forloop or while loop can have an optional else block as well. The else part is executed if the loop terminates 

normally, i.e., if all the values in the sequence get used in a standard way without the loop being forcefully 

terminated. Both the loops, i.e., for and while loop can use else part. However, it is not mandatory to have an else 

block with the loop block. It is just a secure way to check that the loop has terminated normally. 

Program 17:  Write a program to print the sum of all even and odd numbers with in a range. 

(3.7.4) - 0 X 

Figure 7.17:  for...else 

r 
File Edit Shell Debug Options Window Help 

Python 3.7.4 (tags/v3.7.4:e09359112e, Jul 8 2019, 19:29:22) [MSC v.19 A 

16 32 bit (Intel)) on win32 
Type "help", "copyright", "credits" or "license C)"  for more informatio 
n. 
>>> 

RESTART: C: /Users/abhay/AppData/Local/Programs/Python/Python37-32/CT8 
_Fig8 .17 .py 
Enter the lower linat:10 
Enter the upper liniit:20 
Loop terminated successfully: 
The sum of all the even numbers in the given series is: 90 
The sum of all the odd numbers in the given series is: 75 
>>> I 



File Edit Fonnit Run Options Window Help 

a=int (input ("Enter 
b=int(input ("Enter 
i=a 
while i<=b: 

c=(j**2) 
print (C, 
i+=l 

else :— 
print () 
print("boop is 

lower level of the series:")) 
upper level of the series:")) 

The  else part will be 
executed when the loop 
terminates successfull, 

terminated successfully") 

the 
the 

V 
Enter the lower 
Enter the upper 
4 
9 
16 
25 
36 
49 
64 
81 
100 

level of the series:2 
level of the series:1O 

Loop is terminated successfully 
>>>  I 

Program 18:  Write a program to print the series: 49 16 100. 

Figure 7.18: while .... else 

Output 

RECAP 
> In Python, iterative statements keep repeating a set of statements as long as the given condition is true. 

) Iterative statements are also known as loops. 

> There are two types of Iterative statements: for and while loop. 

> for  loop is generally used when you have to repeat a task a specified number of times or within a given range. 

> The in  operator checks whether a given value is a part of the specified sequence. 

) The range() function produces a list of a sequence starting with an initial value up to a final value, updating the 

value at each step. By default, the value is incremented by 1. 

> The while loop can be applied to a program where the number of iterations is not known beforehand. The while 

loop keeps on executing the block of statement as long as the specified test condition evaluates to true. 

- Learning 
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DEVELOPER 

> The while loop has four main components: Initialisation, Condition, Loop body, and Step value. 

> Afor loop ora while loop can have an optional else blockas well. 

> The else part is executed if the loop terminates normally, i.e., if all the values in the sequence get used in a 

standard way without the loop beingforcefullyterminated. 

> The ioop.... else statement is optional to be used in a program. The else block simply makes sure that the loop is 

terminated normally. 

SECTION -  A 

A. Multiple-choice questions. 

1. Iterative statement is also known as statement. 

a. Looping b. Conditional c. Selection d. Sequential 

2. The  loop is used when you are sure about how many times a loop body will be executed. 

a. while b. for c. while...else d. while...not...else 

3. If the condition in a loop is false in the first step itself, you get  

a. No output b. Infinite c. Error d. Normal 

4. The operator checks whether a given value lies within a given set of values. 

a. not in b. between c. range d. in 

5. The loop can be applied to a program where the numberof iterations is not known beforehand. 

a. while b. while...else c. for...not...else d. for 

B. Answer in one word. 

1. Mention the other name for Iterative statements. 

2. Name the two types of Iterative statements. 

3. Name the two membership operators in Python. 

4. Which function is used to check the range in a loop? 

Learning 
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C. Answerthefollowingquestions. 

1. What do you mean by Iterative statements? Give an example. 

2. Why are for and while loops called entry controlled loops? 

3. What is the use of membership operators in Python? 

MY ACTIVITY 

 

Perfection Through Practice 

  

Rewrite the following code of statements after correcting the syntactical errors. 

a. a=integer(input("First number")) 

b=1O 

fori in range(a:b): 

PRI NT(a*b) 

if (a>b) then 

print(a) 

b. i=1O 

while (i=>5): 

print(l) 

i=l+1: 

2. Rewrite the following for loop program using the while loop. 

aint(inputQ'Enterthe first number")) 

b=int(input("Enterthe second number")) 

for i in range(a,b,3): 

print(a*i) 

print("Program Over") 

Learning 
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Rewrite the following code of programs using the for ioop. 

a. aint(input("Entera number")) 

i=a 

while b=O: 

print(a*i) 

i=i-2 

b. x=1O 

y=100  

if x==y: 

print(x) 

elify>x: 

print(y) 

while x<1O: 

print(x) 

x+= 1 

Write the output for the following code of statements. 

a. a=100 

b=20 

5=0 

while a>=b: 

if a%5==0: 

s+=a 

a-= 1 

print(s) 

b. n=1 

while n<5: 

print(n*n) 

n+=1 

c. n=10 

while n<50: 

pnnt(n+n) 

n+=10 

Write the program code for the following: 

a. To print the table of a number using 'for' loop 

b. To print the sum of all the even numbers in the range entered by the user 

c. To print the negative odd numbers between 1 to 30 



USING LISTS AND TABLES IN 
HTML 5 

.  LEARNING IN THIS CHAPTER 

Introduction to lists 
t  Unordered and ordered list 

List properties 

* Nested list 

t  Description list 
Tables 

• Table properties 

In the previous class, you were introduced to the basic formatting tags that were used for designing web page in 

HTML. You have also learnt about the usage of CSS to spruce up the appearance of these elements. 

In this class, you will discuss some more tags to embed objects like Lists, Links, and Tables in our web page to make it 

look more appealing and professional. 

LISTS 

Whether it is the minutes of a meeting, a list of items, orthe table of contents of a document, you wilifind the use of a 

list in all. A list is the most efficient way of presenting information in a precise manner. It helps in making important 

points standout more clearly, there by grabbing a visitor's attention. HTML supports different elements to create a 

list for displaying items in a specific order. A list can be defined in different styles. The types of list that HTML provides 

are: 

Unordered List 

Ordered List 

> Description List 

UNORDERED LIST 

An unordered list is used when the items are not required to be displayed in any particular sequence. The list begins 

and ends with <ul and </ul> tags, respectively. It indents each item in the list and adds a bullet against each of them. It 

is also known as the Bulleted list. For example, a list of stationery items: 

Pen 

Eraser 

Pencil 

Stencil 

Clipboard 

<LI> tag 

To display the list of items given in any of the two list types, i.e., Unordered and Ordered list, <Ii> tag is used. 



Benefits of Positive Attitude 
• Increases Productivity 
• Improves Quality 
• Efficient Team work 
• Breeds Loyalty <Ii> 

J Usinylists 

- o [c  fil.///C/Users/User/Desktop/1,st1.html 

Increases Productivity 

<Ii> Improves Quality 

<Ii> Efficient Team work 

<Ii> Breeds Loyalty</ul></body></htrn!> 

(<html> 

<head> 

<title>Using lists</title><style type="text/css"> 

body{background-color:RGB(255,251 ,214)} 

hi{color:red} 

li{color:green} 

</style> 

</head><body> 

<hi> Benefits of Positive 

Attitude <Jhl><ul> 

Let us have a look at the following example: 

0 — o 
ordered l 

- -' C 0 fiI///C/Users/User!Desktop/madhu/Sl Q. 

<html> 

<head> 

<title>ordered list</title> 

<style type="text/css'> 

body{background-repeat:no-

repeat;background-

image:url(pancake.jpg); 

color: Blue;f ont-size:20px} 

hl[color:Red} 

</style> 

</h ea d> 

<body> 

<hi> Recipe for PanCake: 

The <menu> tag is used to 

create a menu list. <menu> 

denotes the start of the 

menu and </menu> 

denotes the end of the 

menu. 

Let's Know More 

You can also style lists with 

colours, to make them 

more noticeable. 

For example: <style> 

01 {background: Peachpuff; 

padding: 20px;} 

li{background: silver; 

padding: 5px;} 

</style> 

ORDERED LIST 

The ordered list is used to display the list of items in a specific order. An ordered list 

indents and gives a number to each item in the list, that is why it is also known as the 

Numbered list. The list begins and ends with <el> and </ol> tags, respectively. Ordered 

lists are mostly used in situations where the order of the items is significant or where it is 

required to keep a count of the number of items. For example, in a recipe, if the steps are 

not demonstrated orderly, the end result would not be as desired. 

ecip for PanCake: 

1. In a large bowl. nux flour. iugar. baking powder and iilt 
2. Make a well in the center, and pour in milk, eig and oil Mx 

until smooth 
3 Heat a hghtiv oiled griddle or Irving pan over medium high 

4. Pour or scoop the batter onto the griddle. using approximately 
14 cup for each pancake. 

5. Brown on both sides and serve hot 

CoutrsthKIPS  



0 X 
Charactst 

cD file-J//C/Users/userfhstl.html 

Character is a combination of: 

3. Intewity 
2. Unselfishness 
1. Understanding 

,1 

I- 

czol> 

<Ii> In a large bowl, mix flour, sugar, baking powder and salt. 

<Ii> Make a well in the center, and pour in milk, egg and oil. Mix until smooth. 

<Ii> Heat a lightly oiled griddle or frying pan over medium high heat. 

<Ii> Pour or scoop the batter onto the griddle, using approximately 1/4 cup for each pancake. 

<Ii> Brown on both sides and serve hot. 

</01> 

</body> 

</html> 
I 

NOTE 

When an ordered List is used, the <Ii> element will be rendered with a number. One can control the number's 

appearance with the <TYPE> attribute orapplying CSS property LIST-STYLE-TYPE. 

ATTRIBUTES OF <OL> TAG 

Start Attribute 

An ordered list automatically starts with number 1, but you can also start the list with a different number with the 

help of the Start attribute. 

For example, if you write START = 101, the ordered list numbering will start from 101. 

Reversed Attribute 

This attribute specifies that the list order should be in the descending order. 

<html> 

<head> 

<title> Cha ra cter</titl e> 

<style type="text/css"> 

body{background-color:RG B(255,251,2 14)} 

hi {color:red} 

li{color:green} 

</style> 

</head> 

<body> 

<hi> Character is a combination of: </hl> 

'<ol start=3 reversed> 



Number Style 

 

Result 

 

Description 

   

<OL Type = "A"> 

<OL Type = "a"> 

<OL Type = "I"> 

<OL Type = 

A, B, C Upper Case letters 

Upper Case Roman Numbers 

a, b, c Lower Case letters 

i, ii, iii Lower Case Roman Numbers 

<OL Type = "1"> 1,2,3 Sequence of Numbers (default) 

Learning 
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<Ii> Integrity 

<Ii> Unselfishness 

<Ii> Understanding</ol> 

</body> 

</html> 

Type Attribute 

This attribute specifies the type of numbering or bullet used to mark items in the list. By default, its value is '1 for an 

ordered list and 'disc' for an unordered list. 

SYNTAX: 
UNORDERED LIST 

Bullet Style Description Result 
For Uordered list: <ul type = "value"> 

where, value = discsquarecircle 
Disc A filled circle (default) 

Circle 0 A non-filled circle 
For Ordered list: <ol type = "value"> 

where, value = Alailliji 
Square U A filled square 

ORDERED LIST 

LIST PROPERTIES 

LIST-STYLE-TYPE 

Like Type attribute, this property specifies the bullet style that will be used as the type of list item marker. 

SYNTAX: list-style-type:value 

where, values for unordered list= none discjcirclejsquare (disc is the default value) 

and values for ordered list= decimaljdecimal-leading-zerojlower-romanjupper-romanj 

lower-alphajupper-alpha (decimal is the default value) 

LIST-STYLE-IMAGE 

With this property you can specify an image as the list item marker. 
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unordtred tst pfopertes X 

Parts of Speech 
List-style-position=inside 

pronoun 
adjective 

Parts ofi sin 
List-styIe-position=outs) 

Common 'ouns 
E Proper Nouns 
€ Abstract Nouns 

ID fileu//ClUsers/User/Desktop/O. *1 

SYNTAX: list-style-image:value 

where, value=url("path of the image")none 

LIST-STYLE-POSITION 

You can specify the position of the list-item markers with the help of this property, i.e., to make them appear inside 

or outside the content flow. 

SYNTAX: ist-style-position:value 

where, value=insideloutside 

LIST-STYLE 

This is the shorthand property wherein all the list properties can be specified in one declaration. 

SYNTAX: list-style:value 

where, value= value for list-style-type value for list-style-position value for list-style-image 

If one of the values is missing in the above short-hand property, the default value for the missing property will be 

inserted, if any. 

<html> 

<head> 

<title>unordered list properties</title> 

<style type="text/css"> 

body{background-color:RG B(255,251,214)} 

u l{l 1st-style-image: u rl(" ch eck.jpg")} 

li{font-size:30px;color:purple;text-align:top} 

hi {color:red} 

</style> 

</head> 

<body> 

<hi>Parts of Speech</hi> 

<ul style=list-style-position:outside> 

<li>noun 

<I i>pro noun 

<li>adjective 

</u I> 

<hl>Parts of Noun</hi> 

<ul styleHist-style-position:inside> 

<li>Common Nouns 

<li>Proper Nouns 



'--'C 0 file:///C:/Users/User/Desktop/pre.htmt 

[ ordered and unordered x 

Vitamins 
List-style-type:circle 

- -o u le vitamins 
i. Vitamin-A 
ii. Vitamin-D 

iii.-Vt 
iv. Vitamin-K 

Water-soluble vitamins 
A. Vitamin-B Ust-style-type:upper-alpha 

B. nun-:2 
C. Vitamin-B3 
D. Vitaniin-B5 
E. Vitainin-B6 
F. Vitaniin-B7 
G. Vitamin-B9 
H. Vitamin-B 12 
I. Vitamin-C 

List-style-type:lower-roman 
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<li>Abstract Nouns 

</body> 

</html> 

                 

                 

I 

                   

                     

NESTED LIST 

A nested list is a list inside any other list. An ordered and unordered list can be nested within each other to form a 

multi-level list. To create a nested list, add a new list within the list as given below: 

I 
<html> 

<head> 

<title>ordered and unordered lists</title> 

<style type=text/css"> 

body{background-color:RGB(255,251,214)} 

ol{list-style-type:lower-roman;} 

ul{list-style-type:circle;} 

li{font-size:2Opx;} 

hi {color:blue}</style></head><body> 

<hi> Vitamins</hi> 

<ul><li style=color:red><b>Fat-soluble vitamins</b> 

<ol><li style=color:darkgreen>Vitamin-A 

<Ii style=color:darkgreen>Vitamin-D 

<Ii style=color:darkgreen>Vitamin-E 

<Ii style=color:darkgreen>Vitamin-K 

<fol><li style=color:red><b>Water-soluble vitamins</b> 

<01 style=list-style-type:upper-alpha> 

<Ii slyIe=color:darkgreen>Vitamin-Bi 

Ie=color:darkgreen>Vitamin-B2 

<Ii stylecolor:darkgreen>Vitamin-B3 

<Ii style=color:darkgreen>Vitamin-B5 

<Ii style=color:darkgreen>Vitamin-36 

<Ii style=color:darkgreen>Vitamin-37 

<Ii style=color:darkgreen>Vitamin-B9 

<Ii style=color:darkgreen>Vitamin-B12 

<Ii style=color:darkgreen>Vitamin-C </ol></ul> 

</body></html> 

<Ii S 



description list X 
— 0 X 

C 0 file://fC:fUsers/User/Desktop/I $. * 

DNA 
DNA stands for Deoxyribonucleic acid. It is the 
hereditary material ui humans and almost all other 
organisms. 

RNA 
RNA stands for Ribonucleic acid. It acts as a 
messenger between DNA and the protein synthesis 
complexes known as ribosomes. 

DESCRIPTION LIST 

A description list consists of a term followed by its definition. It is used to present a glossary, list of terms, or other 

name/value lists. It starts and ends with <dl> and </dl> tag, respectively. The <dl> tag is used in conjunction with <dt> 

and <dd> tags where: 

<dt>helpsindefiningthetermsornames 

> <dd> helps in describing each term or name 

<html> 

<head> 

<title>description list</title> 

<style typetext/css"> 

body{background-color:peachpuff} 

dt{text-transform:uppercase;color:red;font-

size:30px} 

dd{color:green;font-size:2Opx} 

</style> 

</head> 

<body> 

<dl> 

<dt>d na 

<dd>DNA stands for Deoxyribonucleic acid. It is the hereditary material in humans and almost all other 

organisms.</dd> 

<dt>rna</dt> 

<dd>RNA stands for Ribonucleic acid. It acts as a messenger between DNA and the protein synthesis complexes 

known as ribosomes.</dd> 

</body></html> 

2 

E TABLES 

Tables are extremely popular on the web because they are flexible and an attractive way of presenting information 

in the form of rows and columns. 

ADVANTAGES OF TABLES 

> Tableshelppresentinformationordatainacomprehensivemanner. 

> Tableshelpincomparativeanalysisofdata. 

> Information displayed in tables is easier to read and quickerto evaluate. 
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Student Information 
S.No. Name Grades 

1 Bindu A 

2 Yogesh A+ 

3 Sakshx A 

<html> 

<head> 

<title> 

Creating a Table 

</title> 

<style type='text/css'> 

body{background-color:rgb(255,25 1,214)} 

th{color:blue} 

</style> 

</head> 

<body> 

<table> 

<caption style= color:red> Student Information 

</caDtion> 

<tr> 

<th1S.No.</th><th>Name</th><th>Grades</th> 

</tr<tr> 

<td>1<ftd> 

Let us have a look at the various terms to define a table: 

Information .Student I  Caption: This provides a Shorti 
description of the table. 

Columns: Acolumn in a table is the set of 
facts that you keep track of about that type 

I I jof object. It is also called Field. 

Headings: These are the special cells ¶No. Name Grades 
that act as labels depicting the type I I 
of information In each column. 

. 
1 Neha A+ Rows: A row represents one instance 

— of the type of object described in a 

2 Shikha A table. It is also called a Record. 

Cell: it is the intersection of a column  1 
androw. I' 3 Riya B 

How to create a Table in HTML 

To create a table in HTML, the <table> tag is used. Each table begins with a <table> tag and ends with </table> tag. 

Each row in a table begins with the <tr> table row tag and ends with the </tr> tag. The rows must always be inside the 

<table> tag. The columns contain cells, each of which begins with the <td> table data tag and ends with the </td> tag. 

<td> tag must always be present inside the row tags <tr>. To specify a column heading, you use the <th> tag that also 

ends with the </th> tag. It makes the text bold. The <caption> tag is used to specify the title forthe table. 

Let us create the above given table in HTML using these tags: 
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1<td>Bindu</td><td>A</td> 

</tr><tr><td>2</td> <td>Yogesh</td><td>A+</td> 

</tr><tr><td>3</td> <td>Sakshi</td><td>A</td> 

</tr></table> 

</body></html> 
I 

            

            

            

            

  

The above table does not give the real appearance of a table, except that the data is depicted in rows and columns To 

enhance its appearance, let us discuss the various table properties in the coming section. 

  

            

            

S TABLE PROPERTIES 

The following properties can be applied in a table to enhance its look and appeal. 

Border 

This property helps in specifying the borderwidth, border style, and border-colour of the table and its cells. 

SYNTAX: border:value 

where, value valuefor border-width valuefor border-style valueforborder-color 

Let us apply this property on the above example: 

<html> - - 

<head> 

<title> Creating a Table</title> 
— 0 X 

<style type="text/css"> ( Creating a Table 

body{background-color:rgb(255,251,214)} D file:///C:/Users/UserjDe 

table,th,td{border:1 px solid blue} Student Information 

th{color:blue} S.No. rca me Gia des 

</style> I Bindu 

</head> 
I Yogesh A+ 

<body> 
3 Sakshi A 

<table> 

<caption style= color:red> Student Information </caption> 

<tr> 

<th>S. No.</th><th>Name</th><th>Grades</th> 

</tr><tr><td>1</td> <td>Bindu</td><td>A</td> 

</tr><tr> 

<td >2</td> <td >Yogesh</td><td>A+</td> 
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/ 
</tr><tr> 

     

<td>3</td> <td>Sakshk/td><td>A</td> 

</ta ble> 

</body></html> 
) 

Horizontal and Vertical Alignment 

The text-align and vertical-align properties are used to set the horizontal and vertical alignment of the text 
respectively, in a table. These properties are used with the <th> or <td> tag. 

By default, the horizontal alignment for the contents of <th> is center-aligned and for <td> is left-aligned. The 
default value of vertical-alignment is set to middle alignment. 

SYNTAX: text-align: value;
[ 
 HoiizontalAlignment 

where, value= leftfcenterright 

vertical-align: value; VerticalAlignment  j 

where, value= topmiddlejbottom 

Hover 

This property, if enabled, highlights the table cell, row, or column with the specified colour when you hover your 
mouse over it. It is used with the <tr>, <th>, or <td> tag. 

SYNTAX: tr:hover{background-color: cyan} 

Table-it 

This property is used to set the layout for a table. It is used with the <table> tag. 

Syntax: table-layout: value 

where, vaiue:autolfixedlinitial 

Auto: In this, the column width is set equal to the maximum width of the contents in the column. 

Fixed: The column width depends on the table's width and the width of the columns, not on the contents of the 
cells. 

Initial: The default value is used for the column width. 

I	 - 
<html> 

d ead> 

<title>Creating a Table</title> 

<stle type="text/css"> 

bodybackground-coIor:RGB(255,25 1,214)} 

tabie,td,th{border:1 px solid blue} 

table{width:50%} 
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e Lo file:///C:/Users/User/Desktop/layout.html 

Table layout Fixed 

Emp-id Name Basic BRA 

101 Ajav 200O0OO000O 

1 102  Shashi 150OtiIa''S0 

103  lMukesh  13000  2000   

Table layout Auto 

Emp-id Name Basic BRA 
101 Ajay 2000000000000 3000 

102 Shash 150000000000 2800 

103 Mukesh 13000 2000 

th{text-atign:center} 

td{vertical-align:middle} 

tr:hover{background-color:cyan} 

table{table-Iayout:fixed;background- 

color:peachpuff} 

h2{color:red} 

</style></head> 

<body ><table> 

<h2> Table layout Fixed </h2> 

<tr><th width=40%>Emp-id</th><th 

width=30%>Name</th><th width=17%>Basic</th><th 

width=28%>H RA</th> 

</tr><tr> 

<td>1O1</td> <td> 

Ajay</td><td>2000000000000</td><td> 3000</td> 

</tr><tr><td> 

1 02</td><td>Shashi</td><td>1 50000000000</td><td>2800</td> 

</tr><tr><td> 103</td><td>Mukesh</td> <td> 1 3000</td><td>2000</td> 

</tr></table><table style=table-layout:auto> 

<h2> Table layout Auto </h2><tr><th width=40%>Emp-id</th><th width=30%>Name</th><th 

width= 10%> Basic</th><th width=28%>H RA</th> 

</tr><tr><td> 101 </td> <td> Ajay</td><td>2000000000000</td><td> 3000</td> 

</tr><tr><td> 1 02</td ><td >Shashi</td><td> 1 50000000000</td><td>2800</td> 

</tr><tr><td> 1 03</td ><td>M ukesh</td> <td> 1 3000</td><td>2000</td> 

</tr></table> 

</body></html> 

If only one value is specified, it gets applied to both the horizontal as well as vertical spacing. 

Learning 
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Border-spacing 

This property is used to specify the distance between the borders of the adjacent cells. 

SYNTAX: border-spacing: value 

where, value= horizontal spacing in pxlcm  vertical spacing in pxlcm 

Example: border-spacing:lopx- horizontal and vertical spacing set to lopx 

boraer-spacing:lopx 20px- horizontal and vertical spacing set to lOpx and 20px, respectively. 



<html> 

<head> 

<title>Creating a Table</title> 

<style type="text/css"> 

body{background-color:RGB(255,25 1,214)} 

table,td,th{border:lpx solid red} 

table{border-collapse:separate; border-spacing: lOpx 

20px} 

</style></head> 

<body><table> 

<caption><h3> Living vs Non-living </h3> </caption> 

<tr><th style=background-color:Red;color:white> 

Living</th><th style=background-

color:Red;color:white>Non-living</th> 

</tr><tr> 

<td>Consists of cells</td> <td>No cells</td> 

</tr><tr> 

<td>Needs food for energy</td> <td>Needs no 

food</td> 

</tr><tr> 

[i Creating a Table x 

C 0 file:///C:/Users/User/Desktop/pre.html 'A' 

Living vs Non-living 

Living 

Consists of cells 

fNeeds food for energy J 
Shows growth and movement 

Borders separate 

No cells 

Needs no food 

No growth and movement 

Living vs Non-living 
{Borders collapsed 

flying Non-living 
Consists of cells No cells 
Needs food for energy Needs no food 
Shows growth and movement No growth and movement 

<td>Shows growth and movement</td> <td>No growth and movement</td> 

</tr></table><br> 
j9efinition of the 2nd table starts here 

<table style=border-width:1 px;border-style:solid;border-color:blue;border-collapse:collapse> 

<caption><h3> Living vs Non-living </h3></caption> 

<tr><h style=border-color:blue;background-color:cyan>Living</th><th style=border-color:blue;background-

colorcyan>Non-living</th> 

</tr><tr> 

<td style=border-color:blue>Consists of cells</td> 

Border-collapse 

With this property one can specify whether the table borders are to be collapsed into a single border or detached (as 

usual). 

SYNTAX: border-collapse:va!ue 

where, value= separatelcollapse 

Example: border-collapse:collapse 

Computers wfth  KiPs  
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[) Creating a Tab'e X 

C ® fde//ser/Dsktop/New%2Ofo4der/tabIe3.htmI 

Internet ww.w 
Inteniet comprises of computer networks 
connected throu2h wired or wireless 
connections. 

\\•ld wide w-eb is a hvperltnked and 
contumous network of docuinenrs 

Internet ftinctions independent ofworld wide 
web World wide web is a part of Internet. 

Internet ofrs various services, such as email, 
chaning.etc. 

WVb1V is one of the services 
available on the Internet 

Figui'e1:Diffieuce between Inteinet ind \VW\V  

Caption placed at the bottom 

<td style=border-color:blue>No cells</td> 

</tr><tr> 

<td style=border-color:blue>Needs food for energy</td> <td style=border-color:blue>Needs no food</td> 

</tr><tr><td style= border-color:blue>Shows growth and movement</td> <td style=border-color:blue>No 

growth and movement</td> 

</tr></table></body></html> -J 

Caption-side 

it specifies the placement of a table caption. 

SYNTAX: caption-side:value 

where, value= top(default)Ibottom 

Example: caption-side:bottom 

Empty-cells 

This property helps in specifying whether or not the border and background are to be placed around empty cells 
in a table. 

SYNTAX: empty-celis:value 

where, value= show(default)Jhide 

Example: empty-ceils:hide 

<html> 

<head> 

<title>Creating a Table</title> 

<style type="text/css"> body{background-coior:RGB(255,251,214)} 

table,td,th{border:lpx solid red}tabie{border-coliapse:separate;empty-cells:show} 

th,tr,td{padding:3px 5px 5px 3px}</style></head><body ><table> 

<tr><th stylebackground-color:red;color:white>Narne</th><th style=background-color:red;color:white>E-

mail</th></tr><tr><td>Anand</td> <td>anand123@kips.in</td> 
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</tr><tr><td>Radha</td> <td>radhakau1999@kjps.in</td> 

</tr><tr><td>Sheena</td> 

<td></td> 

</tr></table><br><table 

style=empty-cells:hide;border-

color:blue> 

<tr><th style=border-

color:blue;background-

color:cyan>Name</th><th 

style=border-

color:blue;background-

color:cyan>E-maik/th> 

</tr><tr><td style=border-

color:blue>Anand</td> 

<td style=border- 

color:blue>anand123@kips.in< 

/td> 

</tr><tr><td style=border-color:blue>Radha</td> 

<td style=border-color:blue>radhakau1999@kips.in</td> 

</tr><tr><td style=border-color:blue>Sheena</td> <td style=border-color:blue></td> 

</tr></table></body></html> 

— D X 
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C CD file:///C:/Users/User/Desktop/pre.html * 

Name 

Anand 

E-mail 

anandj23kipsm 

Radha radha_kau1999@kipsin 

Sheena 
Border around empty cell 

Name E-mail 

Anand anand_123.kips.üi 

Radha radha_kau1999kips.in 

Sheena 
Empty cell without Border

, 
 

Let's Know More 

You can display different 

elements inside a table. 

For example, we can include 

a paragraph, a list, a table, 

and a simple text inside a 

table. 

<table><tr> <td> 

<p> Include a 

Paragraph</p> 

<p>Good deeds bring 

Good rewards</p> 

<td>This cell contains a 

table: 

<table><tr> 

<td>A</td><td>B</td> 

</tr> <tr><td>c</td> 

<td>D</td></tr> 

</table></td> 

</tr><tr><td>Here comes 

the list <ul> 

<li>Almonds</li> 

<li>cashews</li> 

<li>Raisins</li> 

</ul> </td> <td>A simple 

text</td></tr> </table> 

Height and Width 

Using these properties, you can set the height and width of the table. 

SYNTAX: height:value 

width:value 

where, value= length in pxlcml% 

Example: height: lOOpx 

Width: 25% 

Padding 

This property helps in specifying the space between the border and content in a table. 

SYNTAX: padding: value 

where, value= top paddingright paddingleft paddingbottom padding in 

pxlcml% 

Example: padding:2px 3px 3px 2px- top(2px),right(3px),left(3px),bottom(2px) 

padding:2px 3px 3px  top(2px),right and left(3px), bottom(3px) 

padding:2px 3px  top and bottom(2px), right and left(3px) 

padding:2px  all four paddings of 2px each 

You can make a table cell 

span more than one column 

by using the colspan 

attribute. 

For example: 

<td colspan=2> 

similarly, a table cell can 

span more than one row 

with the help of rowspan 

attribute. 

For example: 
<td rowpan=2> 

Let's Know More 
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<html> 

<head> 

<title>Creating a Table</title> 

<style type="text/css"> 

body{background- 

color: RGB(255,25 1,214)} 

caption{caption-side:bottom} 

table,td,th{border:1 px solid 

magenta} 

— 0 X 
J CreatingaTbIe X 

C 0 file///C:/Users/User/Desktop/padding.htrr 0. * 

State Capital 
J&K Srinagar (Summer) Jammu (Winter) 

Punjab Chandigarh 
Gujrat Gaudhinagar 

Figure: States and their Capitals 

table{border-collapse:collapse;padding:5px;width:1 00%;height:30%;text-

align:center;background-color:RGB(250,223,223)} 

th{color:blue} 

</style></head> 

<body ><table> 

<caption style=color:red> <b>Figure: States and their Capitals</b> </caption> 

<tr><th>State</th><th>Capital </th> 

</tr><tr><td>J&K</td> <td>Srinagar (Summer) 

Jammu (Winter)</td></tr> 

<tr><td>Punjab</td> <td>Chandigarh</td> 

</tr><tr><td>Gujrat</td> <td>Gandhinagar</td> 

</tr></table></body></html> 

)' A list is the most efficient way of presenting information in a precise manner and helps in making important 

points standout more clearly. 

) An unordered list is used when the items are not to be displayed in any particular sequence. 

> The <Ii> tag is used to display the list of items contained in any of the two list types, i.e., unordered and ordered list. 

> The ordered list is used to display the list of items in a specific order. 

) The Reversed attribute of <el> tag specifies that the list order should be in descending order. 

> A nested list is a list inside any other list. 

) A description list consists of a term followed by its definition and is used to present a glossary, list of terms, or 

other name/value lists. 

)' Tables are an attractive way of presenting information in the form of rows and columns. 

Learning 
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Let's Know More 

You can define a special 

style for a particular table 

in an HTML document by 

using an Id attribute of the 

table. 
For example: 

style>table#tl 

{width: 100%; background-  1 
color: lightgrey}</style> 

<body><table 

id= "ti"> 

<tr><th>Prod_id</th> 

<th>Prod_nm</th> 
</tr> 
<tr> 

<td>P001</td> 
<td>Shirt</td> 
</tr></table> 

RECAP  



SECTION - A 

A. Fill in the blanks. 

1.  A  is the most efficient way of presenting information in a precise manner. 

2.  An  list indents each item in the list and adds a bullet against each item. 

3.  The  

in a table. 

property is used to specify the distance between the borders of the adjacent cells 

4.  The  attribute of <ol> tag puts the list in the descending order. 

5.  A  list is used to present a list of definitions for terms. 

HINTS - Description List Unordered Border-spacing - Reversed 

B. State True or False. 

1. An ordered list automatically starts with the number 0. 

2. The List-style-type property specifies the type of list item marker that will be used as a bullet. 

3. The <TR> tag must always be present inside the row tag <TD>. 

4. The tag <DT> is used to define the terms or names. 

5. The default value of empty-cells property is hide. 

C. pplication-based questions. 

1. Manas has created a table and he wants that the table borders should be collapsed into a single border. Which 

property should he use? 

2. Myrah wants to use an image as the list item marker for her list. Which property should she use to complete 

the task? 

SECTION  -  B 

A. Multiple-choice questions. 

1 Unordered lists is also known as list. 

a. bulleted b. numbered c. multilevel 

Learning 
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2. By default, ordered list starts with  

a.A b.1 c.a 

3. With property, you can specify the position of the list-item markers. 

a. List-style-position b. list-style-place c. list-position 

4. In Description list, the tag helps in describing each term or name. 

a. <dl> b. <dd> c. <dn> 

5. The property helps in specifying the placement f  a table caption. 

a. caption-style b. caption-place c. caption-side 

B. Answer the following questions. 

1. Differentiate between <UL> and <OL> tags. 

2. Define the differenttypes of lists supported by HTMLS. 

3. What are tables and which tags are used to create them? 

4. Write short notes on: 

a) List-style-image 

b) List-style 

c) Empty-cells 



0 0 fiIe:///C:/Users/User/Desktop/Netj 

500 pixels. 

> Create 5 columns in the table named as S.No, Name, 

Birthday, E-mail ID, and Phone No. The Caption of 

the table should be My Classmates. Apply heading style 

1 to it. 

For Concept Clarity GROUP DISCUSSION 

Ask the students to create a web page displaying their personal profile, portraying their aim in 

life, hobbies and strengths that make them unique. Use the required HTML tags to beautify 

your web page including Lists and Tables. 

To know more about types of lists and tables in HTML, visit the following sites: 

> wvw.htrnl-5-tutorial.com/ul-ol •tags.htm 

> www.html-5-tutorial.com/table-tag.htrnl  

Looking For More 

LAB SESSION Perfection Through Practice 

Using Creativity 

) Create a web page to display the details of your classmates in tabularformat. 

> Set the background colour of the web page to yellow and the top margin of the web page to 75. 

> Set Table border size to 3 pixels and border colour to 'Green'. 

> Table Height should be 250 pixels and width should be  

) Create five rows in the table and enter records of your 

five classmates. 

) Set the background colour and border colour of the 

heading row to 'Pink' and 'Green', respectively. 

) Set CeilPadding of the table to 5. 

cix 

My Classmates 

S.No. Name Birthday E-mail ID Phone No. 
1 Nttm 12 June nitin'vahoo.*n 2234574 
2 Apoorva 05 May ap_vakips.ui 2115574 

3 Devinder 12 April deviyahoo.ui 2545321 
4 Sakshi 09 March sak_s1iyalioo.üi 2458751 
5  Abhishek  01 Jul  abhikips.in  2995651   

jI Creating a Table x 

Divide the class into two groups and conduct a group discussion on the topic: 

'CSS Properties of Lists'. 



IMAGES, LINKS, & FRAMES 
IN HTML 5 

H  LEARNING IN THIS CHAPTER 
r Inserting images r The Anchor <A> Tag r Images as links 

r The <1MG> Tag r CSS and Links r Audio and video tag 

r Linking web pages r Links as buttons r Frames. border & IFrame 

In the previous chapter you learnt about the various types of lists and their properties. Besides that we also 

discussed how to present data in a tabularformat. In this chapter, you will learn about the other important elements 

of a web page like Images, Anchor element, Links, Frames, etc. 

INSERTING IMAGES 

Besides text, you can display graphics, drawings, paintings, charts, maps, or photographs on a web page. These 

elements make the web page more informative and appealing. Images can be used as a navigational tool to help 

users browse through the internet. Web browsers support various graphic formats. The widely used formats are 

GlF, PNG,andJPEGforrnats. 

There are two types of images: Inline and External image. The inline image is displayed when the web page is opened 

and inserted within a line of text whereas the external images are not displayed automatically with the other 

content on the web page. Instead, they are referenced externally and viewed separately by clicking on a link. To 

insert an inline image, the <img> tag is used. Whereas, to insert an external image, the anchor tag <a> is used that 

establishes a link to the image. 

THE <1MG> TAG 

The <img> tag is used to add images in an HTML webpage. It is an empty tag and requires different attributes to be 

specified with it. These attributes for the <img> tag tell the browser how to lay out the page so that the text can flow 

property around the image. 

DEFINING THE SOURCE OFAN IMAGE 

To add and define the source of an image on a web page, the src attribute is used. 

SYNTAX: <img src="Narne or path of the image file" 

While specifying the image file, one should be well aware of its name and location, i.e., where the file exists. Let us 

understand it with the help of following examples: 

Example 1: If the image file, let us say "picl.jpg", lies in the same folder, where the referring HTML file is located, 

then you can refer the image file by simply writing its name. 

<1mg src= "pici .jpg"> 

Example 2: If the image file "pici .jpg" lies in a directory other than the one in which HTMLfile is placed, then you can 

ref erto the image by specifying full path of the file: 

<1mg src="C:\Users\Mylmages\Pictures\picl.jpg"> 
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Example 3:  If the image file "pici .jpg" does not lie in your computer rather is located in the images folder of the web 

server of Google, then you need to give full path of the file: 

<imgsrc=http://www.google.com/images/picl.jpg> 

SPECIFYING HEIGHT AND WIDTH FOR AN IMAGE 

The HEIGHT attribute specifies height (in pixels) for an image either in the form of an integer or a percentage value. 

The WI DTH attribute specifies width (in pixels) for an image either in the form of an integer or a percentage value. 

          

<html> 

<he 

<titl e> height and width </title> </head> 

<bo 

<im src= "camel.jpg" style= height: 70% ; width: 

50% <p> 

Morphing is a special effect in motion pictures and 

animations that changes (or morphs) one image or 

shape into another through a seamless transition. 

Most often it is used to depict one person turning into 

another through technological means or as part of a 

fantasy or surreal sequence. </p> 

</body> 

ml> 

         

height and width X -- 
C 0 ie:///C/Users/User/Desktop/camei.htm 

     

     

      

 

I 

       

      

Morphing is a special effect in motion pictures ad animations that changes (or niorpha) one 
Image or shape into another through a seamless ansttion. Most often it is used to depict one 
person turning into another through tecminologacal means or as part of a fantasy or suneal 
sequence. 

ALIGNING IMAGE 

To a'ign an image to the right or left of a text, use the CSS property- float. 

Example: <p><img src= " imagi .jpg" style = float:right;width:50px;height:50px> 

Image will appear to the right of the text. </p> 

To align an image to top, bottom, or middle, use the CSS property vertical-align. 

In previous version of HTML, align attribute was used to align the images to left or right. 

ALT ATTRIBUTE 

Sometimes a browser on the user's computer does not display images due to some reasons (may be because of slow 

connection or error in the src attribute). In that case, you can display the text to provide a description about the 

image. The ALT attribute lets you specify the text as an alternate to the image. The only purpose of ALT attribute is to 

provide a description of the contents of an image file. It is generally used in case the user is having a text-based 
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The value for the ALT attribute is a text string of up to 1024 characters, enclosed in quotation marks if you include 

spaces or other punctuation. 

Due to wrong 
value for src attribute 

alternate text is getting 
displayed   

— 0 X 

Cl Image at tep of the scre X 

C 0  file:///C:/Users/User/Desktop/Netwc * 

iimage of the santa hut 

<html> 

<head> 

<title> Image at top of the screen </title> 

<style type="text/css"> 

body{background-color:RG B(255,25 1,214)} 

</style></head> 

<body> Santa Workshop.jpg 4—Correct Source Value 

<p><img src= "Santa Workshop.gif" alt= "image of the 

santa hut" style = float:right;width:200px;height:lsopx> 

<Ip> 

</body> 

</html> 

browser on his computer such as Lynx. It also proves to be useful when the user is a blind surfer for whom the 

browser is programmed to read aloud the alternate text instead of displaying the image. In many cases, people have 

the image display disabled on their browsers or use settings that do not support the automatic loading of images. In 

such cases as well, ALT attribute is used. 

IMAGES IN A TABLE CELL 

You can also insert an image in a table cell. Let us understand it with the help of an example: 

<html> 

<head> 

<title>Creating a Table</title> 

<style type="text/css"> 

body{background-color:RGB(255,251,214)} 

table,td,th{border:1 px solid green;} 

table{border-collapse:separate;} 

td{text-align:center;} 

</style> 

</head> 

<body> 

<center><table> 

    

 

Creiting a T.b. 

C ® fite:///C:/Users/User/Dsktp!2htmI € * 

   

 

Facilities in a school 

 

Learning 
Computers with  KIPS 



<caption><h1>FaciUties in a school</hl></caption> 

<tr><td><img src="playground.jpg" style=width:100%><h3>Big Playground</h3></td> 

<td><img src="library.jpg" style=width: 100%><h3>A Library</h3></td> 

</tr><tr><td colspan=2><img src="school.jpg" style=width:100%><h3>A School</h3></td> 

</tr><tr> 

<td><img src="complab.jpg" style=width:100%><h3>A Computer Lab</h3></td> 

<td><img src=music.jpgu  style=width:100%><h3>A Music Room</h3></td> 

<jtr> 

</table></center> 

</body></html> 

L,INKING WEB PAGES 

A website consists of a number of web pages that give you access to related information. HTML renders a powerful 

feature of linking these web pages together. This feature is called Hyperlinking. Using these hyperlinks, one can 

open any linked web page on the internet in no time. When you hover the mouse pointer over a link, it will turn into a 

little hand. 

TYPES OF LINKING 

> lnternallinking 

External linking 

Internal linking: When one part of a web page is linked to another section on the same page, it is called the internal 

linking. 

External linking: When one page is linked to another web page orwebsite, it is called the external linking. 

THE ANCHOR <A> TAG 

In HTML, the Anchor tag <A>, is used to mark the text as a hyperlink, which a user can click to display the document, 

anchored to it. Being a container tag, it requires closing tag <IA>  to mark the end of the text or image. This tag is 

generally used to specify the following: 

The text or image that is clicked to activate the link 

The address that will be opened using the defined link 

You can use hyperlinks in the following ways: 

1. T9jump from one section to another within the same web page 

2. Tclink to another page within the same website 

3. Tolinkto another page orwebsite anywhere in the world 

HREF ATTRIBUTE 

H REF is an attribute of <A> Anchor tag, which defines the document to which the link leads. 
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THOUGHT OF THE DAY 

Each new day is a new challenge. To stay fresh and alive 
in sprit. there must be change. Find new tactics. methods, 
and modes of operation that are right for today's situation, 
otherwise you will be left behind and eventually be 
forgotten. 

laps TEAM 

Always Remember: 
GOD HELPS THOSE WHO HELP THEMSELVES 

<html> 

<head> 

<title> 

Creating Paragraphs 

</titl e> 

<style type="text/css"> 

body{background-color:RG B(255,251,214)} 

</style> 

</head> 

<body> 

<p style=text-align:center;color:blue> <b> 

THOUGHT OFTHE DAY </b> </p> 

<p style=text-align:justify> Each new day is a new 

challenge. To stayfresh and alive in sprit, there 

must be change. Find new tactics, methods, 

and modes of operation that are right for 

today's situation, otherwise you will be left 

behind and eventually be forgotten. </p> 

<p style=text-align:right;color:red> <b> KI PS TEAM </b> 'zip> 

<p style=text-align:center;color:blue> Always Remember: <br> 

<b> GOD HELPS THOSE WHO H ELPTHEMSELVES </b> 

<Ip> 

</body> 

</html> 

0 
j Creating Paragraphs X 

C D file:///C:/Users/User/Desktop/anchor.l 

Learning 
Computers with  KIPS 

SYNTAX: <a href = "value"> CLICK HERE </a> 

where value = 

> Absolute URL— It points to another website (like <a href="http://www.google.coml  ">) 

> A relative URL — It points to a file within a website (like <a href="Click.html">) 

> Link to an email address(like <a href= "mailto:info@kips.in">) 

In the syntax given above, the text "CLICK HERE" is called Hypertext. Hypertext is a text that contains links to 

information (text, graphics, or media) on the same web page or some other web page. Browser displays this text 

as underlined and coloured. 

Type the following code and save the file with name click.html. 



You can set the style for several link states in a single statement. While doing so, the following rules, regarding the 

order in which the states are to be mentioned, should be kept in mind. 

) a:hover must come after a:link and a:visited 

) a:active must come after a:hover 

<html> 

<head> 

<title> The Link States </title> 

<style type="text/css"> 

body{text-align:center;margin-top:5O} 

a:link{color:red;text-decoration:overline} 

a:visited{color:yellow} 

a:hover{color:purple} 

a:active{color:green} 
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Now type the following program code in a new file and save the file with the name link.html. 

<html> 

<head> Dx 
/ [ Hyeflink Example X 

<title>Hyperlink Example </title> 
CD file///C:/Users/Usec/Desktop/camethtml ®. * 

</head><body> 
CLICK HERE 

<a href = "click.html"> CLICK HERE <Ia> 

</body> 

</html> 

Remember, if the linked HIM L document exists in a different folder, you must specify the complete path and name 

of the folder. 

E CSAND LINKS 

CSS affects the links differently depending on the state they are in. You can divide the link states in four categories: 

> a:link - a normal, unvisited link 

> a:visited - a link the user has visited 

> a:hover - a link when the user moves the mouse over it 

> a:active - an activated link the moment it is clicked 

You can customise these link states by applying different text properties and colours to them. 

Let us use these link states: 



- ° r /1/ /Use/DesktopJcameLhtrr €& * 

IhoLlin of tue day 

CfUsersfUser/..IcIick.html 

— 0 X 

J cainethtml 

<html> 

<head><style type="text/css"> 

a:link, a:visited {background-color: pink; color: white; 

padding: 14px25px; 

text-align: center; 

text-decoration: none; 

display: inline-block;} 

a:hover, a:active {background-color: red;} 

</style></head> 

<body> 

<a href="click.html">Thought of the day</a> 

</body></html> 

Types of Computer 

Mst,..npufrI Mlnlrnmpula Pctwm.Ico.nputrr 

<html> 

<head> 

<title>ADDING IMAGE LlNK</title> 

</head> 

<body> 

<img src= "Types of Computer.jpg"> 

</body> 

</html> 

— 0 X 
/ AflDNGIMAGEU x 

- 0 0 
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(</style> 

</head> 

<body> 

<a href="channeLnationalgeographic.com"><h 1 >This is a 

link</hl ></a> 

</body></html> 

            

The bM 

         

C 0 fkJ/IC Js.r,ius.e'D.skto1n * 

    

       

       

       

This ja link 

  

        

Thisa link 

-I 

            

LINKS AS BU1TONS 

You can also display links as buttons using CSS styling. The following example demonstrates the same. 

E' IMAGES AS LINKS 

An image can also be used as a hyperlink to another document. Let us see an example. Type the following HTML code 

in the file image.html. 



x J 
(- 4 0 C 

Types 
of 

Computer 

Now type the following HTML code and define the link for image.html file. 

( 
<html> 

<head><title>image link</title> 

</head> 

<body> 

<a href = image.html> 

<img sic = "Computerjpg" 

height=95% width=50%> 

<Ia> 

</body> 

</html> 

Note that in the HTML code written above, you must replace Computer.jpg and Types of Computer.jpg with the 

name or path of the images you have in your computer. 

AUDIO AND VIDEO 

Until now, you have discussed various tags, which help us in enhancing the appearance of our web page. In this 

section, you will discuss the tags with which you will be able to incorporate multimedia in our web page and make it 

come alive. Multimedia refers to 'multiple mediums'- the ability to add bits of sound and moving pictures to the web 

page. 

INSERTING AUDIO 

HTMLS defines a new tag-<audio> tag that specifies a standard way to insert an audio file in a web page. It can be 

used for any file format like.mp3, .ogg, .wav, etc. 

The attributes of <audio> tag are given in the following table: 

Attribute 

 

Purpose 

   

src 

 

Specifies the URL of the audio file 

controls 

 

Displays the controls  on the web page 

autoplay 

 

Plays the audio file automatically when the web page is loaded 

loop 

 

Replays the audio file 

( <html> 

<head> 

<title>Adding Audio Clip</title> 

<style type="text/css"> 
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<html> 

<head> 

<title> Video </title> 

<body> 

<hi> A Video Clip </hl> 

<video controls src="C:\Users\User\Desktop\video  1 .mp4' 

width="720" height=" 540" autoplay> 

Your browser does not support the video tag. 

</video> 

</body> 

</html> 

p • • —. 

n -ax 

C 0 

A Video Clip 

[ Adding Audio Clip X 

Purpose Attribute 

src Specifies the URL of the video file 

controls Displays the controls on the web page 

body{background-color:RGB(250,214,229)} 

</style> 

</head> 

<body> 

<h3 style=color:blue> Music gives soul to the 

universe, wings to the mind, flight to the 

imagination, and life to everything. </h3> 

<audio controls 

src="C:\Users\User\Desktop\Kalimba.mp3"> 

Your browser does not support the audio tag. 

</audio></body> 

</html> 

INSERTING VIDEO 

You can insert video files in your HTML pages with the help of Video tag in a similar way. Supported file formats 

include: .mp4, .webm, .ogg, etc. Attribute associated with the <video> tag are given below. 

U -ox 

3 0 fiIe///C:/Users/User/Desktop/2.htmI ® * 

Music gives soul to the universe, wings to the 
mind, flight to the imagination, and life to 
evel)lhing. 

000548  S 

Plays the audio file automatically when the web page is loaded autoplay 

Specifies the height of the video player displayed height 

Specifies the width of the video player displayed width 
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Let's Know More 

 

  

If the browser does not support <audio> and <video> tags, then any text lying 

between <audio> and </audio> and <video> and </video> tags will be displayed in the 

browser as such. 

FRAMES 

You should always specify 
the width and height of an 
image. If width and height 
are not specified, the page 

will flicker at the time of 
image loading. 

 

   

You have seen so far that an HTML document takes up the entire size of a browser 

window. But what if you want to display more than one HTML documents at once in a 

browserwindow? This can be achieved by using the concept of frames in HTML. 

Frames are a way of organising your website. They enable the user to divide a page into a 

number of rectangular segments for different purposes. 

Frames allow multiple HTML documents to be presented as independent windows within 

one browser window. This gives greater flexibility to design and maintain your site than 

simply dumping everything onto one page. Frames make your site interesting as you can 

include the site theme (image, logo, banners, etc.). The navigation menu in frames is not 

to be downloaded each time when you visit a new page, only you have to change the 

contents of the page. 

CREATING FRAME 

In HTML5, frames can be created using <iframe> (Inline Frame) tag. An Inline frame is a 

new HTML document embedded inside the current HTML document. The attributes of 

<iframe> tag are: 

SRC 

With the help of this attribute, you specify the path of the document that should be 

displayed in the inline frame. 

SYNTAX: <iframe src=value> 

where value=path of the document 

HEIGHT& WIDTH 

With these attributes, you can control the size of the inline frames. 

SYNTAX: width=value in pixels 

height=value in pixels 

Let us use the inline frames in our HTML document. 

Type the below given code for the main document. 

<html> 

<head> 

<title>Main Document</title> 

<style type="text/css"> 

Let's Know More l 

By default, a link will appear 
like this (in all browsers): 

> An unvisited link is 
underlined and blue. 

) A visited link is 
underlined and 
purple. 

> An active link is 
underlined and red. 

Let's Know More 

Before HTMLS, audio and 
video files could only be 

played in a browser with a 
plug-in. 

An frame can be used as the 
target frame for a link by 
using the target attribute of 
the link. The target attribute 
must refer to the name 
attribute of the iframe. 
For example: 
<iframe src='testfile.html" 
name=iframe_1'></ifram 
e> 
<a href='http://www. 
google.com"target=iframe 
1'> Google</a> 

Let's Know More 
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I 
body{background-color:yellow} 

</style> 

</head> 

<body> 

<h3> This is the main document containing below given 

inline frames </h3> 

<iframe src="framea.html" 

height=200width=200></iframe> 

<iframe src="frame_b.html" height2OO 

width=200></iframe> 

</body> 

</html> 

 

0 

[ Mai' Document * \\ 

  

           

 

C cD filel//Cz/usersiuw/Desktop/2.htrrd 

  

          

 

This is the inlu document contiliiing below given 
Inline fratiies 

  

 

FRAME A 

 

FRAME B 

 

           

Before creating the above main document, you should first create two files with name 'frame a.html' and 

'frame b.html'. 

BORDERANDIFRAME 

By applying CSS property-Border, you can display an inline frame with or without the border. 

SYNTAX: Border: value for border-width value  for border-style value  for border-color 

You can also apply individual border properties: 

border-width: value 

where value=thin, thick, medium, or a numeric value indicated in pixels. 

border-style : value 

where value can be none, hidden, dotted, dashed, solid, double, groove, ridge, inset, oroutset 

border-color: value 

where value can be the name of the colour or its corresponding hexadecimal code. 

Let us check out an example: 

I 
<html> 

<head> 

<title>Main Document</title> 

<style type="text/css"> 

body{background-color:yellow} 

iframe{border:lOpx dotted purple} 

~~~~~~~~ 
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</style> 

</head><body> 
b 

- 0 X 

c 

<h3> This is the main document containing 

below given inline frames</h3> 

This is the main document 
p.... a u. •a 
a  FRAME A 
a 

containing below given inline frames 

U  FRAME B 
a FRAME C 

<iframe src"frame_a.html" height=200 a 
p 

U 
U 

width=200></iframe> U 
a 

. U U UU• 

U 
a 

<iframe src="frame_b.html" height=200 

width=200 style="border-width:5px;border-

style:solid;border-color:green"><Jiframe> 

<iframe src="frame_c.html" height=200 width=200 style"border:none"></iframe> 

</body> 

</html> 

  

RECAP, 

 

 

  

) Web browsers support various graphic formats but the widely used formats are GI F, PNG, and JPEG formats. 

) There are two types of images: Inline and External image. 

> The inline image is displayed when the web page is opened and inserted within a line of text whereas an 

external image does not get displayed automatically with the other content on the web page. 

> An inline image is inserted using the <img> tag whereas, to insert an external image, the anchor tag <a> is used 

that establishes a link to the image. 

) There are two types of Linking: Internal linking and External linking. 

) When one part of a web page is linked to another section on the same page, it is called the Internal linking while as 

when one page is linked to anotherweb page orwebsite, it is called the External linking. 

> In HTML, the Anchor tag <A>, is used to mark the text as a hyperlink, which a user can click to display the 

document, anchored to it. 

) You can divide link states in four categories: 

a:link — a normal, unvisited link 

a:visited — a link the user has visited 

a:hover — a link when the user moves the mouse over it 

a:active — a link the moment it is clicked 

> You can also display links as buttons using CSS styling. 

) You can insert audio and video files in an HTML document using <audio> and <video> tags, respectively. 

> Frames allow multiple HTML documents to be presented as independent windows within one browser 

window. 
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RAI ft  

SECTION  - A 

A. Fill in the blanks. 

1. Images can be added to the document with the help of tag. 

2. The attribute lets you specify text as an attribute to the image. 

3. .... .  is linking the various web pages together. 

4. When one part of a web page is linked to another section of the same page, it is called linking. 

5. allow multiple HTML documents to be presented as independent windows within 

one browserwindow. 

6. Groove is one of the possible values for the CSS property  

      

 

HINTS Hyperlinking 

  

border-style Alt Frames <img> 

  

Internal 

   

B. State True or False. 

1. You cannot display photographs on a web page. 

2. <H> is used to mark the text as a hypertext link. 

3. The value forthe alt attribute is a text string of 2000 characters. 

4. Any image can be used as a hyperlink to another document. 

5. You can insert an audio clip or file of any format like .mp3, .ogg, .wav, etc. in our web page with the 

help of the audio tag. 

6. In HTML5, frames can be created using <iframe>. 

C. Application-based questions. 

1. Asmita has added few images in her web page but she wants to keep some provision for visually impaired 

people or users using text-based browsers so that they get the description for the images. Which attribute 

should she use to accomplish the task? 

2. Vikram is creating a website in which he wants to use different images as links to the webpages. He is also 

interested in adding some video clips in his website. Can you suggest him the required tags to include the above 

said elements in his website? 



SECTION  -  B 

A. Multiple-choice questions. 

1   attribute of <A> tag defines the document to which the link leads. 

a. href b. src c. ref 

2. A URL points to a file within a website. 

a. Absolute b. Relative c. Internal 

3. Which of the following specifies the colour of a link when it is clicked? 

a. Visited b. Hover c. Active 

4. attribute of <audio> tag plays the audio file automatically when the web page is loaded. 

a. Start b. Autoplay c. Auto 

5. .webm is one of the supported file formats for  file. 

a. Audio b. Video c. Frame 

6. allow multiple HTML documents to be presented as independent windows within one 

browser window. 

a. Windows b. Screens c. Frames 

B. Answerthefollowingquestions. 

1. How images are added in an HTML document? What are the different attributes of an image element? 

2. What is the importance of associating alternate text with an image? 

3. How can you link webpages in HTML? What are the different types of linking? 
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4. With the help of code, explain how audio and video clips can be added in an HTML document. 

5. Explainhowframesareuseful. 

C. Answer in one word. 

1. The tag that inserts an inline image on the web page. 

2. The attribute of <1mg> tag that specifies the text as an alternate to the image. 

3. The tag that marks the text as a hyperlink. 

4. The attribute of <a> tagthat defines the document to which the link leads. 

5. The attribute of <video> tag that plays the video file automatically. 

6. The CSS property that renders the inline frame borderless. 

     

 

Perfection Through Practice LAB SESSION 

 

Write the HTML code to generate the following web page. (Use relevant tags and CSS properties) 

I STRU CT! S 

) Set the heading of the page as "Save the Earth". It should be in 'Anal' font and bold with size 6 and colour 

Yellow. 

) The background colour of the page should be "Green". 
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SAVE THE EARTH 
NGO group dedicated to saving the Earths natural environment 

Home 
Flag 
Controlling 

I. Pollution 
2. Dckrestatin 
3. Poaching 

• Saving 
I. Forests 
2. Endangered Species 

> The subheading should be in "Verdana" font, bold, 

size 4 and colour Orange. 

> The rest of the text should be in "Times New 

Roman" font, size 4 and colour White and Yellow. 

> Select and place a suitable image on the web page. 

> Use nested list for the links (as shown in the 

schreenshot). 

> The pages linked with this page are asfollows: 

Home Home.htm 

FAQs Faq.htm 

Pollution Poll.htm 

Deforestation Deforest.htm 

Poaching Poach.htm 

Forests Forest.htm 

Endangered Species Species.htm 

> The categories 'Controlling' and 'Saving' in the unordered list are not linked to any page. 

  

GROUP DISCUSSION For Concept Clarity 

  

Conduct a group discussion on the topic:  Link, its states, and the associated CSS properties 

ONLINE LINKS 
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PROJECT WORK Using Creativity 

 

Ask the students to create an HTML document on the topic  CSS TEXT v/s  CSS FONTS. The web 

page should contain two frames wherein one frame will display Text properties and the other 

Font properties. Use unordered list to display the properties in each frame. 

To know more about Images and Frames, visit the following sites: 

> www.htm15-tutoriak.org/htm!-basics/images/  

> www.quackit.com/htrnl5/tags/htmliframetag.cfm  

Looking For More 



APP DEVELOPMENT 

LEARNING IN THIS CHAPTER  1 
P  Introduction to apps r  Downloading and installing an app from 

r  Types of apps Google Play Store 

' Classfication of mobile apps Developing your own app 

Uses of common apps How to install Appy Pie app on your mobile 

INTRODUCTION TO APPS 

The word "app" is an abbreviation for application. An application is a software designed to do a specific job. An app 

enables you to do something specific like paint, draw, read maps, and barcodes, take photographs, play games, 

watch and edit videos, and a host of other activities, but within the technical limitations of your device. However, 

with the rapid rise in the use of smartphones these days, the word 'app' is mostly used to refer to the software that 

runs on mobile phones. 

Since smartphones, tablets, and othermobile devices are nothing but small computers, an app works in pretty much 

the same way as the software does on a desktop or laptop. Since the computing power and memory of a 

smartphone are generally less than that of a standalone computer, the capabilities of the app are generally less than 

that of a similar software running on a PC. Most desktops do not have touchscreens capabilities, while all mobile 

devices have touchscreens. This changes the way the user interacts with the device. Instead of a keyboard and 

mouse, the user taps on the display, which works both as an input device as well as output device. 

Apps are designed to work on different 

operating systems used by the various 

devices. An Android app is developed to work 

on phones and tablets that run on Android 

OS, whereas iPhone apps can be used on 

iPhones that use iOS. For better running of 

apps, the internet connection speed must be 

fast so that the app can be downloaded easily 

from the Google Play Store on Android phone 

orthrough App Store on iOS. 

TYPES OFAPPS 

Apps can be broadly classified as Desktop apps, Web apps, or Mobile apps. 

DESKTOP APPS 

These apps can be used on a desktop or laptop. Generally, they do not need web access and run independently on a 

computer. To run a desktop app, it must first be installed on the desktop or laptop. The installed app is represented 

either by an icon on the computer screen or item on the Start menu. Examples of desktop applications are Word 

Processors, Spreadsheet, or even smaller apps like Paint or Notepad. 
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WEB APPS 

These apps require an internet connection. They are usually browser-based and stored on a remote server. 

Users access them like any other webpage and then install them on their computer by creating a bookmark to that 

page. Web applications require minimum device memory as the application lies on the remote server. These 

applications can be utilised at whatever point needed from any device through the Internet. For example, Google 

Maps, Instant messenger, etc. 

MOBILE APPS 

These apps run on a smartphone or tablet. Mobile apps have responsive web designs to adapt to the much smaller 

screen sizes and orientation of the mobile devices. These apps are usually smaller in size as mobile devices have 

limited memory. Some mobile apps may come preloaded on cell phones ortablets. 

Keeping in view the device independence feature, software companies nowadays make diverse versions of the 

applications to be used as Desktop apps, Web apps, or Mobile apps. 

Look at the examples given below: 

Mobile A 

Photo 

Editing 

Photoshop from Adobe is a 

photo editing software, which 

must be installed on a desktop 

or laptop. 

Pixir is a free photo editing tool 

for desktop. 

Pixir also provides photo editing 

software as a web application 

available at 

https://pixlr.corn  /\veh 

Sumo Paint is another web based 

photo editing application at 
https://www.sumopaint.com/ paint! 

Adobe Photoshop Express and 

Mobile Pixlr are photo editing 

apps for mobile devices, which 

can be downloaded from either 

the Google Play Store or Apple's 

App Store. 

Facebook Facebook has no desktop 

application as it cannot be used 

without being connected to the 

Facebook site. 

Facebook initially began as a Web 

based app. Posting messages or 

videos require you to be 

connected to the internet. 

Facebook is available as a 

separate app. which can be 

downloaded from the Google 

Play Store, the App Store, and 

the likes. 

Office 

Suites 

MS Office is a very good 

example of desktop-based 

Office applications. This includes 

Word processing, Spreadsheet, 

and Presentation apps. 

Microsoft allows the users to use 

their Web-based Office 

applications. Google Docs is an 

Office Suite, which does not have 

any desktop equivalent. 

Microsoft Office Mobile and 

Google Docs allow a user to 

work on Office applications as 

apps. 

Kingsoft and Polaris also have 

mobile apps for Office use. 

Games 

L 

Games like Solitaire and 

Minesweeper are available on 

all Windows-based computers. 

Other games too can be 

downloaded for use on 

desktops and laptops. 

Desktop games can also be 

played online. The advantage of 

Web-based games is that they 

can be easily made Multiplayer. 

These games are also available 

as mobile apps. 

Learning 



Media 

Players 

Maps 

Media player apps enable the 

users to play music or videos 

on their computers. VLC Player 

and Windows Media Player 

are some of the examples of 

freely available Media Players. 

Many sites offer their services 

which allow you to play music, 

videos, listen to the radio, and 

even watch TV while online. 

You are also allowed the access 

to the content of these Web-

based applications. 

Media players are now 

included as a standard app on 

all smartphones. 

Besides Windows Media 

Player and VLC Player, other 

players are also available. All 

allow you to play your own 

media. Some even support 

search and download feature. 

Google maps can be 

downloaded on the desktop 

computer. However, this app 

will only function when the 

Internet access is available. 

The browser based Google 

maps can be accessed by typing 

maps.google.com  in the 

address bar of the browser. 

The Google maps app is 

available in the Google Play 

Store. 

C!ASSIF!CATION OF MOBILE APPS 

Mobile apps can be further classified as Native Apps or Hybrid Apps. 

NATIVE APPS 

Mobile apps are usually developed for a specific Operating System and device. This is because each device may have 

different specifications like GPS, dual SIMs or cameras, memory, Bluetooth, Wireless Fidelity (WiFi), or Near-Field 

Communication (NFC). Apps that are developed keeping the device specifications in mind are known as Native 

Apps. Most Native Apps come pre-installed on the new phone, and can also be downloaded from the Play Store or 

APP Store and further installed on the device. Some Native Apps can run on the device without the use of the 

internet, but others may need the internet facility forfulifunctionality. These apps have certain limitations. They are 

designed fora particular platform and expensive to develop and maintain. 

HYBRID APPS 

Hybrid Apps contain the features of both Web Apps and Native Apps. These apps can be downloaded from the 

PlayStore or APP Store and installed on the device. These apps require the device to be connected to the internet. 

Hybrid apps can be stored partly on the local device and partly on the remote server. Some hybrid apps can be 

operated offline also by using cached pages, however, they have limited functionality offline. 

For example, the most popular gaming app, Candy Crush is a hybrid app that can be played on a mobile phone as well 

as the web. 

USES OF COMMON APPS 

Apps have become so prevalent today that a suitable one can be found for almost any job. Whether it is for learning, 

entertainment, social interactions, oreven banking and e-commerce, there is an app for every purpose. 

Learning 
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Let's Know More 

zomato 

Zomato is a mobile app 
that lets you discover 

restaurants to eat-out at 
or order-in from. It 

provides information and 
reviews on restaurants, 

hotels, and food joints. 
You can also rate and 

review restaurants you 

have been to and share 
photos of your foodie 

moments, directly from 

the app. 

4. 

KHAN 
ACADEMY 

Candy Crush 
In this game the players 

complete levels by 
swapping coloured 

pieces of candy on a 
game board to make a 

match of three or more 
of the same colour, 

eliminating and replacing 

those candies with new 
ones, which could 

potentially create further 

matches. 

EDUCATIONAL APPS 

With the rapid increase of mobile technology, learning with apps has become fun. There 

is a rapid spread of education to the remotest corners of the world. Today, students in 

the far-flung villages can easily access high quality educational resources. 

There are apps for all levels of learning. 

Apps not only help us to learn new 

concepts, but also show us what is 

being taught in the classrooms. 

Students of all age groups can access a 

treasure chest of information on any 

topic. 

Educational apps are equally useful for 

both students and teachers. The 

teachers are able to distribute study 

material quickly, conduct tests, and 

grade the students efficiently by using 

apps like Google Classroom, Kahoot, etc. 

Parents too make use of the educational apps to interact more closely with the teachers 

and thus monitor the progress of their children. 

In keeping with this trend, many online study resources like Khan Academy, Byjus 

(Learning App) as well as online study platforms like EdX and Coursera are now available 

via apps. 

SOCIAL NETWORKING 

Let's Know More 

In a world that is increasingly social and open, social media plays a significant role in 

communication. These social media apps let you post images, videos, and other updates 
Let's Know More 

to your profile, which can be shared with 

anyone. You can connect with anyone 

across the globe easily via such apps. 

There are several types of social 

networking apps available today. Some of 

the most popular social networking apps 

are as follows: 

saavn 

It is one of the most famous 

online music apps. One can 
find his favourite songs, 

download them, listen to 
his favourite artists, make 
and share playlists, play 
radio or online music for 
any mood, song, or artist 

through this app. 

Learning 
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WhatsApp 

With over 1.5 billion active users, WhatsApp is one of the most popular instant messaging app, 

worldwide. Although initially started as a text messaging app, WhatsApp has rapidly grown 

and now offers high quality voice as well as video calling. It has a simple interface and many 

useful features that make it a very popular app. 

Facebook 

Facebook, with nearly 2.23 billion active users, continues to lead the social networking sites. It 

allows all the registered users to create their profile, post comments, exchange information, share 

links, photographs, chat, play games, etc. While initially, it was PC based, Facebook is now available 

as a pre-insta lIed app on most of the mobile phones and tablets. 

Twitter 

Twitter is a social networking app where people communicate in short messages called tweets. 

Tweeting is sending short messages to anyone who follows you on Twitter, with the expectation 

that your messages are useful and interesting to someone in your audience. 

Messages sent with this app were initially restricted to 140 characters. However, with the 

advent of smartphones, the users began to find this as an unnecessary hindrance, therefore, 

Twitter has now doubled this limit, i.e., the users now get 280 characters per tweet. 

Other social networking apps 

Instagram is another app that is used for social networking. This app specialises in sharing of photographs by the 

users. 

Linkedin is a networking app that specialises in the sharing of business and professional information. 

Reddit is a social news aggregation app. Registered users can upload news, stories, or links, and other users can rate 

these stories by voting them up or down. The stories with the most up-votes are moved to the top of the category. 

     

 

in 

   

  

a reddil 
Instagram 

 

Unkedin 

  

Reddt 

   

   

ENTERTAINMENT A P PS 

Looking for some entertainment? If you have a smartphone, you will find a lot of entertainment 

apps on it. While many of these apps are free to use, some charge a fee for their premium services. 

If you wish to watch a movie, catch up on your favourite TV serial, or watch some sports, you can 

install and use Hotstar. 

hotstar 

Hotstar App 

Are you a music lover? Gaana, Hungama Music, and several other apps bring your favourite tunes right 

to your device. Other apps are also available that allow a userto record and edit one's own music. 

Do you fancy watching the latest blockbuster at your favorite multiplex? The BookMyShow app 

allows you to check timings, read reviews, and obtain tickets for plays, concerts, sports, and many 

Gaana App other events. 
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Computers with  IPS 

D 



HUFC Øanldng App $81 B.n1ng App 

Banking Apps 

BookMyShow App 

D'°  44 68u 1432$Pu 

- Jca'onaJ apps to, 8th std 

Aps 

Eotinka - The LeaQ A.p 
• j.. P. 

Ml 
31&48 4?. 

BVJS-Th5LesiV*p 

I 
urn. 0 witoce 

Figure 10.2: 
Searching for an App 

Figure 1O1:The Play Store 
Icon on Mobile Phone 

If you are a game lover, you can enjoy many Gaming apps. These apps have a huge fan base 

from all the age groups. There are various categories in these apps like Sports, Strategy 

games, Action games, Racing games, Fighting games, etc. 

BAN KING AND FINANCE 

Almost all banks have their own apps today. While banks 

have had an online presence for quite some time, now these apps allow quick and 

easy access to most of their services and products. One can check the balance in his 

account, open fixed deposits (FDs), pay utility bills, transfer money to another 

account, order a chequebook or a Demand Draft, and many other activities. 

With the Indian Government encouraging the use of cashless transactions, 

digital wallet apps like Paytm, Pockets from ICICI bank, Buddy from SW, and 

many more similar apps allow the users to make quick and easy monetary 

transactions. 

Moneycontro I 

E-COMMERCE 

Buying or selling of goods or services, using electronic means, is known as E-Commerce. The rapid increase in 

the use of mobile technology and the desire of people to get things done quickly has prompted e-commerce 

companies to opt for mobile apps to supplement their business. This segment has become so important that 

some e-commerce companies have started giving preference to app-based solutions and are discontinuing 

their e-commerce websites. Some of the most popular e-commerce apps that provide facility to shop online are 

Flipkart, Amazon, Snapdeal, and Shopclues. 

DOWNLOADING AND INSTALLING AN APP FROM GOOGLE PLAY STORE 

To download and install an app from Google Play Store, follow the steps given below: 

Tap on the Play Store icon on the screen of your device. 

Moneycontrol 

For the latest information on the Global and Indian stock markets, Moneycontrol app proves to be 

beneficial. It covers the Bombay Stock Exchange (BSE), National Stock Exchange (NSE) and also 

mutual funds, commodity, and currency markets. Using their Portfolio tracker, one can keep in touch 

with the swings of the market and take appropriate and timely decisions. 

p 
ICICt Pockets SBI Buddy Paytm 

Digital Wallet Apps 

PaYtm 

Type the name of the app in the Search bar that you 

wish to download. If you do not know the specific 

name, type a general description of the job that the 

app does. For example, "educational apps for 8th std 

science". 

> It will display the relevant list of apps. Now, select the 

most suitable one by tapping on the name of the app, 

forexample, 'BYJU'S'. 

Learning 
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Figure 10,4: Requirements for making an App 

Additional information about this app will be displayed including whether any fees 

need to be paid. Check out the reviews and comments of the previous users. If it meets 

your requirements, tap the INSTALL button to install the app on your device. The app 

will request you for permission to access specific information from your phone. 

Confirm your consent, and the app will be downloaded and installed on your phone. 

The app is now ready to use. 

BY.JUS - The Learning 
App 

a.E_c., flWf... 

4.7 * U 
,.'-., ' .d'o. . 0 Oe.. 

Figure 10.3: 
Installing the App 

DEVELOPING YOUR OWN APP 

Looking at the different apps available at Play Store is an amazing experience, but it may give you the impression 

that it is very difficult to make your own app, but it is not so. There are several sites that allow you to make your own 

app in a very short time. 

REQUIREMENTS FOR DEVELOPMENT OF APPS 

Here we will discuss the Android apps, but developing apps for the other platforms will also have similar 

requirements. If you want to build an app from scratch and have 

control over the design, a sound background in programming 

will be very helpful. To make an Android app, software such as 

Android Software Development Kit (Android SDK) is required. 

Knowledge of Java is needed since most Application 

Programming Interfaces (APIs) use Java. You may also need to 

learn Extensible Markup Language (XML), HTML, and CSS for 

designing an app. 

Several Integrated Development Environment (IDEs) are 

available that greatly simplify the process of an Android App 

  

Development. The Android Studio from 

Google is one such example, while 

Eclipse is another. Many IDEs come with 

their emulators to preview the working 

of your app, but the final testing of the 

app should be done on different mobile 

devices. 

Android 
/ Stucic vs 

   

Figure 10.5: Popular IDEs for App Development 

Is it possible to develop a simple app without prior knowledge of programming? The answer is yes. Many companies 

offer a user-friendly interface to develop Android apps without any prior knowledge of programming. Some of 

these companies offer free services that may be limited in usefulness, while others offer premium services, but for a 

fee. There are two ways to develop an app. 

> An Android app can be developed using Web based app development software. Some of the websites that offer 

their app-builders are Apps Bar at http://www.appsbar.com/,  Appy Pie at https://www.appypie.com/,  App Yet at 

http://www.appyet.com/,  and AppMakrat https://www.appmakr.com/. Many of these sites also off erthe use of 

theirApp Stores to promote yourapp. 
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Under the Suggested tab, you will find only those pages that are relevant to the category you have chosen. 
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> Use an App-builder and make your own app on your smart phone. As discussed earlier, you can find apps for 

almost every need. 

> Tap on the Google Play Store icon. The Search box will be displayed along with the apps that are downloaded 

most often. 

Type "free app builder" in the Search box and click on the Search button. Several app-builder apps will be 

listed. 

Let us use Appy Pie to make a Quiz App in it. Appy Pie is a web-based app maker; providing various facilities for 

quickly making your own app. In addition to the basic pages and information for a simple app, Appy Pie also allows 

you to add pages, forms, social media links, login pages, and much more. Ready-made templates for applications 

rangingfrom business, social, messengers, taxi services, restaurants, educational, hotels, etc., make designing your 

app very easy. Follow the given steps to make yourfirst app using the Appy Pie website: 

1. In the address bar of the browser, type https://www.appypie.com/.  

Click on the Get Started button. 

2. Give an appropriate name for your app, for example, Quiz, click on 

the Next button. 

3. Now, select a category from the options given below. For example, 

Education. To view more categories, click on the View more 

categories option. Click on the Next button. 

4. Choose a suitable design for your app from the various enlisted 

options. Let us say, Matrix. Click on the Next button. 

5. You can see a preview of your work at any time on the right-side 

of the window or by clicking on any Preview icon, for example, 

Android. 

6. Now, add pages into your app as desired. Under the Suggested 

tab, click on Quiz to insert a quiz page. Unwanted Pages can be 

deleted here. Figure 10.9 Selecting a Design 
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Figure 10.13: Selecting the Editor Option 
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7. Under the Content section on the Quiz page, click on the Add 

Question tab to add or edit questions. The Quiz window will be 

displayed. 

8. Under the Action section, click on the Manage Quiz Questions 

iconU  . The Add/Edit Questions (Quiz) window will be displayed. 

9. Add questions and answers. If you wish you can provide multiple 
Selecting the Manage Quiz Question 

options for each question using the Add Answer button. Put a 

tickmark in the check box to the right side of the correct answer. You can add an image, an audio, or a video also 

to the individual questions. 

10. Proceed to add more questions to your quiz. 

Click on Save, once you have added all the 

questions. 

11. Click on the Quiz Settings icon  J  on the quiz 

window to control the way the quiz operates. 

Under this tab, you can control whether the 

quiz will generate random questions, the 

minimum passing score, time limit for the quiz, 

etc. Click on the Save button when you are 

done. Close the Quiz window. 

Figure 10.11: Add/Edit Questions (Quiz) Dialog box 

 

Now, continue the process by clicking on the Save & Continue 

button. 

You now have to Login or Sign up, if you have not done so far. 

Next step requires you to choose the plan for your app. To choose 

a free plan, move the cursor towards the Address bar of the 

window. A pop-up will appear. Click on the Start FREE Plan Now 

button. 

14. A Congratulations window will be displayed. 

MyApps 15. Now, click on the drop-down arrow adjacent to 

the Welcome tab, displayed on the extreme 

top right corner of the window. Select My 

Apps> Editor option. 

16. Select the Design Customization tab. Here, you 

can choose an icon for your app by selecting 

the App Logo thumbnail. Choose any icon from 

the available list or you may use the Upload 

App Icon option to upload your own icon. 



- 

© 

'-, 

 

Fact File 

Flipkart is a popular 
e-commerce company 

headquartered r 
Bangaluru. It was 

founded in 200] by 
Sachin Bansal and Binny 
Bansal. There are over 
100 million registered 

of Flipkart in India. 

Figure 10.14:  Selecting the Background 
and Splash Screen 

0 18. Click on the Save & Continue tab 
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Figure 10.17: Selecting the Click to Download Tab 

22. Download your application by 

clicking on the given link or 

scanning the QR code. 

23. Now, select any one of the three 

options shown in Figure 10.18 and 

proceed to download the selected 

version of your app. 

OuApp 

.u:c (- - 

UDU 

Let's Know More 

8HIMP 
Bharat Interface for 

Money (SHIM) is an 

android application that 

enables fast, secure, and 

reliable cashless 

payments through your 

mobile phone. The app is 

directly linked to the 

user's bank account. It 

was developed by 

National Payments 

Corporation of India 

(NPCI) and launched by 

the Prime Minister of 

India, 

Mr. Narendra Modi, on 

30 December 2016. 

Figure 10.18: Selecting the OS to Download or Publish the App 
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17. Click on the Choose Background 

thumbnail and choose any screen of 

your choice. Similarly, splash screen of 

the app can also be customised as per 

your choice by selecting any option 

from the Choose Splash thumbnail. 

You, uro wfl be scaWd for off 

su000rted deiCOs 
when done. 

19. You can now proceed to build your 
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app. Click on the Continue to My 

Appstab. 
Figure 10.15:  Uploading an Icon 

20. Select the Test App icon under the My 

Apps secton. 

21. Your app starts getting built. A message 

appears as shown in Figure 10.16. It may take Figure 10.16: 

a few minutes for the app to get ready for 
'App is Getting Built Massage Box' 

download. Appy Pie mails you the download link when the app is ready. 
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HOW TO INSTALL APPY PIE APP ON YOUR MOBILE 

) The simple way to install yourapp is to send the app to your e-mail id. 

) Click on the Email icon  Q  as shown in Figure 10.17. Enter your e-mail id and click on the Send button. 

) You wiliget a mail on your e-mail Id from Appypie. 

> Open the mail on your mobile phone and click on the given link. 

> You will get the instructions for downloading and installing the app. 

> Click on the Launch button. This will download the app on your device. 

> When the download gets completed, tap the Install button to install the app on your device. 

> Now,opentheinstalledapp. 

Before you install the app, make sure that the Unknown Sources box is checked to allow the installation of 

non-market application. 

RECAP 
> The word app is an abbreviation for application. The software designed to do a specific job is known as an 

Application. 

> Apps are broadly classified into three categories: Desktop apps, Web apps, and Mobile apps. 

) Mobile apps are usually developed fora specific operating system and device. 

> Hybrid Apps combine the features of Web apps and Native apps. 

> Buying or selling of goods orservices using electronic means is known as e-commerce. 

> Appy Pie is a web-based app that facilitates in making customised apps quickly. 

PS Computers with  
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SECTION - A 

A. Fill in the blanks. 

1. combine features of both Web apps and Native pps. 

2. The abbreviation of the word 'application' is  

3. Before installing an app on our device, the manufacturer of the app will ask for certain  

4. The Facebook app is an example of a app. 

5. The e-commerce app that was founded by Sachin Bansal and Binny Bansal is —. 

6. apps do not need web access and run independently on a computer. 

7. You can pay utility bills using a app. 

HINTS App Permissions Flipkart Hybrid Apps Desktop Banking Social Networking 

 

!3. State True or False. 

1. Google Maps is an e-commerce website. 

2. SDK stands for Software Design Kit. 

3. Hungama Music app brings your favourite tunes right to your device. 

4. Mobile apps are usually smaller in size as mobile devices have limited memory. 

5. Install SBI Buddy on your mobile device for the latest information on the global and Indian markets. 

C. Application-based questions. 

1. Sneha and her parents are planning to go for a movie. She wants to book the tickets online. Which app can she 

use to do the same? 

2. Mannat had a school trip last month where she clicked various photographs. Now, she wants to share these 

photographs with her friends. Which app should she use? 
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SECTION - B 

D. Multiple-choice questions. 

1. Reddit is a social networking site that is also called a app. 

2.  

a. News Aggregator b. Banking 

is an app that lets you build your own apps. 

b. Reddit 

c. Video sharing 

a. NFCApp c. Appy Pie 

3. Some app-builder apps let you build your own apps without the thorough knowledge of  

a.OS b. Programming Language c. Both of these 

4. Hotstarisan app. 

a. Education b. Entertainment c. Social Networking 

5. Buying or selling goods or services using electronic means is known as  

a. Money control b. Finance c. E-Commerce 

E. Answerthefollowingquestions. 

1. How can you broadly categorise the apps? Explain any one category of apps. 

2. What are the requirements for developing an app by scratch? 

3. What is the difference between Hybrid apps and Native apps? 

4. Distinguish between a Desktop app and a Mobile app. 



 

LAB SESSION Perfection Through Practice 

  

Create a Mobile app 'Go Goa' for mobile phones, which will provide information about the tourist 

destination 'Goa'. 

> Open the site https://www.appypie.com/. The home page of the Appy Pie app builder site opens. Click on 

the Get Started button. 

> inter the App name (e.g., GO GOA) and dick on the Next button. Now, choose the Travel category from the 

ist of displayed options. Click on Next. 

>.  :0110w the same procedure as discussed in the chapter and then select any Design from the displayed list 

ncludingfonts. colours, and sizes of various components of pages that you have designed. Click on Next. 

Learning 
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5. How can you download and install an app from the Google Play Store? 

6. Explain the importance of Educationai Apps. Give an example to support your answer. 

7. With the help of suitable examples, explain the Photo editing tasks that can be done using Desktop, Web, or 

Mobile Apps. 



50GW4.O CAIANGUTE 

MIRAMAR CANC)OLI. 

ONLINE LINK F 

> Choose the Design Customization tab. A new screen appears. 

> Now, choose the App Logo, Background, and Splash screen one after another. 

> Click on the My Features tab. Add other pages to your app that are more suitable 

for a travel app. For example, Map. 

> Provide the mailing address of the place that you want to show on the map or 

enterthe Latitude & Longitude of the place. 

> The map of the place of interest will be displayed. Click on Add More to have 

additional maps in your app. 

> Once you have added all the maps, click on the Add Feature button. 

) Click on the Suggested tab that will suggest the pages appropriate for the 

category you have chosen. 

> Here, you can select Events, Folder, etc., for the app by clicking on the respective 

tabs, let us say, you select the Folder tab. 

> Change the name and folder icon by clicking on them, respectively. 

> Websites can be added as pages which will be placed in the folder that has just been made. Icons for the 

pages that you add can either be used from the gallery that Appy Pie provides or can upload your own icons 

and images. 

> Click on the Add Feature button and from the Information tab, select the Website option. A website page 

will be added to the app. Give a name to the website (e.g., Calangute Beach, Goa) and the URL where the 

information will be linked to, (e.g., https://en.wikipedia.org/wiki/Calangute).  

> Additional websites can be added and customised as required. You can also provide information about 

restaurants, tourists spots, etc., by clicking on the Add More button. 

> Click on the Save & Continue tab when you are done. 

) Sign in your account. Choose the Free Plan. 

> You will get a welcome message and can now click on the Continue to MyApps button to check the app that 

you have just created. 

> Now, click on the Test App option. If it is okay, you can download the .apk file. 

GROUP DISCUSSION For Concept Clarity 

 

Conduct a group discussion on the topic: "Various  types of Apps". 

  

Looking For More 

To know more about App Development, visit the following websites: 

) Iittps://en.wikipedia.org/wiki/Mobile  app development 

> https://developer.android.corn/training/basics/firstapp/  
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Chapters 6-10  I- 

A. Fill in the blanks. 

1. When one part ofa web page islinked to anothersection of the same page, it is called linking. 

2. determines how closelythe colours should be matched for sampling. 

3. In the mode of Python, the processor executes statements one by one. 

4. The function is used to display user-defined messages on the screen. 

S. Every ioop works with the help of a variable known as the  

6. The  loop can be applied to a program where the number of iterations is not known 

beforehand. 

7. The apps are usually smaller in size as mobile devices have limited memory. 

HINTS 

 

Tolerance print() Internal Interactive Control variable while Mobile 

  

  

B. State True or False. 

1. A comma operator is used to print the next value aftera tab space in Python. 

2. The in operator is used to check if a given value exists in the sequence or not. 

3. It is not necessary to use print() statement in IDLE environment. 

4. The condition statement checks whether the loop body will be further executed or not. 

5. The 'else' part is executed if the 'for' block terminates normally. 

6. You do not require any prior knowledge of programming for developing Android apps by scratch. 

7. Google maps cannot be downloaded on the desktop computer. 

C. Give an example for each of the following. 

1. Social Networking Site: 

2. Entertainment App: 

3. Micro-blogging Site: 

4. Global and Indian stock marketsApp: 

5. EcommerceApp: 

6. Cashless payments App: 

putrsKIP69  
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WORKSHEET 
Chapters 6-10 

A. Multiple-choice questions. 

1. A URL points to a file within a web site. 

a. absolute b. relative c. internal 

2. Which of the following is a valid variable name  

a.StuName b.25Bday c.b80k 

3. If the condition in a loop is false in the first step, you get  

a. No output b. Infinite c. Error 

4. Buying or selling goods or services using electronic means is known as  

a. Money control b. Finance c. E-Commerce 

B. Answer in one word. 

1. The other name for iterative statements. 

2. The mode of programming used for writing large programs. 

3. Name the list used to display the list of items in a specific order. 

4. Name an app used to pay the utility bills. 

5. Name the tag in HTMLthat is used to mark the text as a hyperlink. 

C. Answerthefollowingquestions. 

1. What is the difference between Hybrid apps and Native apps? 

2. What is the importance of associating alternate text with an image? 

3. What is the difference between interactive and script mode? 

4. What do you mean by iterative statements? Name them. 



S ACCESS 

) Create a database named 'Information System'. 

) Create a table in it consisting of the following fields: 

S.No. Field Name Data Type 

1 RedO Auto Number 

2 Name Text 

3 Relationship Text 

4 Address Text 

5 City Text 

6 State Text 

7 PIN Number 

8 Home_Phone Number 

9 Office_Phone Number 

10 Mobile Number 

11 Date_of_Birth Date/Time 

12 Anniversary Date/lime 

13 E-mail_ID Text 

) Save the table with the name 'Info Sys'. 

) Collect all the information of your relatives, friends, teachers, and the principal. 

) Enter minimum 30 records in the table. 

) Select the field 'Mobile'. Drag it and place it after the 'PIN' field. 

> Rename the field 'Date of Birth' to 'DOB'. 

> Sort the data in 'DOB' column in an ascending order. 

) Filter the table and display the data of those friends whose birthdays fall in the month of November. 

> Hide the column 'Office_Phone'. 

) Create a query to: 

> Display the records of friends who reside in your city. 

> Display the records with Anniversary date falling in the month of December. 

Retrieve the records of those friends who have their e-mail account in Gmail. 

> Run the queries one by one and save the database. 
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Girls are Precious 
Take them out of the Shell 
to see the World... 

SAVE THE GIRL CHILD! 

PHOTOSHOP CC 

Project:  Create a Poster on the topic  Save the Girl Child in Photoshop CC. 

> Open a new file in Photoshop CC. 

> Using the Paint Bucket Tool, paint a blue-coloured 

background on the canvas. 

) Select the Brush Tool, choose the Splatter 24 pixels brush 

type from the Brush Preset picker and set the brush size to 

100 pixels in the Options bar. 

> Select the white colour and apply the brush on the 

background to give it the look of the Sky. 

> Search the images of an egg, baby girl, and broken egg on 

the Internet and store it in yourcomputer. 

> Open the egg image in your file. Using the Polygonal Lasso 

Tool, select the egg to remove the unwanted area. Now, 

copy and paste it on the background image. 

) Press (trl + T. The handles can be seen on the egg. Now, resize and place it at the desired position. Rename this 

layer as 'Egg'. 

> Likewise, open the image of the baby girl. Copy and paste it on a new layer created in the background image. 

Rename this new layer as 'Baby girl'. 

> Select the Lasso Tool and draw an irregular shape over the egg's surface to display the broken part of the egg 

shell. Now, press the Delete key to delete the selection. 

> Now, use the Move Tool to place the baby overthe broken area as shown in the screenshot. 

> Drag the Baby girl layer below the Egg layer. 

) Select the Burn Tool and move the pointer over the bottom area of the baby girl's image to display the effect that 

the baby is inside the egg shell. 

> Choose the dark egg colour as the Foreground colour. Use the Pencil Tool to display the cracking of the egg's 

surface. 

> Insert a new layer and draw a circle on itto coverthe cropped area of the egg. Ensure that the circle should not be 

biggerthan the circumference of the egg. Fill the circle of the egg with dark shade. 

) Drag the layer below the Baby girl layer. 

> Open the image of the broken egg in yourfile. Use the Magnetic Lasso Tool to select the required part, and paste 

it on the background image. 

) Now, select the background layer, choose the white colour and with the Soft Round Pressure Opacity Brush Tool 

paint a small elliptical area. 

> Use the Text Tool to type the text 'Girls are Precious. Take them out of the Shell to see the World...' over the 

elliptical area. 

> Again use theText Tool to type the caption 'SAVETHE GIRL CHILD!' at the bottom of the poster. 

The poster is ready. Save it by giving a suitable name. 
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The Ramayana written by Tulsidas known as  Rameharitmanas.  is a sixteenth century epic. The story revolves around  Rama, 
who was the seventh avatar of the Hindu God  Vish n a -  He is the central figure of the Hindu epic  Raw aya na.  which is the 
principal narration of the events connected to His incarnation on earth. His ideals and His greatness He was the eldest son of 
King Dashratha- the ruler of Kosala Kingdom Rama's life and journey is one of adherence to dhanna despite harsh tests and 
obstacles and many pains of life and time. This adherence made him earn the name of  Maiyada Purushottam  which literally 
means  The Perfect Man  or  Lord of Self-Control  or  Lord of Virtue.  For the sake of his fathefs honour. Rama abandons his 
claim to Ayodhva's throne to serve an exile of fourteen years in the forest His wife Sita and brother L.akshmana decide to join 
him, and all three spend the fourteen years in exile together. \Uiile in exile. Sita is kidnapped by Ravana. the king of Lanka 
After a long and arduous search. Rama fights a colossal war against Ravanas armies. In a war of powerful and magical 
beings. greatly destructive weaponry and battles. Rama slays Ravana in battle and liberates his wife. Having completed his 
exile. Rama returns to be crowned king in Ayodhya and eventually becomes the emperor. The whole story is divided into 
seven parts known as 'Kands' 

THE SEVEN KANDAS 

Learning 
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HTML 

Project: Create a website on the topic,  "Ramayana-The Epic". 

> Make your website appealing and attractive by including elements and attributes that you have learnt in your HTML 

chapters like Paragraphs, Lists, Tables, Images, Hyperlinks, etc. 

> Home page of yourwebsite should look likethe one shown in Figure 1. 

) It should briefly display the story of the Epic Ramayana, along with an appealing background and a hyperlink "THE 

SEVEN KANDAS", to move to the next web page. 

Figure 1 

)' The second page should depict seven images, each related to a particular Kanda. 

Hint: Use the HTML Table elements to arrange the images. 

> Arrange and display the images as shown in Figure 2. Keep the image depicting Bala Kanda in the centre. 

) All the images should behave as hyperlinks leading to their respective pages, each describing the particular 

Kanda (as shown the linked page of Bala Kanda in Figure 3). 



Ayodhya-Kanda Aranya-Kanda Kishkinda-Kanda 

Sundara-Kanda Vudha-Kanda Uttara-Kanda 

II*nic I'SCV 

&cda - Xcutda 

Dahratlia the king i1Avoth'iava had three wires 
named as Ketithalays, Kaikay. and Sumitra, Rains was 
boru to Kaushalaya. Bhaxata to Kaikay and Lakwuina 
and Shatmghsina to Sunutra. When they were glown-
ups Rains and Laksniana were asked by their lhther to 
accompanY Rishi \shvamitra to the forests to fight the 
deinons They were bestowed with supernatural 
weapons and initnictmns by the Rihi Accompanied 
by sage Viahwanutni they icached Mithsl where king 
Janaka reined Ktng lanaka happened to have amusged 
a Savayamver ceremony ibihia driugisterSita with the 
condthon that whosoever breaks the bow ofShna 
would get the hand of his daughtea Rams manied Sita 
after bieskuig the bow and aIez the Sasaysinves they 
return to Ayo4haya 

jomej) ge  

Figure 2 

Figure 3 

Make the navigation user-friendly by incorporating hyperlinks so that the user can return to the homepage or other 

pages easily (Back and Home Page button in Figure 2 and 3). 

A brief description of each Kanda is given below for your reference. Elaborate t he description of each Kanda by 

gathering information from the internet. 

Bala Kanda: This Kanda 

includes the description of the 

boyhood and adolescence of 

Lord Rama. 

> Ayodhya Kanda:  This Kanda 

describes the exile of Lord 

Rama into the forest for 14 

years for the sake of his father, 

King Dashratha's honour. 

) Aranya Kanda: It includes 

information about Rama's life 

in the forest and the abduction 

of Sita by Ravana. 

) Kishkindha Kanda: This Kanda 

describes Rama's sojourn in 

Kishkindha, the search for Sita, 

and the killing of Bali. 

> Sundara Kanda: In this Kanda, 

you will find a description of the 

arrival of Lord Rama and his 

allies in Lanka; the superhuman 

feats of Hanuman including 

setting Lanka ablaze. 

> Yuddha Kanda: This gives 

information about the defeat of 

Ravana, the release of Sita, their 

returning to Ayodhaya, and the 

coronation of Rama. 

> Uttara Kanda: Here, you will find 

the details of the exile of Sita, 

the birth of Luva and Kusha, 

their battle with Rama to catch hold of the horse of Ashvamedha Yajna, Sita's final refuge in the arms of Mother Earth, 

and Rama's ascent into Heaven. 
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PYTHON 

Project: Hotel Mount View, Manali has announced seasonal discounts for its membership holders. The hotel provides 

three types of membership - Gold, Diamond, and Platinum. The membership codes for Gold, Diamond, and Platinum 

are 1, 2, and 3,  respectively. The hotel has two types of rooms - Deluxe and Super Deluxe. The codes for Deluxe and 

Super Deluxe rooms are 'D' and 'S', respectively. 

Create a program that will accept the Name of a Customer, Membership Code, Room Code, Number of Rooms, and 

Number of Days from the user and displays the Bill amount, Discount, and Payable Amount as per the given rates. 

Deluxe 5% 15% 25% 

Super Deluxe 10% 20% 30% 

Tariff per Day: Deluxe —  2500, Super Deluxe —  4200 

A.  Coditions to evaluate: 

) Write the code to input customer name, membership code, number of rooms and number of days. 

> Write the code to check value of the membership code and apply the respective discount. Initialise the value of the 

corresponding variables as shown in the following table. 

Deluxe Room=5% discount Deluxe =5 

1 
Super Deluxe Room=10% discouritSupDeluxe=10 

Deluxe Room=15% discountDeluxe=15 

2 
Super Deluxe Room=20% d iscou ntSup Del uxe=20 

Deluxe Room=25% d iscou ntDeluxe=25 

3 
Super Deluxe Room=30% discountSupDeluxe=30 

After initialising the values of the variables, (discountDeluxe and discountSupDeluxe), get input for the type of rooms as 

'D' for the Deluxe room and 'S' for the Super Deluxe room. 

>- Check the value of the Room type and calculate the payable amount as follows: 

Tariff Per Day value 

Bill Amount = Tariff per Day x No. of Rooms x No. of Days 

Discount Amount = Bill Amount x Discount on type of Room/mo 

Payable Amount = BillAmount - Discount Amount 
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B. Display the output in the given format. 

Enter Membership Code:2 
Enter Customer Narne:Abhay 
No of Rooms:2 
No of Days:4 
Enter Rooms Code(D\S):S 
*************************** *********************************** 

Hotel Mount View 
Manali (Himachal Pradesh) 

Customer Name: Abhay 
Membership Code: 2 

Dear Abhay you own Super Deluxe membership. 
Seasonal Discount on Super memebrship is 20% 

Tarrif Detail 
*** * ** ****** * * *** ***** ** ***** * * ************************** ** 

Tariff per Day: 4500 
No of Rooms: 2 
No of Days: 4 

************************************************************** 
Total Payable amount: 28800.0 
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QUICK GLIMPSE OF OFFICE 365 

Office 2016 suite contains applications, such as Word, Excel, PowerPoint, and Outlook which are available as a one-

time purchase for use on a single PC. 

Office 365 is a suite of services offered by Microsoft. It is a web based subscription service, where you have to pay a 

monthly or yearly fee to avail the various services it provides. Office 365 subscription plans include Office 365 Home, 

Office 365 Personal, Office 365 University, Office 365 for Mac, Office 365 for Business, etc. With each plan, you can 

install the 2016 versions of Word, Excel, PowerPoint, Outlook, and OneNote (Access and Publisher are also included 

for PC users). 

With the subscription of Office 365, you get: 

The latest version of Office applications that are updated regularly, as and when a new version is released. Office 

365 can be installed on up to 5 devices. 

One Drive cloud storage (free up to 1 TB) that enables you to store all the documents in one place and allows you 

to access these documents at anytime and anywhere. Therefore, it is easier than ever to create, edit, and share 

the documents at one go. 

Free 60 minutes of Skype calling per 

month, which will help you to stay in 

touch with your friends around the 

globe. 

Office Mobile Apps to get the things 

done on any device - PCs, Macs, tablets 

(including iPad and Android tablet). 

.> KEY FEATURES OF OFFICE 365 

Work smarter with the built-in  Word Researcher and Editor 

The Researcher feature helps you to find and use the content, related to your topic, right within your Word 

document. It uses the Bing Knowledge Graph to extract the relevant content from the web and provides safe and 

credible information. 

The Editor feature, on the other hand, provides intelligent suggestions for proof-reading and editing as you type in a 

document. 

Find the right command in seconds with  Tell 

It's easier than ever to find the feature you need. Just type what you want to do in the intelligent "Tell me what you 

want to do" search box and go directly to the command you need. 

Put your best foot forward with  PoverPoint Designer and Morph 

PowerPoint Designer is an intelligent, built-in tool that helps you to create high-quality slides in seconds. The new 

Morph transition effect creates cinematic motion in one click, seamlessly animating between the slides. 
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1 OneNote 

Organise and Share Your Work 
OneNote is a digital notebook that helps you in 
making quick notes either handwritten or typed. It 
provides you with the flexibility to assemble and 
organise your notes, images, audio, and video 
clippings together in one location on your computer. 
You can share your notebook with anyone you desire 
and work on your projects also at the same time. 

Y yammer 

Connect across your Company 
It is a private social network within a company or an 
organisation that allows the team members to share 
information, to have group discussions, and build a 
body of knowledge that is instantly accessible by any 
co-worker at anytime and anywhere. 

Keyboard, touch, or pen - it works the way you do 

Touch and inking capabilities give flexible options for reviewing, editing, and presenting the views. 

Connect and Stay in Touch 

It is the most popular application used for making 
voice and video calls on the Internet. Skype to Skype 
calls are always free but you can also use Skype to 
call mobile phones and landlines at affordable rates. 
You can also use it for instant messaging or chatting. 

Sway 

Turn your Ideas into Stories 

It helps in creating and sharing dynamic and 
interactive reports, presentations, newsletters, and 
personal stories. The built-in design templates help 
to enhance its look. It also provides you with a safe 
browsing tool to search relevant images, audio 
clips, videos, and other contents that you can drag 
and drop right into your creation. It is extremely 
easy to share a Sway with your family and friends 
without signing in or downloading additional 
software. Sway for Windows 10 is available for 
download in the Windows Store. 
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SharePoint 

Keep Projects Together 
It is a platform, offering different services. You can 
use SharePoint to store and organise documents and 
collaborate with anyone in real time. You can sign-in 
to SharePoint from any device, like desktop or mobile 
phones and can use it to have access to any 
information. 

Delve 

Discover exactly what you need 

Microsoft Delve, previously code-named "Oslo", 
helps you in searching your e-mails, meetings, 
contacts, social networks, and corporate documents 

stored across Office 365. It uses "machine learning" 
artificial intelligence to provide you with the stuff you 
need to see. You do not have to remember the title of 
a document and its location. Delve brings the right 
information to you proactively based on what you 
are working with. It shows you the documents no 
matter where they are stored in the cloud but you 
can only see the content that has been shared with 
you. 



) Office lens 

A Scanner in the Pocket 

> Office Lens, one of the incredible apps available 

with Office 365, acts like a scanner and makes 

digital copies of the captured printed 

documents, business cards, posters, etc. 

>  One can also use it to take pictures of the notes 

from whiteboards or blackboards in the 

classroom or meeting. This app digitises these 

pictures and helps in cropping and refining their 

quality to make them clear and readable. 

This app provides the option to convert the 

captured images to PDF, Word, or PowerPoint 

files which are automatically saved to OneDrive. 

Besides that, the images can be saved to 

OneNote oron the local drive of the device also. 

)  It makes use of OCR technology (Optical 

Character Recognition) to recognise the printed 

or handwritten text so that one can search for 

words in images and then copy and edit them. 

Office Remote 

Turn your Phone into a Smart Remote 
>  Office Remote is another free app which turns 

your phone into a smart remote that interacts 

with Word, Excel, and PowerPoint files on 

your PC. 

)  In PowerPoint: you can start the PowerPoint 

presentation, move to the next slides, check out 

the speaker notes, view slide thumbnails and 

jump to a slide, play and pause the embedded 

audio and video files, etc. 

>  In Word: you can scroll through a Word 

document, jump to headings and comments 

section, change the zoom levels, screen up and 

down, etc. 

>  In Excel: you can switch between worksheets, 

move up and down the worksheet, change the 

zoom level, etc. 

> This app works both with Windows as well as 

Android phones. 

Convert your Paper Forms into Mobile Forms 
> It is a data collection app which facilitates in creating professionally lookingforms. 

> It supports various templates to make the form design user friendly and attractive. It works in offline mode 

also. 

>  After creating forms, you can collect data through various means such as sharing web link with desired 

users, sharing the code with other Smart Forms 365 users, etc. 

)' Filled data can be easily exported to otherformats so that it can be reused. 

> Filled forms can be sent to OneNote, with the result that the forms can be viewed on multiple devices. 

) It can be used to create short courses, assessments of mark sheets, surveys, take structured notes, lesson 

plan. Medical professionals can use itto record Patient Medical History, trainee assessments, etc. 
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FUN TO KNOW 

Al has the potential to offer $15.7 

trillion to the global economy by 

2030. 

Aribificial InteIIkJte4i)rce 

Al: Our Constant Companion 

Have you ever wondered how does Amazon recommend a book to you? How is YouTube able to know your taste 

so well that it suggests exactly the video that would match your interest? 

Do you know that when your father is using Google Maps for navigation or mother is calling 

an Uber cab for her shopping spree, they are actually using Artificial Intelligence (Al)! Al-

powered Google Maps help us in finding congestion-free routes. While booking a cab on 

Uber, both the price and car that matches your ride request is decided by Al. 

The films or TV series that Netfiix recommends for you is based on algorithms that are keeping a watchful eye on 

you. These companies and their algorithms know exactly what you have recently watched. They also know about 

your most recent purchase from an online store. Based on the knowledge they gather on you; they are able to 

suggest similarthings that you might enjoy. 

Any video game that you play has some sort of Al element built 

into it. Let us presume that you begin to play a popular game like 

PU BC. Initially, you play against a couple of Al-powered bots. As 

the game advances, you move on to play against real players. 

However, you are actually playing against Al bosses even when 

you are playing a single person story-mode game. Another 

related example of Al is the Middle Earth series of games. In this 

series, all your enemies are Al-controlled. They keep evolving 

constantly, based on their interaction with you and the other 

gaming elements. 

Characteristics to show Intelligent Behaviour 

Various Al experts have listed certain characteristics that exhibit intelligent behaviour. Now, use the given 

checklist to find out your intelligence quotient. 

Do you have: 

> the creative ability to adopt new concepts and ideas? 

> theunderstandingoftheexternalworld? 

> the thirst to acquire new knowledge? 

> memory retention and recall skills? 

> theabilitytodrawsimilaritiesanddifferencesamongdifferentsituations? 

) the aptitude to draw inference with the help of the available information? 

) theskilltorespondtoasituationinafiexiblefashion? 

> the talent to employ step-by-step approach forsolving complex problems? 
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Need for Al 

Computers are very quick and useful when it comes to the following: 

> Numerical computation 

> Information storage 

> Performing repetitive tasks efficiently, without complaining or 

getting bored 

H umans outshine computers when it comes to the following: 

S 

> Understandingthebehaviourofpeople 

> Predicting the outcome of an event merely by observing 

> Common sense and reasoning 

> Drawing conclusions 

> Understanding emotions 

> Evaluatingnewideas 

Most of the problems that you encounter in your daily lives require the use of common sense and reasoning. Your 

actions also depend on your visual and verbal understanding. You may need to derive useful meaning even out of 

incomplete information. Situations may arise where you have to use your own instincts to solve a problem at 

hand. It is impossible to prepare a complete list of all possible problems in the real world. Hence, it is not viable to 

write programming solutions for each kind of problem. In such a case, Al comes handy. 

Developing Intelligent Systems 

Al deals with symbolic rather than numeric processing, heuristics (past experience) and rule of thumb for 

problem solving. Al is a way to make machines think and behave intelligently. So that - 

) Themachinescanfunctionlikethe intelligenthumanbrain FUN TO KNOW! 

) Understandtheworldaroundthem Facebook developed DeepFace that 

could identify human faces in digital 

> Reacttosituationsinthesamewayashumansdo images with an accuracy of 97.35 

Al Domains 

1. Data 

2. ComputerVision 

3. Natural Language Processing 

While using Facebook, Instagram or Snapchat, the feeds that 

you see on your timeline to the app notifications that you 

receive, Al is playing an important role. While browsing the 

internet, you must have noticed several ads that pop up on 

your screen. Al is used to learn about your purchase 



Hondas Asimo is the worlds most 

advanced bipedal humanoid robot. 

In 2017, Waymo started testing its 

driverless cars. While a human took 

about 2 seconds to react and apply 

brakes, a computer took only 0.3 

seconds to compute and apply 

brakes in the same scenario. 

preferences. You are then served ads based on the data collected about you. In 

fact, the global digital ad industry is projected to cross a whopping 300 billion mark 

in 2019. 

Applications of Al 

FUN TO KNOW! 

Facebook developed DeepFace that 

could identify human faces in digital 

images with an accuracy of 97.35 

Al has become an important part of our everyday life. Some of its applications are 

as follows: 

 

FUN TO KNOW! 

 

> Smartcarsanddrones 

> Expert systems in finance and marketing 

Robotics 

Social media 

> Travel and navigation 

> Healthcare industry 

> Securityandsurveillance 

>  Smart homes 

FUN TO KNOW! 

In 2014, GoVivaces speaker 

identification system successfully 

searched for an individual among 

millions of speakers. 

ACTIVITY TIME 

Ice Breaker Activity -  Dream Smart Home Idea 

'Home is where the Heart is.' A real, perfect Al-powered house is probably just a decade away. All you young students, 

must be brimming with new ideas already! So, design a rough layout of the floor plan of your dream smart home and 

share your ideas with your classmates. 

Al systems: The new World Champs 

In 1997, IBM's Deep Blue beat chess champion Gary Kasparov in a 3.5: 2.5 match. In 

1997, Logistello, a program that plays the game Othello, beat the world champion 

Takeshi Murakami in a 6:0 match. In 2011, the IBM Watson system beat Brad 

Rutter and Ken Jennings in the quiz show Jeopardy securing first place and 

bagging a prize of $1 million. In 2016, Google's AlphaGo beat the world champion 

Lee Sodol, with 4:1, while playing the game Go. 

Neural Networks: Learn and Relearn like a Child 

It is like a child who does not know much at birth but once he is exposed to real-life 

situations, he develops problem-solving skills. For neural networks, data is the 

only experience. A neural network can also be compared to a race around a 

circular track with several laps. As a runner passes through the same points 

repeatedly in the loop, he tries to improve his performance. Each step for a neural 

network involves a guess, finding error, and upgrade to a better guess. It learns 

from its own mistakes and tries to attain a better output the next time. 
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Human beings have a natural tendency to learn from their environment through observations. Past experiences 

also help us to improve and take better decisions. Neural networks are a set of algorithms that tend to function 

like the human brain. These are designed to recognise patterns, and then cluster and classify data. 

Some examples of Neural Networks classifying data are as follow: 

) Detect faces 

> Identify people in images 

> Recognise facial expressions 

> Identify objects in images 

Recognise gestures in a video 

) Detect voices 

> Identify speakers 

) Recognise sentiments in different voices 

Some more examples where Neural Networks cluster data are: 

> Comparing documents 

> Grouping together images orsounds to find similarities 

> Detecting unusual behaviour, likefrauds 

ACTIVITY TIME 

Story Time:  Imagine that Sanjay lives in a smart home. As he returns home, his car communicates with the garage to 

open the door. Once inside, the temperature is adjusted to a comfortable level. The lighting is set to a low intensity and 

colourfor relaxation. His pacemaker data indicates it has been a stressful day and instructs the music player to play soft 

music... . Build a story around this setting. Get Set Go! 

1'AI*III'I Quick, Draw! By Google Creative Lab 

It is a game where a neural net tries to guess what you're drawing. You have 20 seconds of time and the 

computer keeps guessing what you have drawn. It even apologizes for not being able to guess right. 

Al Ethics 

Nowadays, you keep hearing about cases of data breach from social media platforms, cyberattacks resulting in 

ransomware, phishing, and malware attacks on the computer system. While using a computer system, Al 

programs are running in the background, and they know all about you. 

You can organise a debate on the topic—Is Al beneficial or harmful forthe society? 
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Sway 
Create vicuully striking newsletters, 

presentations, nd documentation in minutes 

 SWAY  
Sway, a part of the Microsoft Office package, is a digital storytelling application. Its colourful and interactive 

interface is designed for creating and sharing personal stories, interactive reports, presentations, newsletters, and 

more. In Sway, there is no option for creating content itself, though you can import an existing Word, PowerPoint, 

or PDF document from which a new Sway story can be created with text and media. Unlike PowerPoint, it is 

primarily used for presenting ideas on screen rather than to an audience. 

FEATURES OF SWAY 

ADDING INTERACTIVE CONTENT: You can bring your Sway to life with elements like videos, interactive reports, 

personal stories, presentations, and more. 

READY CONTENT FOR ALL DEVICES: Sway adapts itself to all devices. 

SEE SUGGESTED SEARCH RESULTS: Sway suggests searches to help you find relevant images, videos, tweets, and 

othercontent that you can drag and drop into your creation. 

INBUILT DESIGN ENGINE: Sway's inbuilt design engine provides various choices to customise your content. 

EASY TO SHARE: You can also share your Sway with others via a link or through social media, or by embedding it in 

your websites. 

ADDING MEDIA VIA SOCIAL MEDIA ACCOUNTS: In Sway, you can add different media via social media accounts such 

as inserting photos directly from Face book, inserting tweets from Twitter, and adding videos from Youlube. 

USE CREATIVE NAVIGATION STYLES:  Sway provides you with muftiple options to navigate through your content. 

ACCESSING SWAY 

To get started with Sway, follow the given steps: 

Visit sway.offlce.com  and then click on the Sign in option on the right cornerof the top Menu bar. 

> A Sign in popup window will appear. Sign in using youre-mail address either in Hotmail or Outlook. 

Sway Sign in Window 
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CREATING A SWAY 

Create a new Sway by 
clicking on Create New option 

Swa 

S:-'/e Cescçjn 

Click to add new content 

Sack UØoad 

Click to add new content 
to your Sway. 

Click to 
Add Background Image 

to your Sway. 

H.adng Cad 

Tips for Motorist 

coat •  00* Road Safety 
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Total Questions 50 Time:1 hr 

N CO Section (1) t.ogical Reasoning (2) Computers & IT (3) Achievers Section 

No. of Questions 10 35 5 
co F !'ATiorgAL CYBER OLYMPiAD 
SYLLABUS 
Section — 1 : Verbal and Non-Verbal Reasoning. 
Section —2  Fundamentals of Computers, Internet & Viruses, HTML-[Html,  Head, Title, Body (Attributes: Background, Bgcolor, Text, Link, Alink, Vlink), Font (Attributes: 
Color, Size, Face), Center, BR, HR (Attributes: Size, Width, Align, Noshade, Color), Comment tayk!-- -->), <H1>..<H6>, <P>, <B>, <I>, <U>, <1MG>, Html 
Elements: A, UI and 01 (Attributes:Type, Start), 1:), Flash CSB, MS-Access, Networking, MS-Word (Exploring File tab, Language and Translate options, Tracking features 
-Comments, Reviewing Pane, Tracking Changes. Comparing, Combining and Protecting documents, Working with References). MS-PowerPoint (Exploring File tab and 
Slide Show tab, Comparing, Combining and Protecting presentations), MS-Excel(Exploring File tab, Useful Formulas and Functions - lF,Even, Odd, 1CM, GCD, Powe 
Product, Round, Sqrl, Sum, Mm, Max, Average, Count, Upper, Lower And Replace, Cell referencing, Using Defined Names group), Memory & Storage Devices, Basics 
of Cyber Crimes, Cyber Laws, Operating Systems(Introduction, Features, Types-single user and mulu-user), Latest Developments in the field of IT. 
Section — 3  : Higher Order Thinking Questions - Syllabus as per Section — 2. 
Questions are based on Windows 7 and MS-Office 2010. 

Marks per Ques. 3 

Visit www.sofworld.org  for more details. 

LOGICA  -  EASONIN 

If in a certain code SAND is VDQG and BIRD 
is ELUG, then what is the code for LOVE? 
(A) PRYG (B) ORTG 
(C) NPUH (D) ORYH 

Which of the following Venn diagrams best 
represents the relationship among "tennis fans, 
cricket players and students"? 

(A) 

(D) 

A, B, C, D, E and F, not necessarily in that 
order, are sitting on six chairs regularly placed 
around a round table. It is observed that A is  

between D and F, C is opposite to D, D and 
E are not on neighbouring chairs. The person 
sitting opposite to B is  
(A)A (B)D 
(C)E (D)F 

If the digits in the number 25673948 are 
arranged in ascending order from left to right, 
what will be the sum of the digits which are 
fourth from the right and third from the left in 
the new arrangement? 
(A) 10 (B) 9 
(C)4 (D)6 

Find the missing term in the given series. 

DMP, FLN, HKL, JJJ, ? 
(A) MII (B) LIH 
(C) Ill (D) MIF 

(C) 

(B) 

OMPUTERS AND INFORMATION TE 

Which of the following is NOT available as a 
category in Control Panel of Windows 7? 
(A) System and Security 
(B) Programs 
(C) Bluetooth settings (D) Ease of Access 

The function of given icon in MS-Word 
2010 is  
(A) To add caption to a picture or 

other image 
(B) To insert an index into the document 
(C) Merge document to PDF files 
(D) Insert Flash video  

8. Which of the following is CORRECT in HTML? 
(A) <hr> (B) <HR> 
(C) <B> Bold Text </B> (D) All of these 

9 Computers use the seven digit code called 
ASCII. What does ASCII stand for? 
(A) American Standard Code for Information 

Interchange 
(B) Association of Software Coding and 

Information Institute 
(C) American Standard Computing and 

Information Institute 
(0) American Scientists Convention for 

Information Interchange 
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How many sheets are there in MS-Excel 2010 
workbook by default? 
(A)2 (B)3 
(0)4 (D)5 

In Flash CS6, is called  tool. 

(A) Fill color (B) Paint bucket 
(C) Ink bottle (0) Lasso 

In MS-PowerPoint 2010, Format Painter is used 
to  
(A) Copy formatting from one place and apply 

it to another 
(B) Reset the position, size and formatting of 

the slide 

(C) Format text to the left 
(D) Increase the indent level 

Which of the following statements is INCORRECT 
about memory and storage devices? 
(A) Cache memory makes memory transfer 

rates higher and thus raises the speed of 
the processor. 

(B) A storage device is a hardware component 
that writes data to and reads data from a 
storage medium. 

(C) ROM loses its data when you turn off the 
computer. 

(D) Hard disks can be divided into one or more 
logical disks called partitions. 

Rearrange the steps given below to insert a 
motion tween in Flash CS6, first and last steps 
are given for you. 
First: Draw a shape at Frame 1 

(i) Drag the playhead to a new frame and 
reposition your object 

(ii) Select the shape and convert it to a symbol 

(iii) Go to Insert tab -p Motion tween 

Last: Press Ctrl + Enter .4-_J to play the 
tween. 
(A) (ii) —* (iii) —* (i) 
(C) (iii) -* (i) - (ii) 

Which of the following statements is CORRECT 
about 'Sneakernet'? 

(A) Transferring computer files between 
computers by physically moving removable 
media such as CDs, flash drives. 

(B) Unauthorised access of information from a 
wireless device. 

(C) The process of converting data in a form 
so that an unauthorised person cannot 
understand it. 

(D) A private computer network in which multiple 
PCs are connected to each other. 

(B) (i) __* (iii) —* (ii) 
(D) (iii) .-.~ (ii) -3W (I) 

 is a device that will only 
send a message to the device that needs 
or requests it rather than broadcasting it 

to all devices. 

(A) Router 

(B) Hub 

(C) Switch 

(D) Modem 

(2AB)lb = (
 
)2.  

(A) 001010101011 

(B) 0010101011 

(C) 111000110101 

(D) 001010101010 
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